FINAL PROJECT - RC 141501

REDESIGN OF SURABAYA FAVE HOTEL USING
PRECAST CONCRETE METHOD IN BEAM AND SLAB
STRUCTURE ELEMENTS

ADITYA CAHYADI
NRP 3112 106 046

SUPERVISOR :
Prof. Dr. Ir. | GUSTI PUTU RAKA
Prof. TAVIO, ST.MT.PhD

DEPARTEMENT OF CIVIL ENGINEERING
Faculty of Civil Engineering and Planning
Sepuluh Nopember Institute of Technology
Surabaya 2015



TUGAS AKHIR - RC 141501

MODIFIKASI ULANG HOTEL FAVE SURABAYA
MENGGUNAKAN METODE BETON PRACETAK PADA
ELEMEN STRUKTUR BALOK DAN PELAT LANTAI

ADITYA CAHYADI
NRP 3112 106 046

Dosen Pembimbing :
Prof. Dr. Ir. | GUSTI PUTU RAKA
Prof. TAVIO, ST.MT.PhD

JURUSAN TEKNIK SIPIL

Fakultas Teknik Sipil dan Perencanaan
Institut Teknologi Sepuluh Nopember
Surabaya 2015



MODIFIKASI ULANG HOTEL FAVE SURABAYA

MENGGUNAKAN METODE BETON PRACETAK

PADA ELEMEN STRUKTUR BALOK DAN PELAT
LANTAI

TUGAS AKHIR

Diajukan Untuk Memenuhi Salah Satu Syarat
Memperoleh Gelar Sarjana Teknik
pada
Program Sarjana Jurusan Teknik Sipil
Fakultas Teknik Sipil dan Perencanaan
Institut Teknologi Sepuluh Nopember

Oleh :
ADITYA CAHYADI
NRP. 3112 106 046

Disetujui oleh Dosen Pembimbing Tugas Akhir :

1. Prof. Dr. Ir. Il GUSTH

é~ ok ViV
Nip. 19500403 1&
0
2. Prof. TAVIO, ST. ;

o
o Usan TN

Nip. 19700327 1997091 6051 uees

SURABAYA
JANUARYI, 2015




MODIFIKASI ULANG HOTEL FAVE SURABAYA
MENGGUNAKAN METODE BETON PRACETAK
PADA ELEMEN STRUKTUR BALOK DAN PELAT

LANTAI
Nama Mahasiswa : Aditya Cahyadi
NRP : 3112106046
Jurusan : Teknik Sipil FTSP-ITS

Dosen Pembimbing  : Prof. Dr. Ir. | GUSTI PUTU RAKA
Prof. TAVIO, ST.MT.PhD

ABSTRAK

Beton pracetak adalah komponen beton yang dicor diluar
site atau di pabrik. Kelebihan beton pracetak adalah lebih efektif
untuk kawasan yang padat bangunan dibanding dengan struktur
cast in place. Secara garis besar beton pracetak mempunyai 3
(tiga) tahapan pelaksanaan, yaitu tahap pembuatan, tahap
pengangkatan dan tahap pemasangan. Gedung Hotel Fave
Surabaya JawaTimur yang dibangun 13 tingkat dengan cara cor
di tempat (cast in place) dalam modifikasi perencanaan ini
menggunakan beton pracetak pada balok induk, balok anak dan
plat. Sedangkan kolom dan unsur sekunder lain (tangga dan kolom
praktis) tetap menggunakan metode cast in place. Sambungan
antar elemen pracetak menggunakan tipe sambungan basah
dengan sistem overtopping untuk menjamin kesatuan struktur yang

cukup kaku dan penyebaran atau distribusi beban hidup vertikal
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antar komponen pracetak lebih merata. Penambahan dinding
geser pada bangunan ini bertujuan untuk merancang ulang
bangunan menggunakan Sistem Rangka Gedung, yaitu dengan
partisipasi pemikulan pengaruh beban gempa oleh sistem rangka
adalah kurang dari 10% dengan mempertimbangkan
kompatibilitas struktur. Untuk struktur bangunan bawah
direncanakan dengan podasi dalam menggunakan tiang pancang.

Kata kunci : beton pracetak; sambungan; sistem rangka gedung;
pondasi dalam
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ABSTRACT

Precast concrete is concrete components by cast in
location outside the site or in the factory. The advantages of
precast concrete is more effective in mass area than cast in place
structure. Broadly speaking precast concrete has three (3) stages
of implementation. The first stage is concrete casting in factory, the
second stage is lifting process and the final stage is installation.
Fave Hotel Surabaya, built in 13 levels by cast in place, in this
modification is used precast concrete in beam and slab members
while the column and other secondary elements (stairs and
practical columns) is still using cast in place. Conncections
between precast elements using a wet-type connection with
overtopping system to ensure the unity of structure rigidity and
evenly distribute vertical live load between precast components.
The addition of shear walls on the building aims to redesign the

building using Building Frame System. The concept of Building
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Frame System is the participation of lateral load resistance in
frame less then 10% by considering the structure compatibility.

And the design of bottom building structure uses pile group

foundation.

Key Words : precast concrete; conncetion; building frame

system; pile group
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BAB1
PENDAHULUAN

1.1 Latar Belakang

Hotel Fave Ketintang Surabaya merupakan bangunan
gedung 13 lantai yang direncanakan dengan metode beton
konvensional. Metode beton konvensional, walaupun umum
dipakai dalam pembangunan gedung, saat ini memiliki banyak
kekurangan. Pertama, waktu pelaksanaan pekerjaan relatif lama
terkait dengan pembukaan elemen bekisting beton yang berkisar 21
— 28 hari. Kedua, proses pengecoran di lapangan sangat bergantung
pada kondisi cuaca sehingga sering terjadi penundaan pekerjaan
yang mempengaruhi waktu penyelesaian proyek. Ketiga, kualitas
beton sulit untuk di kontrol sehingga seringkali mutu beton tidak
seragam. Keempat, jumlah tenaga kerja yang dibutuhkan relatif
banyak sehingga biaya di sektor SDM (sumber daya manusia)
cukup tinggi. Kelima, pemakaian bekisting sebagai media untuk
mencetak beton menghasilkan banyak waste material terutama
pada bekisting yang berbahan kayu.

Berdasarkan hal di atas, maka diperlukan desain alternatif
yang dapat menutupi kekurangan pada metode beton konvensial,
yaitu dengan menggunakan sistem beton pracetak. Sistem beton
pracetak memiliki banyak kelebihan dibandingkan dengan sistem
beton konvensional. Pertama, Beton pracetak adalah beton yang
dicor dan dicetak di pabrik atau di dekat lokasi proyek. Karena
proses pembuatannya di pabrik (pengawasan ketat), kualitas/mutu
pekerjaan dari beton pracetak dapat terjaga dengan baik dan
seragam (wulfram | Ervianto, 2007). Kedua, waktu pengerjaan
sistem pracetak relatif lebih cepat dari sistem konvensional
terutama pada bangunan yang tidak memiliki banyak variasi pada
elemen strukturalnya. Ketiga, pengerjaan sistem pracetak tidak
bergantung pada cuaca karena proses pengecoran di lakukan di
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pabrik. Ketiga, sistem pracetak tidak memerlukan bekisting di
lapangan sehingga tidak terdapat waste material akibat
penggunaan bekisting. Keempat, pada proses pengerjaan di
lapangan tidak memerlukan banyak tenaga kerja sehingga biaya di
sektor SDM (sumber daya manusia) dapat dikurangi.

Sistem Pracetak, disamping memiliki berbagai kelebihan,
juga memiliki karakteristik yang menjadi prasyarat agar penerapan
sistem ini dapat digunakan secara maksimal karena tidak semua
tipe bangunan dapat diterapkan sistem pracetak. Pertama, secara
umum pengggunaan metode beton pracetak menuntut repetisi yang
tinggi pada elemen struktur (A.S.G Bruggelling dan G.F.Huyghe,
1991). Hal ini berkaitan dengan efektifitas dari pemasangan
elemen pracetak di lokasi. Dengan demikian, variasi elemen
struktur sebisa mungkin dibatasi (tipikal). Kedua, sistem pracetak
belum bisa diterapkan pada bangunan di daerah zona gempa tinggi
terkait dengan sistem sambungan yang masih belum bisa dijamin
kekakuannya. Maka, sistem pracetak pada saat ini idealnya hanya
bisa diterapkan pada bangunan gedung yang terletak di zona gempa
rendah sampai zona gempa menengah.

Kemudian pada tahap perencanaan, terdapat beberapa hal
mendasar yang harus diperhatikan pada metode ini. Pertama,
metode beton pracetak didesain dengan menganggap struktur
bersifat bersifat monolit (cor di tempat) atau sama dengan beton
konvensional. Metode desain seperti ini disebut pendekatan desain
emulasi (C.E.Warnes, 1992). Dengan pendekatan ini, konsep
desain kapasitas yang biasa digunakan pada perancangan struktur
beton konvensional dapat digunakan dalam perancangan struktur
beton pracetak. Desain kapasitas ini dapat tercapai dengan
menerapkan aturan strong column-weak beam yang mengharapkan
kelelehan pada balok terjadi terlebih dahulu sebelum terjadi
kelelehan pada kolom. Oleh karena itu, sambungan antar elemen
stuktur (balok-kolom) menjadi bagian yang sangat penting dalam
mentransfer gaya-gaya antar elemen pracetak yang disambung.
Dengan demikian, perencanaan sambungan (tipe, kekuatan dan
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penempatan) Yyang tidak direncanakan dengan baik dapat
mempengaruhi  stabilitas struktur sehingga memungkinkan
terjadinya keruntuhan yang prematur (Elly Tjahjono dan Heru
Purnomo, 1997). Kedua, pada beton pracetak, kekuatan beton
harus dikontrol terhadap tahapan-tahapan yang dilalui beton
sebelum terpasang di tempatnya. Tahapan tersebut adalah tahap
produksi dan setelah produksi. Pada tahap produksi, fabrikasi
beton (casting, cast dan curing) dikerjakan di pabrik. Kemudian
tahap setelah produksi adalah tahap penanganan (handling),
penyimpanan (storage), penumpukan (stacking), pengiriman
(transport) dan tahap pemasangan di lapangan ( site erection ).
Tahapan-tahapan ini sangat penting karena dapat mempengaruhi
mutu dan perilaku elemen pracetak sebelum terpasang di lapangan.
Jika perencanaan elemen pracetak tidak dikontrol terhadap
tahapan-tahapan tersebut dengan baik dapat menyebabkan
kegagalan pada elemen pracetak sebelum terpasang di lapangan.

Berdasarkan pemaparan di atas, perencanaan gedung Hotel
Fave Ketintang Surabaya dengan menggunakan sistem pracetak
adalah pilihan yang tepat. Mengapa harus menggunakan pracetak?
Karena disamping memiliki kelebihan di banding dengan sistem
beton konvensional, struktur bangunan gedung Hotel Fave sangat
memungkinkan untutk didesain dengan sistem pracetak karena
memenuhi kriteria yang sudah di jelaskan di atas. Yaitu memiliki
elemen struktur yang tipikal (tidak banyak variasi) dan terletak di
kota surabaya yang merupaka daerah zona gempa menengah.

1.2 Perumusan Masalah
1.2.1 Permasalahan Utama

Bagaimana merencanakan gedung Hotel Fave
Ketintang dengan menggunakan metode beton pracetak?
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1.2.2

.

Detail Permasalahan

Bagaimana merencanakan gedung Hotel Fave dengan
metode beton pracetak pada elemen struktur balok dan
pelat?

Bagaimana merencanakan dan memperhitungkan elemen
beton pracetak yang dipengaruhi oleh tahapan-tahapn
(proses) yang dilalui beton pracetak tersebut sebelum
terpasang di lokasi (erection)?

Bagaimana merencanakan sambungan pada elemen
struktur pracetak pada gedung Hotel Fave Ketintang?
Bagaimana menuangkan hasil perhitungan ke dalam
gambar teknik?

1.3 Tujuan Penulisan

1.3.1 Tujuan Utama

1.3.2

4.

Merencanakan struktur gedung Hotel Fave Ketintang
Surabaya dengan menggunakan metode beton pracetak.

Detail Tujuan

Merencanakan struktur gedung Hotel Fave Ketintang
Surabaya dengan menggunakan metode beton pracetak pada
elemen struktur balok dan pelat.

Merencanakan elemen beton pracetak yang dipengaruhi oleh
tahapan-tahapan yang dilalui beton pracetak tersebut
sebelum terpasang di lokasi.

Merencanakan sambungan pada struktur beton pracetak
yang mendekati sambungan pada beton konvensional
(monolit).

Menuangkan hasil perencanaan ke dalam gambar teknik.



1.4 Batasan Permasalahan

N

5.

Komponen struktur yang menggunakan pracetak adalah
pelat dan balok

Tidak meninjau biaya dan metode pelaksanaan konstruksi
Perencanaan tidak termasuk sistem utilitas, kelistrikan dan
sanitasi.

Tidak meninjau masalah perubahan volume akibat
perubahan temperatur, creep, dan shrinkage pada beton.
Analisa struktur menggunakan program bantu ETABS 9.07

1.5 Manfaat Penulisan

1.

Manfaat untuk masyarakat/pembaca:

Pembaca dapat mengetahui adanya desain beton pracetak
yang memiliki banyak kelebihan dibanding dengan desain
beton konvensional.

Manfaat untuk dunia teknik sipil:

Sebagai tambahan referensi dalam perencanaan gedung
bertingkat dengan metode beton pracetak sehingga metode
ini lebih banyak digunakan dan diaplikasikan pada tipe
bangunan gedung yang sesuai (memenuhi kriteria ideal
desain pracetak).

Manfaat untuk penulis:

Mengetahui dan memahami bagaimana cara merencanakan
struktur gedung bertingkat dengan menggunakan metode
beton pracetak.



“Halaman Ini Sengaja Dikosongkan”



BAB 11
TINJAUAN PUSTAKA

2.1 Umum

Teknologi beton pracetak adalah teknologi konstruksi
struktur beton dengan komponen komponen penyusun yang
dicetak terlebih dahulu pada suatu tempat khusus (off-site
fabrication), terkadang komponen-komponen tersebut disusun dan
disatukan terlebih dahulu (pre-assembly), dan selanjutnya dipasang
di lokasi (installation). Dengan demikian, sistem pracetak ini akan
berbeda dengan konstruksi beton monolit pada aspek perencanaan
yang tergantung atau ditentukan oleh metoda pelaksanaan dari
fabrikasi, dan pemasangannya, serta ditentukan pula oleh teknis
perilaku sistem pracetak dalam hal cara penyambungan antar
komponen (joint). Beberapa prinsip beton pracetak tersebut
dipercaya dapat memberikan manfaat lebih dibandingkan beton
monolit antara lain terkait dengan pengurangan waktu dan biaya,
serta peningkatan jaminan kualitas, keandalan, produktivitas,
kesehatan, keselamatan, lingkungan, koordinasi, inovasi,
reusability, lingkungan, koordinasi, inovasi, reusability, serta
relocatability (Gibb, 1999).
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2.2 Analisis beton pracetak dengan beton konvensional

Pada dasarnya dalam merencanakan beton pracetak
maupun konvensional adalah sama. Metode beton pracetak
didesain dengan menganggap struktur bersifat bersifat monolit (cor
di tempat) atau sama dengan beton konvensional. Metode desain
seperti ini disebut pendekatan desain emulasi (C.E.Warnes, 1992).
Adapun perbedaannya adalah sebagai berikut:

1. Perencanaan pracetak memperhitungkan kondisi
penganggkatan saat umur beton belum mencapai 24 jam. Pada
kondisi ini (saat pengangkatan) apakah beton akan mengalami
crack atau tidak sehingga diperlukan analisa desain tersendiri.

2. Desain pracetak memperhitungkan metode pengangkatan,
penyimpanan di stock yard, pengiriman, dan saat pemasangan di
proyek.

3. Pada desain pracetak diperlukan desain sambungan antar

elemen.

2.2.1 Elemen Stuktur Pracetak yang Direncanakan

2.2.1.1 Pelat
Pelat dianggap sebagai diafragma yang sangat kaku untuk

mendistribusikan gempa. Pada waktu pengangkutan atau sebelum
komposit, beban yang bekerja adalah berat sendiri pelat, sedangkan

beban total yang diterima oleh pelat terjadi saat pelat sudah



3

komposit. Untuk pelat pracetak (precast slab), ada beberapa jenis

yang umum digunakan yaitu :

i
SOLID FLAT SLAB HOLLOW CORE SLAB DOUBLE TEE SINGLE TEE

Gambar 2.1: Jenis-jenis penampang pelat pracetak
Sumber: PCI 6 Edition

1. Pelat pracetak berlubang (Hollow Core Slab)

Pelat pracetak dimana ukuran tebal lebih besar dibanding dengan
pelat pracetak tanpa lubang. Biasanya pelat tipe ini menggunakan
kabel pratekan. Keuntungan dari pelat jenis ini adalah lebih ringan,
tingkat durabilitas yang tinggi dan ketahanan terhadap api sangat
tinggi. Pelat jenis ini memiliki lebar rata-rata 2 hingga 8 feet dan
tebal rata-rata 4 inchi hingga 15 inchi.

2. Pelat pracetak tanpa lubang (Solid Slabs)

Adalah pelat pracetak dimana tebal pelat lebih tipis dibandingkan
dengan pelat pracetak dengan lubang. Keuntungan dari
penggunaan pelat ini adalah mudah dalam penumpukan karena
tidak memakan banyak tempat. Pelat ini bisa berupa pelat pratekan
atau beton bertulang biasa dengan ketebalan dan lebar yang

bervariasi. Umumnya bentang dari pelat ini antara 5 hingga 35 feet.
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Dalam tugas akhir ini plat pracetak tanpa lubang yang akan

digunakan.

3. Pelat pracetak Double Tees dan Single Tee

Pelat ini berbeda dengan pelat yang sudah dijelaskan sebelumnya.
Pada pelat ini ada bagian berupa dua buah kaki sehingga tampak
seperti dua T yang terhubung.

2.2.1.2 Balok
Balok memikul beban pelat dan berat sendiri. Selain itu,

balok juga berfungsi untuk memikul beban-beban lain yang
bekerja pada struktur tersebut. Untuk balok pracetak (Precast
Beam), terdapat beberapa jenis balok yang digunakan seperti

Rectangular Beam, L-Shaped Beam, Inverted T Beam dan | Beam.

77777

o dslel S Joafave CTaas e e

RECTANGULAR L-SHAPED BEAM INVERTED TEE AASHTO BEAM
BEAM BEAM

Gambar 2.2: Jenis-jenis penampang balok pracetak



2.2.2 Sambungan

Dalam perencanaan struktur dengan beton pracetak, hal
yang menjadi perhatian utama adalah sambungan. Selain berfungsi
untuk menyalurkan beban-beban yang bekerja, sambungan juga
berfungsi menyatukan masing-masing komponen beton pracetak
menjadi satu kesatuan yang monolit sehingga dapat mengupayakan
stabilitas struktur bangunannya.

Secara umum jenis sambungan antar komponen dapat
dikatagorikan menjadi 2 kelompok sebagai berikut:

1. Sambungan kering (dry connection)

Sambungan kering menggunakan bantuan pelat besi sebagai
penghubung antar komponen beton pracetak dan hubungan antara
pelat besi dilakukan dengan baut atau dilas. Penggunaan metode
sambungan ini perlu perhatian khusus dalam analisa dan
pemodelan komputer karena antar elemen struktur bangunan dapat
berperilaku tidak monolit.

2. Sambungan basah (wet connection)

Sambungan basah terdiri dari keluarnya besi tulangan dari
bagian ujung komponen beton pracetak yang mana antar tulangan
tersebut dihubungkan dengan bantuan mechanical joint,
mechanical coupled, splice sleeve atau panjang penyaluran.
Kemudian pada bagian sambungan tersebut dilakukan pengecoran

beton ditempat.



2.3 Perencanaan Beton Pracetak

Ketentuan perencanaan beton pracetak mengacu pada SNI
Beton 2847:2013 pasal 16.  Adapun hal-hal yang harus
diperhatikan berdasarkan peraturan tersebut adalah sebagai
berikut:

1. Distribusi gaya diantara komponen struktur

2. Desain komponen struktur

3. Integritas struktur
4

. Desain sambungan dan tumpuan
2.4 Pembebanan

2.4.1 Beban-Beban Pada Struktur
1. Beban Statis

Beban statis adalah beban yang bekerja secara terus-menerus
pada suatu struktur. Beban statis juga diasosiasikan dengan beban-
beban yang secara perlahan lahan timbul serta mempunyai variabel
besaran yang bersifat tetap (steady states). Dengan demikian, jika
suatu beban mempunyai perubahan intensitas yang berjalan cukup
perlahan sedemikian rupa sehingga pengaruh waktu tidak
dominan, maka beban tersebut dapat dikelompokkan sebagai

beban statik (static load). Deformasi dari struktur akibat beban
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statik akan mencapai puncaknya jika beban ini mencapai nilainya
yang maksimum. Beban statis pada umumnya dapat dibagi lagi
menjadi beban mati, beban hidup, dan beban khusus, yaitu beban

yang diakibatkan oleh penurunan pondasi atau efek temperatur.

2. Beban Dinamis

Beban dinamis adalah beban yang bekerja secara tiba-tiba
pada struktur.Padaumumya, beban ini tidak bersifat tetap
(unsteady-state) sertamempunyai karakterisitik besaran dan arah
yang berubah dengan cepat. Deformasi pada struktur akibat beban
dinamik ini juga akan berubah-ubahsecara cepat. Yang termasuk
dalam beban dinamik ini adalah seperti beban akibat getaran

gempa /angin.

2.4.2 Beban-Beban yang diperhitungkan

Dalam perencanaan struktur gedung ini, beban yang
bekerja adalah beban gravitasi berupa beban mati dan beban

hidup serta beban lateral berupa beban gempa.

1. Beban Mati (Dead Load)

Berdasarkan SNI-1728-2013 yang dimaksud dengan
beban mati adalah berat semua bagian dari suatu gedung yang
bersifat tetap, termasuk segala beban tambahan, finishing, mesin-

mesin serta peralatan tetap yang merupakan bagian yang tak
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terpisahkan dari gedung tersebut. Semua metode untuk
menghitung beban mati suatu elemen adalah didasarkan atas
peninjauan berat satuan material yang terlihat dan berdasarkan
volume elemen tersebut. Beban-beban yang dipakai tersebut
mengacu pada PPIUG 1983.
2. Beban Hidup (Live Load)

Berdasarkan SNI-1728-2013 yang dimaksud dengan
beban hidup adalah semua beban yang terjadi akibat pemakaian
dan penghunian suatu gedung,termasuk beban-beban pada lantai
yang berasal dari barang-barang yang dapat berpindah dan/atau
beban akibat air hujan pada atap. Beban hidup yang dipakai
mengacu pada PPIUG 1983.

3. Beban Gempa

Besarnya beban gempa yang terjadi pada struktur bangunan
tergantung dari beberapa faktor yaitu, massa dan kekakuan
struktur, waktu getar alami dan pengaruh redaman dari struktur,
kondisi tanah, dan wilayah kegempaan dimana struktur bangunan
tersebut didirikan. Massa dari struktur bangunan merupakan faktor
yang sangat penting, karena beban gempa merupakan gaya inersia
yang besarnya sangat tergantung dari besarnya massa dari struktur.
Besarnya Beban Gempa Dasar Nominal horizontal akibat gempa
ditentukan menurut Standar Perencanaan Ketahanan Gempa Untuk
Struktur Gedung (SNI 1726 2012)



2.5 Sistem Struktur

Sebelum menghitung struktur bangunan, SNI 1726-2012
mensyaratkan untuk menentukan sistem bangunan terlebih dahulu
yang nantinya akan dipakai dalam pembahasan sub bab
perencanaan struktur selanjutnya dan berikut adalah langkah-
langkah menentukan sistem struktur bangunan antara lain :
Menentukan nilai Ss dan S;

Menentukan kelas situs berdasarkan data tanah yang ada.
Menentukan koefisien lokasi Fa dan Fv

Menghitung nilai Spsdan Sz

Menghitung Sps dan Sp1

Menentukan kategori resiko bangunan

Menentukan kategori desain gempa (KDG)

00 S="M 01 “sh_YIL ==

Dengan memakai data Sps dan Kategori desain gempa didapat

sistem bangunan yang dipakai.
2.6 Perencanaan Struktur Atas

2.6.1 Perencanaan Pelat Lantai
Tebal minimum pelat dengan balok yang menghubungkan
tumpuan pada semua sisinya dengan dengan i—z < 2 maka harus

memenuhi ketentuan sebagai berikut (SNI 2847:2013, Pasal
9.5.3.3):
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- Untuk am < 0,2, harus memenuhi ketentuan (SNI 2847:2013,
tabel 9.5(c)) dan tidak boleh kurang dari nilai berikut:
Pelat tanpa panel drop (drop panels) > 125 mm
Pelat dengan panel drop (drop panels) > 100 mm

- Untuk 0,2 < am < 2,0, ketebalan pelat minimum harus
memenuhi :

I n(o,8+ SU7

hiZ 1400J > 125 mm. RuMus2-1

36 +50(af m—0,2)

- Untuk am > 2,0 ketebalan pelat minimum tidak boleh kurang

dari
In[0,8 T fy]
h= 1400 > 90 mm
36 +945
Rumus2-2
Ya
afm &= nfn

Rasio kekakuan balok terhadap pelat :

of = M >1 (SNI 2847:2013, Pasal 13.3.6) Rumus2.3
EcpxIp
Dimana :

Ecb = modulus elastisitas balok beton

Ecp = modulus elastisitas pelat beton
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Ib = momen inersia terhadap sumbu pusat penampang bruto balok
Ip = momen inersia terhadap sumbu pusat penampang bruto pelat
Dalam buku Disain Beton Bertulang, oleh Chu Kia Wang
dan Charles G. Salmon jilid 2 disebutkan bahwa:
e oam < 0.375 sebagai pelat tanpa balok tepi
e 0.375<am<1.875 sebagai pelat dengan balok tepi yang
fleksibel
e am>1.875 sebagai pelat tanpa balok tepi yang kaku
Perhitungan momen — momen yang terjadi pada pelat berdasarkan
Peraturan Beton Bertulang Indonesia tahun 1971 (PBBI 1971)
adalah sebagai berikut :
Jika pelat terjepit penuh pada ke-empat sisinya;
Mix  =+40,001 x g x Ix?2 x X
Mly  =+40,001 xqgx Ix2x X
Mtx  =-0,001xqgxIx?x X
Mty =-0,001xqgxIx?>xX
(dimana harga X bisa dilihat pada Tabel 13.3.1, PBBI 1971)

Penulangan pelat

1. Rasio penulangan:

- Rasio penulangan minimum plat : p . = 0,0018

- Perhitungan p balance dan p max berdasarkan SNI 2847:2013
Pasal B.8.4.2
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v 0.85x g, x f. 600 il 4
f, 600+ f,
Prax = 0,750, Rumus 2-5
Pperts = i(l— 1—Mj Rumus 2-6
m fy

2. Kontrol jarak spasi tulangan. (SNI 2847:2013, Pasal 7.6.5)
Smax < 3 X h

Smax < 450 mm

3. Kontrol tulangan susut dan suhu.
Tulangan susut dan suhu harus paling sedikit memiliki rasio luas
tulangan terhadap luas bruto penampang beton sebagai berikut,
tetapi tidak kurang dari 0,0014. (SNI 2847:2013, Pasal 7.12-2-1)
1. Kontrol jarak spasi tulangan susut dan suhu.
S < 5h atau 450mm. (SNI 2847:2013,, Pasal 7.12-2.2)
2. Kontrol Retak

s =380 (Zfﬂ) £2.5C, < 300(@) (SNI-2847-2013)

Rumus 2-7
fs = §fy Rumus 2-8
3. Penulangan Pelat Sebelum Komposit Akibat

Pengangkatan



13

Besarnya momen dan pengaturan jarak tulangan
angkat sesuai “PCI Handbook, 6" Edition” berdasarkan
empat titik angkat dimana momen daerah tumpuan sama
dengan momen daerah lapangan, yaitu sebagai berikut :

Mx = 0,0107 x wx a®x b
My = 0,0107 X W X ax b? Rumus 2-9

2.6.2 Perencanaan Balok

2.6.2.1 Penulangan Lentur

Kriteria perencanaan lentur adalah ¢ Mn > Mu dimana :

¢ = adalah faktor reduksi kekuatan = 0,9 (SNI 2847-2013,
Pasal 9.3.2.7)
Mn = kuat momen nominal penampang

Mu momen terfaktor yang ditahan oleh penampang tersebut

Untuk menghitung momen pada pelat, maka digunakan
tabel. (PBI 71)

Untuk mencari tulangan perlu, maka menggunakan :

_085x f.'x B 600

X SNI1:2847-2013, Pasal
2 f 600+ 7,
B.8.4.2) Rumus 2-10
dimana :

P, = rasio tulangan berimbang
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B, = 0,85 untuk fc’ < 28 Mpa

Nilainya berkurang 0,05 untuk setiap kenaikan 7 MPa dari fc’ >
28 MPa (SNI 03-2847-2013, pasal 12-2.7)

f_ = Kuat tekan beton yang disyaratkan, Mpa
fy = tegangan leleh baja, Mpa
Rasio tulangan maksimum dibatasi sebesar :
Puaks = 0,75 p, (SNI 2847-2013, Pasal B.10.3.3)

Rumus 2-11
Rasio tulangan minimum dibatasi sebesar :

(SNI 2847-2013, Pasal 10.5.1)

fy fy
Rumus 2-.12
dengan
fy
= Rumus 2-13
0,85 x fc'
Mn
Rn = o 3 Rumus 2-14
b.d

Maka didapatkan :
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pperluz%Ll 1@] Rumus 2-15

Y]

Menentukan luas tulangan (As) dari W yang didapatkan :
As .., =pbd

perlu

Rumus 2-16
Dengan spasi antar tulangan :

a. tulangan utama harus berjarak bersih minimum sebersar db
b. atau > 25 mm (SNI 2847-2013, Pasal 7.6.1)

2.6.2.2 Penulangan Geser dan Torsi

Perencanaan penampang terhadap geser harus didasarkan pada :

PV, >V, (SNI 2847-2013, Pasal 11.1.1)
V.=V, +Vq Rumus 2-17
dimana :

V Y = geser terfaktor pada penampang yang ditinjau
V" = kuat geser nominal
V ¢ = kuat geser beton

V¢ = kuat geser nominal tulangan geser

Perencanaan penampang terhadap torsi :

T, <¢ T, (SNI 2847-2013, Pasal 11.5.3.5)
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Rumus 2-18
Tulangan sengkang untuk puntir :
2.A A .f
T = AR coto (SNI 2847-2013, Pasal 11.5.3.6)
S
Rumus 2-19
dimana :

T, = momen torsi terfaktor
T, = kuat momen torsi
T . = kuat torsi nominal yang disumbang oleh beton

T, = kuat momen torsi nominal tulangan geser

Ao = luas bruto yg dibatasi oleh lintasan aliran geser, mm2

1. Kontrol Torsi
Pengaruh torsi harus diperhitungkan bila :

2
T, < $0.0831,/ f c(A“—pJ (SNI 2847-2013, Pasal 11.5.1)

cp
Rumus 2-20
Untuk struktur statis tak tentu, harga T, boleh diambil

sebesar :

2
T, <$0.331,/ f c[ﬂ—p] (SNI 2847-2013, Pasal 11.5.2-2)

cp
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Rumus 2-21
2. Kontrol Penampang
Penampang menurut SNI 2847-2013, pasal 11.5.3, dikatakan
cukup bila :

2 2 p
Vu + Tu'ph <¢X VC h 2\/T
b, xd 17xA,2) " |b,xd 3

(SNI 2847-2013, pasal 11.5.3.(1.a)) Rumus 2-22

3. Tulangan Sengkang Torsi

A T,

S :goszoxfytxcota

Rumus 2-23
5
dimana : @ = 45° dan cot® = AN«
Sehingga sengkang untuk menahan geser dan torsi adalah sebagai
berikut:
Ry gy
< % Rumus 2-24

Sedangkan tulangan sengkang minimum :



18

b,S _ b,

Av +2At =0.062,/f'c AR (SNI 2847-2013, pasal
w w

11.5.5.2) Rumus 2-25

4. Tulangan Torsi Longitudinal

f
A :%x P, x(f—w]xcotza

v (SNI 2847-2013, pasal

WSR3
Rumus 2-26
Minimum tulangan torsi memanjang :
0.42,/ fc' x At f
Aminy = Ay (AL X p, X2 Rumus 2-27
fy fy
(SNI 2847-2013, pasal 11.5.5.3)
0.175b
A . Rumus 2-28

dengan — 2
S f

w
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2.6.3 Perencanaan Komponen terkena beban lentur dan

aksial

Perencanaan kolom dilakukan melalui pengecekan momen
dan beban aksial yang bekerja pada penampang terhadap diagram
interaksi P-M vyang diperoleh dari penampang yang telah
ditentukan dimensi serta tulangannya. Suatu kombinasi beban yang
diberikan pada kolom tersebut bila diplotkan ternyata berada dalam
diagram interaksi dari kolom yang dibuat maka beban tersebut
dapat dipikul oleh kolom. Begitu juga sebaliknya apabila suatu
kombinasi beban tersebut ada di luar diagram maka kapasitas

kolom tidak memenuhi.

1. Perhitungan Tulangan Geser Kolom
Untuk komponen struktur yang dikenai tekan aksial

Nu
14.44

Ve =017 (1 + )/1,/ Fieb,d  (SNI 2847:2013, Pasal 11.2-

1.2) Rumus 2-29

Ny
— (dalam Mpa)
Ag

Spasi maksimum sengkang di daerah tumpuan (sepanjang lo) dan
di lapangan mengacu pada SNI 2847:2013, pasal 21.3.5.2
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2.7 Pondasi

Pondasi merupakan bagunan perantara untuk meneruskan
beban bagian atas dan gaya-gaya yang bekerja pada pondasi
tersebut ke tanah pendukung di bawahnya. Untuk merencanakan
pondasi harus memperhatikan beberapa hal diantaranya jenis
tanah, kondisi tanah dan struktur tanah, karena sangat berkaitan
dengan daya dukung tanah tersebut dalam memikul beban yang
yang terjadi di atasnya. Penyelidikan atas tanah tersebut sangatlah
perlu dilakukan agar mendapatkan parameter-parameter sebagai
masukan dalam perencanaan, agar didapatkan pondasi yang aman,

ekonomis dan efisien.

Kemampuan Tiang Pancang

Kemampuan tiang pancang dalam menahan beban luar
ditentukan berdasarkan dua keadaan yaitu :
e Daya dukung tiang pancang tunggal yang berdiri sendiri

¢ Daya dukung tiang pancang dalam kelompok

1. Daya Dukung Tiang Pancang Tunggal

Perhitungan daya dukung tiang pancang ini berdasarkan
hasil uji Standard Penetration Tes (SPT). Wika memodifikasi
perumusan dari mayerhof untuk menghitung daya dukung tiang

pancang tunggal seperti ditunjukan pada Rumus 2-30.
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Quic = 40A,N,, + AS}:‘"’ Rumus 2-30
Dimana :
Qut = Daya dukung tiang ultimate (Ton)
Ap = Luas penampang dasar tiang (m?)
Np = Nilai SPT didasar tiang sepanjang 4D diatas s/d 4D
dibawah ujung tiang
(D = Diameter tiang pancang)
Nav = Nilai rata-rata SPT sepanjang tiang dengan nilai 3 <

N <50
(N = Nilai SPT)
2. Daya Dukung Tiang Pancang dalam Kelompok
Dalam menentukan besarnya gaya yang bekerja pada satu

tiang pancang dalam kelompok tiang ditentukan berdasarkan

31.
it % o M"Z"f;':“" & Myz"gza" Rumus 2-31
Dimana :
Pi = Gaya aksial satu tiang pancang (Ton)

2V, =Jumlah beban vertikal (Ton)

n = Jumlah tiang pancang

Mo = Momen yang bekerja didasar poer dalam arah sumbu x
(Tonm)
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Myo = Momen yang bekerja didasar poer dalam arah sumbu y
(Tonm)
D = Jarak dari sumbu tiang ke titik berat susunan kelompok

tiang searah sumbu x

Dyi = Jarak dari sumbu tiang ke titik berat susunan kelompok
tiang searah sumbu y

Xmax = Absis terjauh terhadap titik berat kelompok tiang (m)
Ymax = Ordinat terjauh terhadap titik berat kelompok tiang (m)
Dari gaya aksial P;yang maksimum dan minimum harus dikontrol

terhadap daya dukungnya seperti pada 32

Brax < Qq = Qult/SF Rumus 2-32

Dimana :

Pmax = Gaya aksial Pjyang maksimum (Ton)

Qu = Daya dukung ijin (Ton)

Quit = Daya dukung tiang ultimate (Ton)

SF = faktor keamanan sebesar 2

Daya dukung satu tiang pancang dalam kelompok tersebut harus

dikalikan suatu faktor efisiensi yang ditentukan berdasarkan

Ey=1—tan"12 W} Rumus 2-33
N 90omn

Dimana :

Ex = Faktor efisiensi tiang pancang dalam kelompok

D = Diameter tiang pancang (m)
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S = Jarak tiang pancang terkecil (m)
n = Jumlah tiang pancang dalam baris
m = Jumlah tiang pancang dalam kolom

3. Daya Dukung Lateral Tiang Pancang

Dalam menentukan daya dukung lateral tiang pancang terdapat
dua jenis tiang diantara lain :

e Tiang dengan kepala tidak tertahan

e Tiang dengan kepala tertahan

Untuk setiap jenis tiang tersebut ditinjau terhadap dua keadaan
jenis tanah yaitu :

e Jenis tanah kohesip

e Jenis tanah tidak kohesip
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BAB I1I
METODOLOGI

3.1 Umum

Metodologi ini akan menguraikan dan menjelaskan urutan
penyelesaian tugas akhir secara rinci. Langkah-langkah
penyelesaian yang akan dilakukan penulis dapat dilihat pada
Gambar 3.1.

Identifikasi Masalah
Studi Literatur
Pengumpulan Data

Pemilihan Kriteria
Desain

Preliminary Desain
Analisa Struktur

Perencanaan Elemen
Struktur

Perencanaan
Sambungan
Kontrol
Sambungan
Ya
Gambar Teknis

Selesai

Gambar 3.1: Diagram alir penyelesaian tugas akhir
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3.2 Pembahasan Metodologi

Diagram alir pada Gambar 3.1 merupakan acuan untuk
merencanakan struktur Gedung Hotel Fave Ketintang Surabaya

dengan perkuatan pada struktur betonnya.

3.2.1 ldentifikasi Masalah

Identifikasi masalah merupakan suatu langkah awal untuk
mendefinisikan tentang permasalahan yang perlu diangkat dan
dibahas dalam penyelesaian tugas akhir ini, sehingga hasil yang
akan didapatkan dapat bermanfaat baik bagi akademisi maupun
praktisi. ldentifikasi masalah dilakukan dengan cara membaca
jurnal baik international maupun nasional, literatur dan para

peneliti sebelumnya.

3.2.2 Studi Literatur

Studi literatur merupakan suatu tahapan yang dilakukan
untuk mencari acuan perhitungan dan persyaratan secara teoritis
untuk menunjang permasalahan dalam tugas akhir ini. Acuan
perhitungan dan persyaratan tersebut antara lain :

1. Tata cara perencanaan struktur beton untuk bangunan gedung
(SNI 2847-2013).
2. Tata cara perencanaan ketahanan gempa untuk bangunan

gedung



(SNI 1726-2013).

3. PCI Design Handbook 6™ Edition (MNL 120-04).

4, Peraturan Pembebanan Indonesia untuk Gedung (PPIUG ’83).
5. Asumsi dasar perhitungan beton bertulang (Edward G Nawy,
1985).

3.2.3 Pengumpulan Data

Cakupan pengumpulan data terkait perencanaan Gedung Hotel
Fave Ketintang Surabaya antara lain :

1. Gambar Struktur Eksisting.

2. Gambar Arsitek Eksisting.

3. Gambar Struktur Modifikasi.

4. Data Tanah.

Selain cakupan data tersebut didapatkan pula data umum
bangunan antara lain :

e Tipe Bangunan  : Gedung Hotel.

e Letak Bangunan :Jauh dari Pantai (Surabaya Barat).
e Desain Seismik  : Desain Seismik D (Surabaya).

e Tipe Tanah : Tanah Lunak.

e Tinggi Bangunan :46.2m

e Jumlah Lantai : 13 Lantai

e  Struktur Bangunan : Beton Bertulang.
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Gambar 3.2: Denah Struktur Lantai 1 Fave Hotel
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dari suatu komponen struktur yang mengacu pada ketentuan
SNI 2847:2013. Beberapa komponen struktur tersebut antara
lain :

1. Balok

2. Plat Lantai

3. Kolom

4. Tangga

3.2.4 Pembebanan

3.2.4.1 Beban Hidup

Berdasarkan PPIUG 1983, beban hidup Gedung
Apartemen harus diambil paling sedikit sebesar 250 kg/m?.
Sedangkan untuk beban hidup pada atap harus diambil paling
sedikit sebesar 100 kg/m?.

3.2.4.2 Beban Gempa

Perhitungan beban gempa ditentukan berdasarkan SNI
1726-2012.

3.2.4.3 Kombinasi Pembebanan

Kombinasi pembebanan diambil berdasarkan SNI
2847:2013.
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3.2.5 Analisa Struktur

Langkah analisis struktur dilakukan untuk mengetahui
gaya dalam yang akan terjadi pada suatu elemen struktur. Dalam
analisis struktur ini dibagi menjadi dua bagian dalam tahap
penyelesaiannya yaitu :

1. Analisis struktur sekunder

2. Analisis struktur primer
3.2.4.1 Analisis Struktur Sekunder

Analisis struktur sekunder dilakukan dengan cara manual,
yaitu dengan menggunakan pembebanan tibutari akibat
pembebanan yang terjadi pada plat lantai, lalu dihitung gaya-gaya
dalam yang terjadi.

3.2.4.2 Analisis Struktur Primer

Analisis struktur primer dilakukan dengan menggunakan
program bantu analisis struktur. Prosedur analisis struktur
didasarkan pada SNI 1726:2012.

3.2.6 Perencanaan Struktur Sekunder

Perencanaan struktur sekunder dilakukan dengan cara
mengambil output gaya-gaya dalam dari hasil proses analisis

struktur sekunder. Gaya-gaya dalam tersebut menjadi acuan untuk
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perencanaan dalam struktur sekunder. Beberapa elemen struktur

sekunder yang akan di rencanakan antara lain :

1. Plat Lantai
2. Balok Anak
Bt Lifi

4. Tangga

Langkah-langkah dibawah ini hanya tidak menjelaskan langkah-
langkah perencanaan lift dan tangga karena memiliki langkah
perencanaan yang hampir sama dengan perencanaan balok anak
dan plat lantai.

3.2.7 Perencanaan Struktur Primer

Perencanaan struktur primer dilakukan dengan cara
mengambil output gaya-gaya dalam dari hasil proses analisis
struktur primer dengan menggunakan program bantu analisis
struktur. Gaya-gaya dalam tersebut menjadi acuan untuk
perencanaan dalam struktur sekunder. Beberapa elemen struktur
sekunder yang akan di rencanakan antara lain :

1. Balok Induk
2. Kolom

3. Hubungan Balok Kolom



3.2.8 Kontrol Penanganan Elemen Pracetak

Kontrol penanganan elemen pracetak mengacu pada PCI 6™
Edition Chapter 5.
3.2.9 Perencanaan Sambungan
Dalam perencanaan sambungan pracetak, gaya — gaya
disalurkan dengan cara menggunakan sambungan grouting,
kunci geser, sambungan mekanis, sambungan baja tulangan,
pelapisan dengan beton bertulang cor setempat, atau
kombinasi cara — cara tersebut.
1. Sambungan Balok-Kolom
Sambungan balok-kolom direncanakan dengan
menggunakan sambungan brakit dengan overtopping.
Untuk perhitungan sambungan mengacu pada SNI
2847:2013.
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Gambar 3.3: Sambungan balok kolom dengan menggunakan sambungan
momen



2. Sambungan Pelat Lantai-Balok
Sambungan balok dan pelat di rencanakan berdasarkan

desain emulasi (PCI 6" Edition MNL 120-04).

Gambar 3.4: Desain sambungan diafragma balok dan pelat lantai

Sambungan Balok Anak-Balok Induk

%
Pada sambungan antara balok anak dengan balok induk, balok

anak direncanakan dengan sistem brakit dengan overtopping

seperti pada gambar 3.7 berikut.

Gambar 3.5: Sambungan balok induk-balok anak (Brakit)

Untuk spesifikasi dan perhitungan Brakit mengacu pada
SNI:2847-2013 Pasal 11.8
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3.2.10 Perencanaan Pondasi

Perencanaan Pondasi dilakukan dengan cara mengambil
output gaya-gaya dalam dari hasil proses analisis struktur primer
dengan menggunakan program bantu analisis struktur. Gaya-gaya
dalam tersebut menjadi acuan untuk perencanaan pondasi.

Beberapa komponen yang akan direncanakan antara lain :

i, Tiang Pancang
2. Poer
3. Sloof

3.2.11 Gambar Teknis

Gambar teknis merupakan tahapan akhir dari penyelesaian
tugas akhir yang berfungsi sebagai output akhir dari analisis
struktur yang telah dilakukan. Penggambaran akan dilakukan

dengan menggunakan program bantu penggambaran.
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BAB IV
PRELIMINARY DESIGN

4.1 Data Desain

Bahan yang dipakai untuk struktur gedung ini adalah beton
bertulang dengan data-data sebagai berikut:

Tipe Bangunan : Hotel
Katagori Seismik Desain :D
Tinggi Bangunan 146.2m
Lebar Bangunan :13.2m
Panjang Bangunan :28.8m

Denah struktur gedung Hotel Fave Surabaya diperlihatkan
sesuai gambar 4.1

VL e A +| =77 g 1i| L E 1 II 7\

¢ “LM 4 R S -
| [
2 3
Gambar 4.1 Denah Struktur Hotel Fave Surabaya

|
1

4.2 Dimensi Balok

Balok adalah salah satu komponen struktur yang
berkemampuan menahan lentur. Sesuai dengan RSNI 2847:2013 Ps.
9.5 tabel 9.5(a), desain dimensi balok (tinggi minimum balok ) dengan
bentang seperti pada Gambar 4.2 adalah shb :
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e Dimensi Balok Primer (L =7.2m)

Gambar 4.2 Balok Primer (B1)

h—720—4475 60
s W@k G

2
b=§x70=40cm

Maka dimensi balok primer memanjang adalah 40/60 cm

e Dimensi Balok Sekunder 1 (L =5.4 m)

Gambar 4.2 Sekunder (B2)
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h—700—3333 50
=7 = 3333~ 50cm

b =§x 50 = 33.33 cm ~ 30 cm

Maka dimensi balok sekunder memanjang adalah 30/50 cm

Tabel 4.1 Resume Pendimensian Balok

Tipe Balok Dimensi ( cm)
b h
B1 ( B.Primer) 40 60
B2 (B.Sekunder1) | 30 50

4.3 Dimensi Pelat Lantai

e Desain tebal pelat lantai 1 s/d 13
Perhitungan tipe pelat A dengan dimensi seperti pada

gambar 4.4
« B =
A A
A A
A A
< | o)

Gambar 4.3 Pelat Lantai Tipe A
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Ly =335cm
Lx=170cm

Direncanakan dengan tebal pelat, t = 12 cm
f’c =25 Mpa ; fy = 240 Mpa

Balok As Joint 2 (A — B) seperti pada gambar 4.5

1

. =4 .

Gambar 4.4 Balok As Joint D - 2

Menentukan lebar efektif flens (Pasal 13.2.4 SNI-2847-2013)
>be=bw+ 2hb < bw + 8hr
be=bw + 2hb

be= 40 + 2(60 — 12) = 136 cm
be=bw+ 4hf
be=40+4X%x12=88cm
diambil beterkecil = 88 cm

k =

4 (- @[+ () + G

1+ G- 1) ()
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2 3
1+ (53~ 1) (85)[+- 0 (68 ++(5) + G- &) |
ko= 88 12
1+ (35~ 1) (5)
1.71
k:m=1.38

Momen inersia penampang
b,,h3 40 x 603

L Y — 4
Iy =k 12 — .38 12 = 993600 cm
Momen inersia Pelat
el Erandl Siekil CrarAN |
P — s A 12 = cm
Rasio Kekakuan balok terhadap pelat

4 I, y 993600

= 39.43

1= T 25200
p

e Balok As Joint 2’ (A - B) seperti pada gambar 4.6

" o YL | [ gl S

Gambar 4.5 Balok As Joint 2 (A-B)
Menentukan lebar efektif flens (Pasal 13.2.4 SNI-2847-2013)
2>be= bw+ 2hb < bw+ 8hr
be= bw+ 2hb
be=30+42(50—-12) =106 cm
be = bw+ 4hf
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be=30+8x%x12=126cm
diambil beterkecil = 106 cm

(- )@@ 40 + G- )@ ]

k=
be t
1+ (5= 1) (5)
106 12 12 1272 /106 1233
A 1+(w—1)(%)[4—6(%)+4(5—o) +(30-1)(50) ]
? CA )
30 0
A Ay /) AVA
2 /1 6 N4
Momen inersia penampang
I, = kbwh3 =1 6930x sl 528125 cm*
b= 12 — - T cm
Momen inersia Pelat
T 20 G P12 0
P — W B 12 = cm
Rasio Kekakuan balok terhadap pelat
I, 528125
=—=———=20.96

%2= 1 = 25200
p

1
=7 (3943 +2096) = 15.1

Karena afm > 2 dipakai persamaan (9-13), SNI-2847-2013 Pasal
9.5.3.3. dan tidak boleh kurang dari 90 mm.
L, (08 + {—YOO)
T 36+98

> 90 mm

4000 (0.8 + %000)

36+ 9x 116 =83.67mm = 120 mm
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h=120mm =90mm ...... (OK)
— Karena nilai h lebih besar dari 90 mm, maka digunakan tebal
pelat lantai 1 s/d 13 dengan tipe A adalah 12 cm.

Dengan cara yang sama didapatkan resume ketebalan pelat
dari masing-masing tipe pelat seperti pada table 4.2

Tabel 4.2 Resume Ketebalan Pelat Lantai

Tipe Lantai Dimensi Tebal Ket
Lx Ly

A 1s/d12 | 170 335 120 mm | 1 arah

B 1s/d12 | 215 335 120 mm | 2 arah

3 1s/d12 | 120 335 120 mm | 1arah

4.4 Desain Dimensi Kolom

Berdasarkan denah struktur pada Gambar 4.9 Desain kolom
yang memikul beban terbesar adalah kolom yang memikul plat lantai
dengan bentang terbesar yaitu pada kolom As B-15 sebagai mana
diperlihatkan pada Gambar 4.10.

Menurut  SNI-2847-2013 pasal 10.8. kolom harus
direncanakan untuk memikul beban aksial terfaktor yang bekerja pada
semua lantai atau atap dan momen maksimum dari beban terfaktor
pada satu bentang terdekat dari lantai atau atap yang ditinjau.
Direncanakan

Direncanakan :

Tebal Pelat =12 cm =120 mm

Tinggi Lantai 1 =480 cm

Tinggi lantai 2 s/d atap =320 cm

Beban hidup (Lo) =1.92 KN/m2 (SNI-1727-2012 Tabel 4-1)
Luas Tributari (AT) =7.2x7.8 =56.16 m2

KLL = 4 (berdasarkan ilustrasi pada SNI-1727-

2012 Gambar C4)
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1
—
—————1

L
|

—
|

——

Gambar 4.7 Daerah Pembebanan Kolom As B-3

Detail Pembebanan Pada Kolom
Beban Mati Lantai atap

Pelat Lantaiatap =72 x 78 x 012 x 24 x 1 = 127.01kN
Penggantung =72 X 718 X x 0.07 x = 3.09kN
Plafon =72 x 18 Xx x 011 x = 4.85kN
Balok B1 (40/60) =04 x 06 x 133 x 24 X = 89.38 kN
Balok B2 (30/50) =03 x 05 x 72 x 24 X = 20.16 kN
Spesi t=2 cm =72 x 18 x x 021 x = 9.26 kN
Mekanikal =72 x 78 X x 04 x = 17.64kN
Total Beban Mati = 281.97 kN
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Beban Mati Lantai 1 s/d 12

Pelat Lantai =72 x 78 x 012 x 24 x 12 = 139.09kN
Penggantung =72 x 78 X x 007 x 12 = 33.96kN
Plafon =72 x 78 X x 011 x 12 = 485kN
Balok B1 (40/60) = 0.4 x 0.7 x 133 x 24 = 89.38kN
Balok B2 (30/50) =03 x 04 x 72 x 24 = 20.16 kN
Spesi t=2 cm S A2 (X )78 % x 021 x 12 = 101.87 kN
Tegel t=1 cm =72 x 718 X x 024 x 12 = 116.42KkN
Aspal =72 X 78 X x 014 x 1 = 6.17kN
Mekanikal =72 x 78 X x 04 x 12 = 194.04kN

Total Beban Mati = 2069.78 kN
Total Keseluruhan Beban Mati = 2351.75 kN

Menurut SNI-1727-2012 Pasal 4.8 komponen struktur yang

memiliki nilai K.A;=>37.16 m2 diijinkan untuk dirancang dengan
beban hidup tereduksi sebagai mana ditunjukan pada Rumus 3.10

Ar =7.0 X 6.3 = 44.1m?

KyAr = 4 X 56.16 = 224.64 m?

Maka, 224.64 m? > 37.16 m? (Beban hidup boleh direduksi)

1.

Reduksi Beban Hidup Pelat Lantai 1 s/d 11
) > 0.4L,

=, <0.25 +
KLLAT
L= 192(025+4'—57)>04><192
' V22464
L = 1.14 kN/m? > 0.768 kN /m?
Jadi total beban hidup pelat lantai 1 s/d 11
Lt1—-11=1.14 X7.2x7.8x12=553.014 kN

Reduksi Beban Hidup Pelat Lantai Atap

Reduksi beban hidup plat lantai atap (Lr) ditentukan sesuai
dengan Rumus 3.11 Karena Ar=44.1 m2 (perhitungan
sebelumnya) maka,

R, =1.2-0.011x56.16 = 0.715

R,=1(F<4)

L, =L,R{R, = 0.96 x 0.715 X 1 = 0.686 kN /m?

0.58 < L, < 0.96, Maka Lr =0.686 kN/m?

Jadi, total beban hidup pelat lantai atap :

Lt Atap = 0.686 x 7.2 x 7.8 =30.26 kN
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Kombinasi Beban

Q, =14D = 1.4 x 2351.75 =3292.45 kN

Q,=12D +1.6L+ 0.5Lr

Q, =1.2x2351.75 + 1.6 X 553.014 + 0.5 x 0.686
= 3707.27 kN

Diambil kondisi paling menentukan

Quitimate = 3707.27 kN

Mutu Beton = 35 Mpa

&
Dimensi :A = —— = 379727X10 _ 353473 33 mm?
0.3xf/ 0.3x35

Dimensi: h = b jadi A =b X b = b?

b = vA = v/353073.33 = 594.2 mm ~ 600 mm

h=b =600mm

Maka, dipakai dimensi kolom 60 cm x 60 cm pada seluruh
kolom gedung hotel Fave Ketintang

4.5 Desain Dimensi Dinding Geser

Menurut SNI-2847-2013 pasal 14.5.3.(1) : ketebalan dinding

pendukung tidak boleh kurang dari 1/25 tinggi atau panjang bentang
tertumpu, yang lebih pendek, atau kurang dari 100 mm.
Direncanakan:

Tebal Dinding Geser =40 cm

Panjang bentang : 400 cm

40 cm = H/25
40 cm > 480/25
40cm =24 cm
40cm = L/25
40 cm = 675/25
40cm =27 cm

Tidak boleh kurang dari 100 mm

Jadi, tebal shearwall sebesar 40 cm telah memenuhi syarat SNI-
2847-2013 Pasal 14.5.3.(1).
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BAB V
PERENCANAAN STRUKTUR SEKUNDER

5.1 Perencanaan Pelat

Peraturan yang digunakan untuk penentuan besar beban yang
bekerja pada struktur pelat adalah Tata Cara Perhitungan
Pembebanan Untuk Bangunan Rumah dan Gedung (SNI-1727-
2012). Pelat direncanakan menerima beban mati dan beban hidup
dengan kombinasi pembebanan SNI-2847-2013 Pasal 9.2.1 yaitu:

e Qu=14D

e Qu=12D+1.6L +0.5(Lratau R)

Desain Pelat direncanakan pada beberapa keadaan, yaitu :

1. Sebelum Komposit, keadaan ini terjadi pada saat awa
pengecoran topping yaitu komponen pracetak dan komponen
topping belum menyatu dalam memikul beban. Perletakan
pelat dapat dianggap sebagai perletakan bebas.

2. Sesudah Komposit, keadaan ini terjadi apabila topping dan
elemen pracetak pelat telah bekerja bersama-sam dalam
memikul beban. Perletakan pelat dianggap sebagal
perletakan terjepit el adtis.

Permodelan pelat terutama perletakan baik pada saat sebelum
komposit dan setelah komposit akan digunakan untuk perhitungan
tulangan pelat. Pelat pada saat awal pemasangan atau saat sebelum
komposit diasumsikan tertumpu pada dua tumpuan.

Sedangkan pada saat setelah komposit diasumsikan sebagai
perletakan terjepit elastis. Penulangan akhir nantinya merupakan
penggabungan pada dua keadaan diatas. Selain tulangan untuk
menahan beban gravitasi perlu juga diperhitungkan tulangan
angkat yang sesuai pada pemasangan pelat pracetak. Perletakan
pada plat yang dipakai diasumsikan sebagai perletakan jepit.
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5.1.1 Pembebanan Pelat

Data Desain

Data-data desain yang dibutuhkan dalam perhitungan lantai adalah
sebagai berikut:

e Mutu Beton (f’c) =25 Mpa —-£1=0,85
o Tebal Pelat (1) =120 mm

¢ Selimut Beton =20 mm

e Modulus Elagtisitas = 200000 Mpa

e Kuat Lelah (fy) =240 Mpa

o Faktor Reduksi (¢) =038

Untuk mengantisipasi adanya penumpukan saat pengecoran
topping maka tebal topping dalam perhitungan beban perlu
diadakan penambahan ketebal an topping sebelum komposit setebal
0,02 m sehingga dalam perhitungan ketebalan topping menjadi
0,07 m (dalam perhitungan beban sgja).

Pembebanan Pelat lantai 2 5/d 13

Pelat direncanakan menerima beban mati dan beban hidup
dengan kombinasi pembebanan yang sesuai dengan SNI-2847-
2012 pasal 9.2.(1), yaitu sebesar :
1. Beban Mati (DL)

Sebelum komposit
Berat sendiri =0,07 X 24  =1.68 kN/m?
Berat topping =0,07 X 24 =1.68 kN/m?
DL= 3.36 kN/m?
Setelah komposit
Berat sendiri =0,12m X 24 = 2.88 kN/m?
Plafond =0.11 = 0.11 kN/n?
Penggantung =0.07 = 0.07 kKN/n?
Tegel (t=1cm) =0,01m X 24 = 0.24 KN/n?
Spesi (t=2cm) =0,02m X 21 = 0.42 kKN/nm?
Ducting AC = 0.20 KN/n?
Plumbing = 0.10 KN/n?
DL = 4.02 kN/m?
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2. Beban Hidup (LL)
Beban hidup (Lo) = 1.92 kN/m? (SNI-1727-2012 Tabel

4-1)
Luas Tributari (A) = 1.7 x 3.35= 6.48 n?
Ku =1 (SNI-1727-2012 Tabel 4-2)

A #2ilf703.35688.7m >

¥ ol o2 1 Xl =57 3

Maka, 5.7 m*< 37.16 m? (Beban Hidup tidak boleh

direduksi)

Maka, Beban hidup lantai 2 s/d 12 = 1.92 kN/m?
3. Kombinasi Pembebanan

Sebelum Komposit

Sebelum Overtopping

Qu = 14D = 1.4 x 1.68 = 2.35 kN /m?

Qu = 1.2D + 1.6L + 0.5(L, atau R)

Qu,=12x%1.68+ 1.6 x 0.96 = 4.42 kN /m?

Saat Overtopping

Qu = 14D = 1.4 x 3.36 = 4.7 kN /m?

Qu = 1.2D + 1.6L + 0.5(L, atau R)

Q,=12%336+1.6x0=4.03kN/m?

Setelah Komposit

Qu = 14D = 1.4 X 4.02 = 5.63 kN/m?

Qu = 1.2D + 1.6L + 0.5(L, atau R)

Qu=12%X4.02+1.6xX1.92 = 7.9 kN/m?

Pembebanan Pelat |lantai Atap
Pelat direncanakan menerima beban mati dan beban hidup
dengan kombinasi pembebanan yang sesuai dengan SNI-2847-
2012 pasal 9.2.(1), yaitu sebesar :
1.Beban Mati (DL)

Sebelum komposit
Berat sendiri =0,07 X 24 =1.68 kN/m?
Berat topping =0,07 X 24 =1.68 kKN/m?

DL=3.36 kN/m?



Setelah komposit

Berat sendiri =0,12m X 24 = 2.88 kN/m?
Plafond =011 = 0.11 kKN/n?
Penggantung =0.07 = 0.07 kN/m?
Tegel (t=1cm) =0,01m X 24 = 0.24 kN/m?
Spesi (t=2cm) =0,02m X 21 = 0.42kN/m?
Ducting AC = 0.20 kN/n?
Plumbing = 0.10 KN/m?

DL = 4.02 kN/m?

Beban Hidup (LL)
Beban hidup (Lo) = 0.96 kN/m? (SNI-1727-2012 Tabel

4-1)
Luas Tributari (A)) = 1.7 x 3.35= 6.48 n?
KiL =1 (SNI-1727-2012 Tabel 4-2)

Ar = 1.7 x 3.35 = 5.7m?

K, A7 = 1x 5.7 = 5.7 m?

Maka, 5.7 m*< 37.16 m? (Beban Hidup tidak boleh
direduksi)

Maka, Beban hidup lantai atap = 0.96 kN/nv
Kombinas Pembebanan

Sebelum Komposit

Sebelum Overtopping

Q, = 14D = 1.4 x 1.68 = 2.35 kN /m?

Qu = 1.2D + 1.6L + 0.5(L, atau R)
Q,=12x1.68+1.6x0.96 = 4.42 kN/m?
Saat Overtopping

Q, = 14D = 1.4 x 3.36 = 4.7 kN /m?

Qu = 1.2D + 1.6L + 0.5(L, atau R)
Q,=12x336+1.6 %0 =4.03kN/m?
Setelah Komposit

Q, = 14D = 1.4 X 4,02 = 5.63 kN /m?

Q, = 1.2D + 1.6L + 0.5(L, atau R)
Qu=12x4.02+1.6 X 0.96 = 6.36 kN/m?




55

5.1.2 Penulangan Pelat Lantai Tipe A
Dimensi pelat lantai tipe A seperti ditunjukan pada gambar 5.1

T B I Tl R E:

Sebelum Komposit

(Sebelum Overtopping)

e

(Saat Overtopping)

A

HH
Setelah Komposit

i

l

I B
| A

Ve 7A POTONGAN A - A

Gambar 5.1 Penampang dan Potongan Melintang Plat Lantai Tipe A

Data Perencanaan:

Dimensi Pelat = 1700 mm x 3350 mm
Tebal Pelat =120 mm

Tebal Decking =20 mm

Diameter Tulangan =12mm

Mutu Tulangan (fy) =240 Mpa

Mutu Beton (f°¢c) =25Mpa; p1=0.85
Ly/Lx =198

1. Penulangan Sebelum K omposit

Penulangan Sebelum Overtopping

Pada Penulangan Pelat A sebelum komposit pelat dianggap
terletak bebas di atas dua tumpuan.

Qu = 4.42 kKN/m?

12
d=70—20—7=44mm
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0.85 % f/ X By 600
Pp = X
fy 600 + fy

~0.85x25x0.85 600

= X = 0.
g 240 600 1 240 _ 2054

Pmax = 0.75p, = 0.75 %X 0.06324 = 0.04
Pmin = 0.0014 (SNI-2847-2013 Pasal 7.12.2.1)
! 2 1 2
ML, = <§x q X Ly> = §X 442 X 3.35% = 6.2 kNm
= 6200000 Nmm

Penulangan Arah-y

Mty = Mly = Mu = 6200000 Nmm
® =090 (SNI-2847-2013:9.3.2.1)

D20t QP2EA0" Qs - My
"TT T T 09 -
Mn 6889368

T b.d? 1000 x 442

Rn 3.56

fy 240

E. = = 11.294
085x f'c 085 x 25 7

m

1 2Zm X Rn
pperlu:a 1 _T



_ 1 [, [, _2x11294x356
Preriv = 77504 240

= 0.0163

Pmin < pperlu < Pmax
Maka, dipakai pperiy = 0.0163

ASperi = p-b.d = 0.0163 x 1000 X 44 = 718.7 mm?

1
AS1 tuiangan = ZnDZ =0.25 X X 122 = 113.1 mm?

As
PERE_ /6.3

n v -oams -~
PR AS1 tuiangan

Dipakai 7412 (As = 791.3 mm?)

As.fy  226.1% 240

@ =085 fleb  085x25x1000 o0 mm

OMn = @As.fy (d — %)

8.9
@Mn = 0.9 X 791.3 X 240 (44 4 7) = 6760000 Nmm
¢Mn = 6760000 Nmm > Mu = 6200000 Nmm (OK)

1000 1000
= =——=166.67mm = 160 mm
n—1 7-1

Kontrol Spasi Tulangan:

S >25mm (SNI-2847-2013 Pasdl 7.6.2)
S < (2h=240 mm) (SNI-2847-2013 Pasal 13.3.2)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)

160 mm > 25 mm (OK)

57
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160 mm < 240 mm (OK)
160 mm < 450 mm (OK)

Maka, dipakai tulangan utama ¢12 — 160 (arah-y)
Untuk penulangan arah-x dipakai penulangan bagi, sehingga
dipakai tulangan ¢12 — 240.

Penulangan Saat Overtopping
Qu = 4.7 KN/nv

12
d=70—20—7=44mm

085X f/XpB, 600
Pp = X
fy 600 + fy

~ 0.85x25x%0.85 600

2 — 0.054
Po 240 X 500+ 240 ~ 20

Pmax = 0.75p, = 0.75 X 0.06324 = 0.04

Pmin = 0.0014 (SNI-2847-2013 Pasal 7.12.2.1)
1 2 1 2

Mty = ML, = (§><q ><Ly> = (§><4.7>< 3.35 ): 6.6 kNm
= 6600000 Nmm

Penulangan Arah-y

My = Mu = 6600000 Nmm
=09 (SNI-2847-2013:Ps9.3.2.1)

Mu 6.6 X 10°

Mn =—= = 25799 N
n 2 09 7325799 Nmm
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Mn 7325799

"= p.d% T 1000 x 442
fy 240
Mm=085xfc_ 0.85x%25
1 2Zm X Rn
Ppertu = — AL > 7y

p (1 0% V0% e
Preriv = 7504 240

= 0.0175

Pmin < Ppertu < Pmax

ASpern = p-b.d = 0.0175 x 1000 X 44 = 769.8 mm?

1
ASi pyiangan = ZnD2 =0.25x T x 122 = 113.1 mm?

As
Xt PEIWY Xk 6.81 ~ 7

n E=3
i As 1 tulangan

Dipakai 712 (As = 791.3 mm?)

As.fy 7913 x 240

4 L L2726
@ = 085.fc.b  0.85x 25 x 1000 &

OMn = 9As. £y (d - %)

8.9
PMn = 0.9 X 791.3 x 240 (44 ~ 7) = 6760000 Nmm
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#Mn = 6760000 Nmm > Mu = 6600000 Nmm (OK)

1000 1000
= =——=166.67mm = 160 mm
n—-1 7-1

Kontrol Spasi Tulangan:

S>25mm (SNI-2847-2013 Pasal 7.6.2)
S <(2h=240 mm) (SNI-2847-2013 Pasal 13.3.2)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)
160 mm > 25 mm (OK)

160 mm < 240 mm (OK)
160 mm < 450 mm (OK)

Maka, dipakai tulangan utama ¢12 — 160 (arah-y)

Untuk penulangan arah-x dipakai penulangan bagi sehingga

dipakai tulangan ¢12 — 240

2. Penulangan Setelah Komposit

Qu = 7.9 kN/m?
42
d= 120—20—7=94mm

_ 0.85x fl X By 600

X
Pb Fy 600 + fy
_085x25x085 600 .
Po = 240 600 + 240

Pmax = 0.75p, = 0.75 x 0.06324 = 0.04

Prmin = 0.0014 (SNI-2847-2013 Pasal 7.12.2.1)
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1 1
Mt, = Ml, = (§ X q X L§,> = (§ X 7.9 X 3.352) = 11.08 kNm

= 11080000 Nmm

Penulangan Arah-y

Mx = Mu = 11080000 Nmm
® =09 (SNI-2847-2013:9.3.2.1)

Mu 11.08 x 10°
Mn=—=———00+=12313576 Nmm
) 0.9

Mn 12313576

~b.dZ 1000 x 942

)0 Kb D0 Q4e
M= 085xfc 0.85x25

Rn 1.394

=11.294

1 2Zm X Rn
pperluza < _T

_ot (] 2x11294x13%
Preriv = 77504 240

= 0.006

Pmin < pperlu < Pmax
Maka, dipakai prin= 0.006

ASperpy, = p-b.d =0.006 X 1000 X 94 = 565 mm?

1
AS1 tyiangan = ZT[DZ = 0.25 X T x 122 = 113.1 mm?
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As erlu
14 =5

n S
e A51 tulangan

Dipakai 5¢12 (As = 565.2 mm?)
As.fy 5652 240

@ =085 fc.b 085x25x 1000
a
OMn = QAs. fy (d - E)

= 6.4mm

6.4
@Mn = 0.9 X 565.2 X 240 (94 - 7) = 11090000 Nmm
¢Mn = 11090000 Nmm > Mu = 11080000 Nmm (OK)

1000 1000
S = —

=av] m =250 mm
Kontrol Spasi Tulangan:
S>25 mm (SNI-2847-2013 Pasal 7.6.2)
S < (2h=240 mm) (SNI-2847-2013 Pasal 13.3.2)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)
250 mm > 25 mm (OK)

250 mm < 240 mm (Tidak Memenuhi)
250 mm < 450 mm (Tidak Memenuhi)

Maka, dipakai tulangan utama ¢12 — 240 (arah-y)
Untuk penulangan arah-y dipakai penulangan bagi ¢12 — 240

3. Perhitungan Penulangan Pelat Sebelum Komposit Akibat

Pengangkatan

Besarnya momen dan pengaturan jarak tulangan angkat sesuai
“PCl Handbook, 6" Edition” berdasarkan empat titik angkat
dimana momen daerah tumpuan sama dengan momen daerah

lapangan, yaitu sebagai berikut :



Mx =0,0107 x w X &x b
My =0,0107 x w X ax b?
Pada pelat tipe 1,7 x 3,35 ditentukana= 1,7 danb = 3,35
denganw = 0,07 x 24 + 0.96 = 2.64 kN/m?
Maka: Mx = 0,0107 x 4.42 x 1.8%x 3,6 = 0.458 kNm
= 0.458 x 10° Nmm
My = 0,0107 x 4.42 x 1.8 x 3.62=0,90 kNm
=0.9x 106 Nmm

Penulangan Arah-x

TR Mx  0.458 x 10° N i
SRR g5 mminT. peicn e

Mn 508889

Rn = =
"= p.d%? T 1000 x 322

= 0.497

) 4 fy 240
M= 085% f'c 0.85x 25

= 11.294

1 2m X Rn
Pperu = | 1= ST

b |y _2x11294x 0497
Preriv = 7504 240
Pmin < Pmin < Pmax

Maka, dipakai pmin= 0.0021
ASperi = p-b.d = 0.0021 x 1000 x 32 = 67.1 mm?

= 0.0021

1
AS1 tuiangan = ZT[DZ =0.25 X x 122 = 113.1 mm?
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ASperiu
4 —1

n =
futangan A51 tulangan

Dipakai 5¢12 (As = 565.2 mm?)
As. fy M 113 x 240

4= 0.85.f'c.hb 0.85x 25 x 1000
a
oMn = 9As. fy (d — E)

=1.3mm

13
@Mn = 0.9 x 113 x 240 (32 . 7) = 770000 Nmm
#Mn = 770000 Nmm > Mu = 458000 Nmm (OK)

1000 1000
S 0= c Y

220 m = 1000 mm
Kontrol Spasi Tulangan:
S >25 mm (SNI-2847-2013 Pasal 7.6.2)
S <(2h=240 mm) (SNI-2847-2013 Pasal 13.3.2)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)

1000 mm > 25 mm (OK)

1000 mm < 240 mm (Tidak Memenuhi)
1000 mm < 450 mm (Tidak Memenuhi)
Maka, dipakai tulangan utama ¢12 — 240 (arah-x).

Penulangan Arah-y

Mn = Ur ¥~ 10° = 1000000 N
n= (Z) = 09 = mm
b Mn 1000000 -
= p.dZ 71000 x 442 T
240
m Iy =11.294

~085xfc 0.85x25



1
Ppertu = — NS "1 d

_1 [, _2x11294x0517
Preriv = 771504 240

Pmin < Pmin _S Pmax
Maka, dipakai pperiu= 0.0022
ASperiy = p-b.d = 0.0021 X 1000 X 32 = 67.1 mm?

= 0.0022

1
ASy piiangan = ZnDZ =0.25 X T X 122 = 113.1 mm?

As erlu
14 |

n T oo e
ke ASl tulangan

Dipakai 512 (As = 565.2 mm?)
As.fy 113 x 240

=085 fc.b  0.85x25x1000
a
PMn = QAs. fy (d - E)

=1.3mm

13
@Mn = 0.9 x 113 X 240 (44 - 7) = 1060000 Nmm
¢Mn = 1060000 Nmm >Mu = 900000 Nmm (OK)

~ 1000 of 1000 Vi

o R A
Kontrol Spasi Tulangan:
S >25mm (SNII-2847-2013 Pasal 7.6.2)
S < (2h=240 mm) (SNI-2847-2013 Pasal 13.3.2)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)
1000 mm > 25 mm (OK)

1000 mm<240 mm  (Tidak Memenuhi)
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1000 mm <450 mm  (Tidak Memenuhi)

Maka, dipakai tulangan utama ¢12 — 240 (arah-y).

5.1.3 Penulangan Pelat Lantai Tipe B
Dimensi pelat lantai tipe B seperti ditunjukan pada gambar 5.2

_AA

Sebelum Komposit

(Sebelum Overtopping)

Lf“’;*’:?t:f**’-‘::‘r:ﬁ’:.i

TN

\
B
\

Sebelum Komposit

(Saat Overtopping)

Setelah Komposit
THTETTTE PEEETTTRRT R LRI T sorefican B A

A

Gambar 5.2 Penampang dan Potongan Melintang Plat Tipe B

Data Perencanaan:

Dimensi Pelat = 2150 mm x 3350 mm
Tebal Pelat =120 mm

Tebal Decking =20 mm

Diameter Tulangan =12 mm

Mutu Tulangan (fy) =240 Mpa

Mutu Beton (f’c) =25 Mpa ; f1=0.85



1. Penulangan Sebelum K omposit
Penulangan Sebelum Overtopping
Qu = 4.42 KN/m?

My = My, = 0.001 X @ X L3 X X,
My = My, = 0.001 X 442 x 2.15% x 58 = 1.19 kNmm
M., = My, = 0.001 X Q,, X L X X,,
My, = My, = 0.001 X 4.42 x 2.15% X 36 = 0.74 kNmm

12
dx = 70—20—7=44mm
0.85 % f X B, 600
= X

Pb fy 600 + fy
_085x25x085 600 .
Po = 240 600 + 240

Pmax = 0.75p, = 0.75 X 0.06324 = 0.04
Pmin = 0.0014 (SNI-2847-2013 Pasal 7.12.2.1)

Penulangan Arah-x
Mx = Mu = 1190000 Nmm

® =09 (SNI-2847-2013:9.3.2.1)

_ Mu 119X 10°

Mn = = = 1322222 N
n 2 09 mm

Mn 1322222

= = = 0.683
b.d? 1000 x 442

Rn
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Sy 20 o0
M= 085xfc 085%x25

1 2m X Rn
Pperu = | 1= 1_T

__ 1t [, [, _zx11294x0683)_
Pperiv = 77504 240 =<

Pmin 2 pperlu < Pmax
Maka, dl pakal pperlu: 00029
ASperpy, = p-b.d = 0.0029 X 1000 x 44 = 127.3 mm?

1
AS) tylangan. = ZnDZ’ =0.25 x 1 X 122 = 113.1 mm?

M=113~2

n =3
Sy Asl tulangan

Dipakai 2912 (As = 226.2 mm?)
As.fy 2262 %240

4= 085.fc.h 0.85x 25 x 1000
a
oMn = As. fy (d - E)

=2.6mm

2.6
@Mn = 0.9 X 226.2 X 240 (44 - 7) = 2090000 Nmm
#Mn = 2090000 Nmm > Mu = 1190000 Nmm (OK)

_1000 1000
i1 @PrLS RS

Kontrol Spasi Tulangan:
S>25mm (SNI-2847-2013 Pasal 7.6.2)



S < (2h=240 mm) (SNI-2847-2013 Pasal 13.3.2)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)

1000 mm > 25 mm (OK)

1000 mm < 240 mm (Tidak Memenuhi)
1000 mm <450 mm (Tidak Memenuhi)
Maka, dipakai tulangan utama ¢12 — 240 (arah-x).

Penulangan Arah-y
My = Mu = 740000 Nmm

® =09 (SNI-2847-2013:9.3.2.1)

_ Mu 074 x 108

Mn = wela VY o1
o Mn o _ 822222
n=pdZ  1000x322
240
i 1y = 11.294

~085xfc  0.85x25

1 2Zm X Rn
Ppertu = — 45 Kg7Fy ©

2% 11.294 x 0.803

pperlu = m 1-— \]1 240 = 00034

Pmin = pperlu < Pmax
ASpery, = p-b.d = 0.0034 x 1000 x 32 = 108.8 mm?
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1
AS1 tylangan = ZnDZ =0.25 X1 x 122 = 113.1 mm?

As
P li-peniy 7| 094 ~ 2

Ntulangan =
i A51 tulangan

Dipakai 2¢12 (As = 226.2 mm?)
As. fy _226.2x 240

4= 085.fc.b 0.85x 25 x 1000
a
OMn = QAs. fy (d - E)

= 2.6 mm

1.3
PMn = 0.9 x 226.2 X 240 (32 — 7) = 770000 Nmm
#Mn = 770000 Nmm > Mu = 740000 Nmm (OK)

1000 1000
S = =

] m = 1000 mm
Kontrol Spasi Tulangan:
S>25mm (SNI-2847-2013 Pasal 7.6.2)
S < (2h=240 mm) (SNI-2847-2013 Pasal 13.3.2)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)
1000 mm > 25 mm (OK)

1000 mm < 240 mm (Tidak Memenuhi)
1000 mm < 450 mm (Tidak Memenuhi)

Maka, dipakai tulangan utama ¢12 — 240 (arah-y).

Penulangan Saat Overtopping
Qu = 4.7 KN/n??

Mg, = My, = 0.001 X Q, X L2 x X,



M,, = M;,, = 0.001 X 4.7 X 2.152 X 58 = 1.26 kNmm
My, = My, = 0.001x Q, x [ X X,
M, = My, = 0.001 X 4.7 X 2.152 X 36 = 0.78 kNmm
12
dx = 70—20—7=44mm
12
dy = 70—20—12—7:32mm
_ 085X £l x By o 600
N fy 600 + fy

0.85 x 25 x 0.85 600
Pp = X
240 600 + 240

Pp

= 0.054

Pmax = 0.75p, = 0.75 X 0.06324 = 0.04
Pmin = 0.0014 (SNI-2847-2013 Pasal 7.12.2.1)

Penulangan Arah-x

Mx = Mu = 1280000 Nmm
=09 (SNI-2847-2013:9.3.2.1)

M = Mu - 1.28 x 10° L1 4220880
LSl 2D gD mm

Mn 1422222
= 0.735

R - -
=147 T 1000 x 442

fy 240

= < = 11.294
=085 f'c 085x25 <
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1
Pper = —| 1= /1 po oy

__t [, |, _zx1294x0735)
Pperiv = 71594 240 =

Pmin p:S pperlu < Pmax
Maka, dipakai pperiy = 0.00312
ASperyy = p-b.d = 0.00312 x 1000 X 44 = 137.1 mm?

1
AS) tulangan = ZnDZ’ =0.25 X X 12%2 = 113.1 mm?

it 9205, @

n =3
tijgnaen Asl tulangan

Dipakai 2912 (As = 226.2 mm?)
As.fy 2262 %240

4= 085 fcbh  085x25x1000
a
PMn = QAs. fy (d - E)

=2.6mm

2.6
@Mn = 0.9 X 226.2 X 240 (44 - 7) = 2090000 Nmm
¢Mn = 2090000 Nmm > Mu = 1280000 Nmm (OK)

1000 1000
S = =

1 m = 1000 mm
Kontrol Spasi Tulangan:
S>25mm (SNI-2847-2013 Pasal 7.6.2)
S < (2h=240 mm) (SNI-2847-2013 Pasal 13.3.2)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)

1000 mm > 25 mm (OK)
1000 mm > 240 mm (Tidak Memenuhi)



1000 mm > 450 mm (Tidak Memenuhi)
Maka, dipakai tulangan utama ¢12 — 240 (arah-x)

Penulangan Arah-y

My= Mu = 780000 Nmm
@ =09 (SNI-2847-2013:9.3.2.1)

Mu  0.78 X 1192

Mn =—= — N
n 2 09 866666 Nmm

Mn 866666

Rn = =
"= p.d%? T 1000 x 322

= 0.846

fy 240

= = — 11.294
M= 085% f'c 0.85x 25 2

1 2Zm X Rn
Pperiu = — < _T

b |y _2x11.294x 0846
Preriv = 7504 240

= 0.0036

Pmin < pperlu =3 Pmax
Maka, dipakai pperiu= 0.0036
ASpery, = p-b.d = 0.0036 x 1000 x 32 = 115.2 mm?

1
AS1 tuiangan = ZﬂDZ =0.25 xw x 122 = 113.1 mm?
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As
_ Toperlu 1.09 =~ 2

n =
futangan A51 tulangan

Dipakai 2¢12 (As = 226.2 mm?)
As. fy _226.2x 240

4= 0.85.f'c.h 0.85x 25 x 1000
a
oMn = 9As. fy (d — 5)

= 2.6 mm

2.6
PMn = 0.9 x 226.2 X 240 (32 o 7) = 1500000 Nmm
#Mn = 1500000 Nmm > Mu = 780000 Nmm (OK)

1000 1000
S 0= = ¥

220 m = 1000 mm
Kontrol Spasi Tulangan:
S >25 mm (SNI-2847-2013 Pasal 7.6.2)
S < (2h=240 mm) (SNI1-2847-2013 Pasal 13.3.2)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)

1000 mm > 25 mm (OK)
1000 mm < 240 mm (Tidak Memenuhi)
1000 mm < 450 mm (Tidak Memenuhi)

Maka, dipakai tulangan utama ¢12 — 240 (arah-y)

2. Penulangan Setelah K omposit
Qu = 7.9 KN/n??

12
dx=120—20—7=94mm

12
dy=120—20—12—7=82mm

_ 0.85x b N 600
B fy 600 + fy

Pp



~0.85x25x0.85 600

= X = U.
Pb 240 600 + 240~ 0-0>4

Pmax = 0.75p, = 0.75 X 0.06324 = 0.04

Pmin = 0.0014 (SNI-2847-2013 Pasal 7.12.2.1)

M., = M;,, = 0.001 X Q,, X L2 X X,

My, = My, = 0.001 X 7.9 X 2.15% x 58 = 2.12 kNmm

Mgy, = My, = 0.001 X Q, X L X X,,
M.y = My, = 0.001 X 7.9 x 2.152 x 36 = 1.31 kNmm

Penulangan Arah-x

Mx = Mu = 2120000 Nmm
@ =090 (SNI-2847-2013:9.3.2.1)

_ Mu 212 10°

Mn = 3 09 = 2355555 Nmm

_ Mn 2355555
" b.d? 1000 x 942

ol Gantel G
M= 085xfc 085x25

Rn 0.267

=11.294

1 2m X Rn
Pperin = —( 1~ W7
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__ bt [, |, _2x11294x0267\_
Preriv = 71592 240 N

Pmin = pperlu

Maka, dipakai tulangan utama ¢12 — 240 (arah-x dan arah-y)

3. Perhitungan Penulangan Pelat Sebelum K omposit Akibat
Pengangkatan
Besarnya momen dan pengaturan jarak tulangan angkat sesuai
“PCl Handbook, 6" Edition” berdasarkan empat titik angkat
dimana momen daerah tumpuan sama dengan momen daerah
lapangan, yaitu sebagai berikut :

Mx = 0,0107 x w x &Xx b
My = 0,0107 X w X ax b?
Pada pelat tipe 2.15 x 3,35 ditentukana=2.15dan b =3.35
dengan w = 0,07 x 24 + 0.96 = 2.64 KN/m?
Maka: Mx = 0,0107 x 2.64 x 2.15°x 3.35 = 0.44 kKNm
=0.44 x 10° Nmm
My = 0,0107 x 2.64 x 2.15 x 3.35° = 0.68 KNm
=0.68 x 10° Nmm

Penulangan Arah-x
Mx = 440000 Nmm

AN Mx  0.44 x 10°  hashadh
n= @ = 0.9 = mm

_ Mn 488883
" b.d? 1000 x 322

>y fy 4 23
M= 085% f'c 0.85x 25

Rn 0.48

= 11.294



1
Pperu = | 1= "1 d

_o1 [, ], _2x11294x 048
Preriu = 771504 240

= 0.002

Pmin < pperlu = Pmax
ASperiy = p-b.d = 0.002 X 1000 X 32 = 64.4 mm?

1
ASy tiiangan.= ZnDZ = 0.25 X T X 122 = 113.1 mm?

aci Sracyi (o

n —
i ASl tulangan

Dipakai 2¢12 (As = 226.2 mm?)
As.fy  226.2X 240

=085 fc.b  0.85x25x1000
a
PMn = QAs. fy (d - E)

= 2.6 mm

13
@Mn = 0.9 X 226.2 X 240 (32 5 7) = 1500000 Nmm
¢Mn = 1500000 Nmm > Mu = 440000 Nmm (OK)

1000 1000
0= -

= m = 1000 mm
Kontrol Spasi Tulangan:
S >25 mm (SNI-2847-2013 Pasal 7.6.2)
S < (2h=240 mm) (SNI-2847-2013 Pasal 13.3.2)
S <450 mm (SNI-2847-2013 Pasdl 7.6.5)

1000 mm > 25 mm (OK)
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1000 mm < 240 mm (Tidak Memenuhi)
1000 mm < 450 mm (Tidak Memenuhi)

Maka, dipakai tulangan utama ¢12 — 240 (arah-x)

Penulangan Arah-y

My = 680000
iy sl 9:68. 10 perAny (s
SVT ST ¢
o Mn _ asesss
" p.dz T 1000x 442
fy 240
= = = 11.294
M= 085x f'c 0.85x% 25 ?
1 2Zm X Rn
Pperu = —| 1= 1= po oy

__ [, [, _zx1294x0253)
Prertu = 77504\ =7 |77 240 e

Pmin < pperlu < Pmax
Maka, d| paka] Pperlu = 0002

ASperpy = p-b.d = 0.00164 X 1000 x 32 = 72.2 mm?

1
ASyiangan = ZnD2 = 0.25 x T X 122 = 113.1 mm?

As
perlu
n =—=064=2
V4 Asl tulangan

Dipakai 2¢12 (As = 226.2 mm?)
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| Asfy | 2262x240
@ =085 fc.h 0.85x 25 x 1000

oMn = 9As.fy (d ~ g)

=2.6mm

2.6
@Mn = 0.9 X 226.2 X 240 (32 £ 7) = 1500000 Nmm
éMn = 2090000 Nmm > Mu = 680000 Nmm (OK)

1000 1000
S —— —

n_1 m = 1000 mm
Kontrol Spasi Tulangan:
S >25 mm (SNI1-2847-2013 Pasal 7.6.2)
S < (2h=240 mm) (SNI1-2847-2013 Pasal 13.3.2)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)
1000 mm > 25 mm (OK)

1000 mm < 240 mm (Tidak Memenuhi)
1000 mm <450 mm (Tidak Memenuhi)

Maka, dipakai tulangan utama ¢12 — 240 (arah-y)

5.1.5 Penulangan Stud Pelat L antai

Pada perencanaan yang memakai elemen pracetak dan
topping cor ditempat maka transfer gaya regangan horisontal yang
terjadi harus dapat dipastikan mampu dipikul oleh seluruh
penampang, baik oleh elemen pracetak maupun oleh topping cor
ditempat. Untuk mengikat elemen pracetak dan elemen cor
ditempat maka dipakai tulangan stud.

Stud ini berfungsi sebagai sengkang pengikat antar elemen
harus mampu mentransfer gaya-gaya dalam yang bekerja pada
penampang tekan menjadi gaya geser horisontal yang bekerja pada
permukaan pertemuan antara kedua elemen komposit dalam
memikul beban.
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Dalam SNI pasal gaya geser horisontal bisa diperiksa
dengan jalan menghitung perubahan aktual dari gaya tekan dan
gaya tarik didalam sembarang segmen dan dengan menentukan
bahwa gaya tersebut dipindahkan sebagai gaya geser horisontal
elemen — elemen pendukung.

Gaya geser horisontal yang terjadi pada penampang komposit ada
dua macam kasus :
o Kasus1: gayatekan elemen komposit kurang dari gaya
tekan elemen cor setempat
e Kasus2: gayatekan elemen komposit lebih dari gaya

tekan elemen cor setempat
Daerah Momen Positif

Topping som [ <}° Ce Ce
Pelat Pracetak
rem ) T T.

Kasus1,C<Cc Kasus2, C>Cc
Vnh=C=T Vnh=C<T

Daerah Momen Negatif o
Topping 5cm
Pelat Pracetak 7cm Cc

Gambar 5.3 Diagram Gaya Geser Horisontal Penampang Komposit

Vnh=C=T

Perhitungan Stud Pelat Lantai Tipe A dan Tipe B
Cc = 0.85. f'c. Atopping
Cc=0.85x%x25x50x 1000 =1062500 N = 1062.5 kN
Dipakai stud ¢ 12 mm
As = 1/4 xm x 122 = 113.1 mm?
Vnh =C=T
=Asx fy
=113,1 x 240 = 27144 N = 27.144 kN
0,55.4. = 0,55.bv.d = 0,55 X 1000 X 94 = 56400 N
=56.4kN > Vnh
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Sesual dengan SNI-2847-2013 pasal 17.5.3.2:
Bila pengikat minimum disediakan sesuai dengan 17.6 dan bidang
kontaknyabersih dan bebas dari serpihan tapi tidak dengan sengaja
dikasarkan, maka kuat geser Vnh tidak boleh diambil lebih dari
0,55.b,.d dalam Newton. Pasa 17.6.1 berbunyi bahwa bila
pengikat dipasang untuk menyalurkan geser horizontal, luas
pengikat tidak boleh kurang dari yang diperlukan oleh 11.4.6.3,
dan spasi pengikat tidak boleh melebihi empat kali dimensi terkecil
elemen yang ditumpu, atau melebihi 600 mm.
SNI-2847-2013 pasal 11.4.6.3:

0,35.b,,.S 0,35 x 1000 x 240

A o
maka dipasang stud ¢ 12-300 mm ( Av = 452.4 mm?)

= 350 mm?

5.1.6 Kontrol Lendutan dan Retak

e Kontrol Lendutan
Berdasarkan SNI-2847-2013 hila ketebalan plat yang
digunakan melebihi batas minimum ketebalan plat, maka
kontrol lendutan tidak perlu dilakukan. Kontrol lendutan ini
dimaksudkan agar perencana mengetahui perilaku dari plat
lantai ini.

L endutan Pelat A

dl

1
7 A (g x 1.92 X 3.352) = 2.69

Ma = Mygmari + Micxiaup = 564 + 2.69 = 8.33 kNm
bh® 1000 x 1203

L e 12

fr=0.62/fc=0.62vV25 = 3.1 Mpa

= 1.44 x 108 mm*
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_ 2fply 231 x1.44 % 10°

= 744 kN
T Th 120 kNm

Karena Ma > Mcr, maka inersia yang digunakan adalah
inersia penampang efektif (le).

E. = 4700,/f'c = 4700v25 = 2.35 x 10* Mpa

_E, 200000 _

25 B S35000
bc? 5

ICT = T - TlAs(d — C)

¢ = tinggi sumbu netral dari tepi serat tertekan ke sumbu
netral penampang transformasi, maka:

As =012 — 160

),
T+nAsc —ndgd =0
160c?

+851x113.1c—8.51%x113.1x94=0

—>c%2412c—-1131=0->c = 28.16 mm

1000 x 28.163

I = 3 + 8.51 X 791.8(94 — 28.16)?

= 36653030 mm*
M\ Mc\°
le (M_a) g+ [1 v (M_a) fer
7.44\3
(—) 1.44 x 108 + |1 - (

le 8.33

=1.13 x 108 mm*

4 3
3.67 x 107
8.33 ) ]
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Defleks Jangka Pendek
Swi* 5w x 3350* 698X 107

A= = r
384E., 384x2.35x10* X1, I,

w

Defleksi Beban Hidup Sesaat
6.98 x 107(4.02 + 1.92) 6.98 x 107(4.02)
Q)L = =

1.13 x 108 1.44 x 108
=172 mm

Defleks Beban Mati Sesaat

L _698X107(402) _
C4oasent eyl QL €

Defleksi Jangka Panjang
Berdasarkan SNI-2847-2013 untuk durasi |ebih dari 5
tahun digunakan £=2
A=06E§=06x%x2=1.2
L endutan yang terjadi ditentukan dengan rumus
Apr= (AL + A[(A)pL +0.2(4) 1]

=172+ 1.2[1.94+ 0.2 X 1.72] = 4.46 mm

Berdasarkan SNI-2847-2013 Tabel 9.5(b) batasan lendutan
untuk pelat lantai adalah [/240.

Lendutan Pelat A
L _3350 _ ...
240 2480 P 11" 8

App=4.46 < 2%0 13.95 (Ok, Lendututan memenuhi)

e Lendutan Pelat B
My prari = 0.001 X 4.02 X 2.152 x 58 = 1.08 kNm
Mitx nigup = 0.001 X 1.92 X 2.15? X 58 = 0.51 kNm



Ma = Myxemari + Miexniaup = 1.08 + 0.51 = 1.59 kNm
bh3® 1000 x 1203
=977 12
fr =0.62,/f'c = 0.62v25 = 3.1 Mpa
2f;l;  2%x3.1x144x108
Mo == = 120

= 1.44 x 10% mm*

=7.44 kNm

Karena Ma < Mcr, maka inersia yang digunakan adalah
inersia penampang kotor (1g).

E. = 47004/ f'c = 4700V25 = 2.35 X 10* Mpa

@) _ 5Mgl* 5% 1.59 x10°x 2150°
VPLHLL T 48E 1, ~ 48 x 2.35 X 10% X 1.44 x 108
= 0.23mm
Mp, 1.08
Api (= (A =————x023
= 0.16 mm
My 0.51
=0.1mm

Berdasarkan SNI-2847-2013 untuk durasi lebih dari 5
tahun digunakan £=2
A=06E§=06%x2=1.2
Lendutan yang terjadi ditentukan dengan rumus
Apr= (B + A[(A)pL + 0.2(4y) L]

=0.1+1.2[0.16 + 0.2 X 0.1] = 0.32 mm
Berdasarkan SNI-2847-2013 Tabel 9.5(b) batasan
lendutan untuk pelat lantai adalah [/240.

Lendutan Pelat B

1 QoL e
TN, S AR sl
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l
Ar=032 < 210 8.9 (Ok, Lendututan memenuhi)

e Kontrol Retak

s =380 (z;i’) —25C, < 300("’%)

2 2
fs =3 fy = 5% 240 = 160 Mpa
C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C. =20mm

s =380 (%

s =615mm > 525mm

Maka, digunakan s =525 mm

Sui tipea=160 mm < 525 mm .....(OK).
Sl tipe=240 mm < 525 mm .....(OK).

)—2.5><20§300x(j—§g)

5.1.7 Panjang Penyaluran Tulangan Pelat
Panjang penyaluran harus disediakan cukup untuk tulangan
pelat sebelum dan sesudah komposit. Panjang penyaluran
didasarkan pada SNI-2847-2013 :
Lan > 8d,, SNI-2847-2013 Pasal 12.5.1
Lan > 150 mm SNI-2847-2013 Pasal 12.5.1

Lan = (0.24w,f,/AJf!)d, SNI-2847-2013 Pasal 12.5.2
dengan, ve=1.0

A=1.0
{)dh =8X12=96mm
'edh =150 mm

Lan = (0.24 x 1 x 240/1V25)d, = 138 mm
Maka, dipakai panjang penyaluran sebesar 150 mm



86

5.1.8 Per hitungan Tulangan Angkat

Dalam pemasangan pelat pracetak harus pula diingat bahwa
pelat akan mengalami pengangkatan sehingga perlu direncanakan
tulangan angkat untuk pelat.

Gambar 5.4 Jarak Tulangan Angkat (PCI Design Handbook, Precast and
Prestress Concrete, Sxth Edition)

o Gayaakibat pengangkatan akan ditranformasikan
kedua arah horisonta, yaitu arah i dan j.
e Tinggi kabel sling dari muka pelat direncanakan ,
h=15m.
e Pada perhitungan beban ultimate ditambahkan
koefisien kgjut (F = 1,2) pada saat pengangkatan.
e DL (Pelat A)=0.07x 1.7 x 3.35x 24 = 9.57 kN
e DL (Pelat B) =0.07 x 2.15x3.35x 24 = 12.1 kN
e beban pekerjaadalah 1 kN
Dalam hal ini dianggap ada 2 orang pekerja yang ikut serta diatas
pelat untuk mengatur dan mengarahkan posisi pelat, makalLL = 2
kN.
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Tulangan Angkat Pelat A

R o i~ &

Gambar 5.5 Titik Angkat Pelat Tipe A

Beban Ultimate = 1.2(1.2 X (9.57) + 1.6 X (2)) = 17.62 kN

17.62
Gaya angkat (Tu) setiap tulangan = TR 4.4 kN

fy 240

Jijin = E = E =160 Mpa (ASD)
Maka diameter tulangan angkat,

oS 4400

= = 27.5 mm?

Otarik ijin 160
0 = \/(4/7)Ag =  (4/1)27.5 = 5.92 mm
Dipakai diameter tulangan angkat = 12 mm

Astu =

Kontrol Tulangan Angkat
fpelat < 1:cr

fer untuk beton 3 hari adalah 2,4 Mpa
ye=0,5x 0,07 =0,035 m
Berdasarkan PCI Design Handbook, Precast and Prestress Concrete,
Sxth Edition, momen maks mum diperhitungkan
Berdasarkan gambar diatas:
e Arahisamadenganaahy
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o Arahj samadengan arah x

w ,
i (tpelat X 24) + </p1;eke_m>
pelat
= (0.07 X 24) + (=5 532 ) = 2.03 kN/m?
o )+ <1.7 X 3.35) /m

M, = 0.0107 X w X a® X b
M, = 0.0107 x 2.03 x 1.7% x 3.35 = 0.21 kNm
M, = 0.0107 X w X a X b?

M, = 0.0107 X 2.03 X 1.7 X 3.352 = 0.41 kNm

i (17'62) = 44 kN
a t( 1.8 )_ t( Id )—4553"
9\ o5s6b/2) ~ " I\(0586 % 335)/2) T
- t( 1.5 )_ t( 15 )—716°
1= 9 \os86as2) ~ I \(0586 x 17)/2) T T

¢ My ditahan oleh penampang selebar a/2 = 170/2=85 cm
P Xy, 4.4 % 0.035
M, = = ( - ) = 0.051 kNm
tg o« tg 71.6
Mio: = 0.41 + 0.051 = 0.461 kNm

1 1
S=g><b><h2=g><850><702=694167mm3
_0.62x4/f! 0.62xV25

=207 M
A SF 15 07 Mpa

o _MyoeF_0461x10°x12
Syl U@L @22 5 @) &

f: = 0.8 Mpa < f,, = 2.07 Mpa (OK)



¢ Mx ditahan oleh penampang selebar 15t = 1050 mm atau
b/4=837.5 mm
Diambil terkecil = 837.5 mm

ML (P X yc) [ ; (2.36 X 0.035) gl
*Q0eq %/ & tg 90 4
Moy = 0.214+0 = 0.21 kNm

il 1
§ =¢ xbxh* = =x837.5x 70 = 683958 mm?
_0.62x\f/ 0.62x+25

=207 M
" SF 15 Pg
o _MgeF_021x10°x12
U3 CleVEL \@L S0k Nl

ft = 0.37 Mpa < f, = 2.07 Mpa (OK)
Maka, pada pelat tipe A dapat dipakai empat titik angkat.

Tulangan Angkat Pelat B

Gambar 5.6 Titik Angkat Pelat Tipe B

Beban Ultimate = 1.2(1.2 x 12.1) + 1.6 X (2) = 21.26 kN

21.26
Gaya angkat (Tu) setiap tulangan = W al 5.31 kN

f, 240

89
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Maka diameter tulangan angkat,
T, 5130
Otarik ijin 160
@ = \/(4/7)As 1 = +/(4/m)32 = 6.38 mm
Dipakai diameter tulangan angkat = 12 mm

= 32 mm?

Astul =

Kontrol Tulangan Angkat
fpdat < fcr
for untuk beton 3 hari adalah 2,4 Mpa
ye=0,5x 0,07 =0,035 m
Berdasarkan PCl Design Handbook, Precast and Prestress
Concrete, Sxth Edition, momen maks mum diperhitungkan
Berdasarkan gambar diatas:
o Arahi samadenganarahy
o Arahj samadengan arah x

Wpekerja)

W = (tyoree X 24) + ( :
pelat

w = (0.07 X 24) + ( ) = 1.96 kN /m?

2.15x3.35

M, = 0.0107 X w X a? X b
M, = 0.0107 X 1.96 X 2.15% x 3.35 = 0.32 kNm
M, = 0.0107 x w X a X b*

M, = 0.0107 x 1.96 X 2.15 x 3.352 = 0.51 kNm
21.26
t ( - ) t ( d ) 62.27°
;= —_— ] = = .
= atIN\o2920/2) = ¥ M9\(0.292 x 3.6),2
y ( 1.5 ) ) ( 1.5 ) ol 70"
;= —_—] = = i
i~ I\ 0586a2) T V" 9I\(0.586 x 2.15)/2

¢ My ditahan oleh penampang selebar a/2 = 215/2=107.5 cm
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M. = Pxy.\ (5.31 X 0.035) — 0.078 kN
vy \tg o) " \tger22 )T m

M,,, = 0.51 + 0.078 = 0.588 kNm

il 1
S=—><b><h2=g>< 1075 x 70% = 877917 mm3

6
_0.62x\/ﬁ_0.62x\/25_207M

Ak U@ 7k @S @ik
B _Mtot.F_0.588><106><1.2_O8M
fe=h=—¢—="g77917  _ 08Mpa

ft = 0.8 Mpa < f,, = 2.07 Mpa (OK)

e Mx ditahan oleh penampang selebar 15t = 1050 mm atau
b/4=837.5 mm
Diambil terkecil = 837.5 mm

L (P X yc) (5.31 X 0.035)
* T \tg «; tg 90

M,or = 0.32 + 0 = 0.32 kNm
1 1
S =2 X bx h* = =x 8375 x 707 = 683958 mm®

_0.62x4/f! 0.62xV25

= =207 M
L SE 15 07 Mpa

I _th.F_O.32><106><1.2_056M
o S m O e S

f: = 0.56 Mpa < f,, = 2.07 Mpa (OK)
Maka, pada pelat tipe B dapat dipakai empat titik angkat.
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5.1.9 Resume Perencanaan Pelat Lantai

Tabel 5.1 Resume Perencanaan Pelat Lantai 2 5/d 12

Pelat Dua Arah

Tipe Pelat Penulangan Arah X Penulangan Arah Y
A - Sebelum K omposit Sebelum K omposit
-, S $12-240 $12-160
3 ; Setelah K omposit Setelah K omposit
A $12-240 $12-240
pr— Penulangan Stud Penulangan Stud
A PoronGANA-A $12-300 $12-300
Penulangan Angkat Penulangan Angkat
Lx = 1700 mm piZ-240 egede
Ly N 3350 mm Panjang Penyaluran = 150 mm
t =120 mm Retak > S= 160 mm < 525 mm
Pelat Satu Arah L e dutame
Tans T Sebelum Komposit Sebelum K omposit
—_— $12-240 $12-240
I ) Setelah Komposit Setelah Komposit
| B | $12-240 $12-240
‘ == Penulangan Stud Penulangan Stud
TTTTTTRATITITTT Vi $12-300 $12-300
Penulangan Angkat Penulangan Angkat
Lx = 2150 mm $12-240 $12-240
Ly = 3350 mm X
t =120 mm Panjang Penyaluran = 150 mm

Retak > S= 160 mm < 525 mm

Lendutan =

Sebelum K omposit

Sebelum K omposit

Lx =1200 mm
Ly =3350 mm
t =120 mm
Pelat Satu Arah

$¢12-240

Setelah Komposit
$12-240
Penulangan Stud
$¢12-300
Penulangan Angkat

$12-240

Setelah Komposit
$12-240
Penulangan Stud
$12-300
Penulangan Angkat

$12-240

$12-240

Panjang Penyaluran = 150 mm

Retak > S=160 mm < 525 mm

L endutan =




Tabel 5.2 Resume Perencanaan Pelat Atap
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Pelat Satu Arah

Tipe Pelat Penulangan Arah X | Penulangan ArahY
A Sebelum Komposit Sebelum Komposit
== $12-240 $12-240
A Setelah Komposit Setelah Komposit
! $12-240 $12-240
{ e Penulangan Stud Penulangan Stud
A roTonGA-A $12-300 $12-300
Penulangan Angkat Penulangan Angkat
Lx = 1700 mm 2249 2-250
Ly = 3350 mm - e
t =120 mm Panjang Penyaluran = 150 mm

Retak - S= 160 mm < 525 mm

L endutan = 4.46 mm < 8.9 mm

Sebelum Komposit
$12-240
Setelah Komposit

Lx =2150 mm
Ly =3350 mm
t =120 mm
Pelat Dua Arah

$12-240

Penulangan Stud
$12-300

Penulangan Angkat
$12-240

Sebelum Komposit
$12-240

Setelah Komposit
$12-240
Penulangan Stud
$12-300

Penulangan Angkat
$12-240

Panjang Penyaluran = 150 mm

Retak = S= 160 mm < 525 mm

Lendutan =0.32 mm < 8.9 mm

Sebelum K omposit

Lx =1200 mm
Ly =3350 mm
t =120 mm
Pelat Satu Arah

$12-240

Setelah Komposit
$12-240
Penulangan Stud
$12-300
Penulangan Angkat
$12-240

Sebelum Komposit
$12-240

Setelah Komposit
$12-240
Penulangan Stud
$12-300
Penulangan Angkat
$¢12-240

Panjang Penyaluran = 150 mm

Retak = S= 160 mm < 525 mm

Lendutan = -
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5.2 Perencanaan Tangga
Data Desain :

Tinggi antar lantai = 320 cm
Lebar injakan(i) = 28 cm
Tanjakan (t) = 16 cm

Tebal pelat tangga= 12 cm
Tebal pelat bordes =12 cm
Lebar bordes = 338 cm

L ebar tangga = 155 cm
Jumlah tanjakan dan injakan =

160
n.t = —— =10 buah

16
ni=nt—1=10—-1=9 buah
Syarat desain tangga:

60<2t+i<65-60<2X16+18 <65
60 < 60 < 65 - OK!
Sudut Kemiringan

(150 5oy
tan 280 = 29.74

Teba Pelat rata-rata

i 28
T = (E) X Sin <= (7> X sin29.74 =695cm =~ 7 cm
T=70+12=19cm

Denah desain tangga lantai dasar dapat dilihat pada gambar 5.8
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oy D
1
T
Gambar 5.7 Desain Tangga Lantal Dasar
Pembebanan Tangga
e Pembebanan Anak Tangga
1. Beban Mati (DL)
Berat Sendiri  (Q1MZAKN/MT) o g o5 N/me
C0s 29.74
Railing (diasumsikan) = 0.20 kN/m?
Tegel (1.cm) S 0.24 KN/m?
Spesi (2 cm) = 0.42 KN/m?
TOTAL DL 6.11 KN/m?

2. Beban Hidup (L)
2012 Tabel 4-1)
Jadi Beban Ultimate (qut)

e Pembebanan Bordess
1. Beban Mati (DL)

Berat Sendiri (0.12 x 24 kN/m3)

Railing (diasumsikan)
Tegel (1 cm)

= 1.92 kN/m? (SNI-1727-

=1.20pL + 1.60.L
= 1.2(6.11) + 1.6(1.92)
= 10.41 kKN/m?

2.88 KN/m?
0.20 kN/m?
0.24 KN/n?
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Spesi (2.cm) = 0.42 kN/m?
TOTAL DL 3.74 KN/m?
2. Beban Hidup ( Lo) = 1.92 kN/m? (SNI-1727-

2012 Tabdl 4-1)

Jadi Beban Ultimate (qut) = 1.2qoL + 1.6q.1
=1.2(3.74) + 1.6(1.92)
=7.56 KN/m

Analisis Struktur Tangga

Pada proses analisis struktur tanggaini, menggunakan
perhitungan statistertentu dengan perletakan berupasendi-rol,
seperti yang ditunjukan pada gambar 5.8

quit=10.41 kN/m2

quIt=7.56 kN /m?2

e <%
5 ¢

2800 1204

Gambar 5.8 Pembebanan Struktur Tangga

Analisis Gaya Dalam Tangga
e Redaks Perletakan

XM, =0
2.8 7.56 + 1.22
= —Ry x40+ [10.41 X 2.8 (7 + 1.2)] + I QAVEEL 0
_80.285

Ry=——=201kN (D)
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YV =0

=R, +201-1041%x28-756%x12=0

R, =18.12 kN (1)

Perhitungan Gaya Lintang

Potongan X1

Dys =R —qq x X, =18.12 - 7.56 x 1.2

X, =0m - D, = 18.12 kN

X, =12m - Dg =18.12 —-7.56 X 1.2 = 9.05 kN
Potongan X2

Dy, =Ry —qy X X, =201 —10.41 x 2.8

X5 =01m Py =20.1dN

X, =28m - Dy =20.1—-10.41 % 2.8 =—9.05 kN

Gambar gaya lintang pada tangga ditunjukan pada
gambar 5.9.

Gambar 5.9 Diagram Gaya Lintang Pada Tangga

Perhitungan Momen
Potongan X1

My = Rc X X1 = (q:X)/2
Xi=0m->M.=0

X, =12m - My
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7.56 x 1.22
Mp =1812x 1.2 — — = 16.3 kNm

Potongan X2

My, = Ry X X5 — (q2X3)/2
XZ - Om d MA - 0

XZ = 2.8m - MB

10.41 x 2.8?
Mg =20.1x28— R ST 15.5 kNm
Momen Maksimum Pada Tangga

Ry + (q2X3) =0
Dyp = 0 = 20.1 + (10.41 X X,) = 0

=200 103
L TN gl 4
q2X3
MMAX=RC><X2—< 5 )

10.41 x 1.932
2

Myux = 20.41 % 1.93 — < > =20 kNm

1?2
Gambar 5.10 Diagram Momen Pada Tangga



Penulangan Lentur Pada Tangga

DataDesain :

e Mutu Beton (f’c) =25 Mpa-> p1=0.85
o Tebal Pelat (1) =120 mm

e Selimut Beton =20mm

e Tulangan (¢) =12 mm

o fy =240 Mpa

e My =20KkNm

Direncanakan menggunakan tulangan ($)=12 mm

Penulangan Pelat Tangga

Mmax : 20 KNm = 20x 106 Nmm

Vu  :-20.1kN

Tulangan Lapangan

® =090 (SNI-2847-2013:9.3.2.1)

12
dxr= 120—20—7:94mm
085X fi % By 600

X
Pb fy 600 + fy
_085x25x085 600 . .
Po = 240 600 + 240

Pmax = 0.75p, = 0.75 X 0.06324 = 0.04

Pmin = 0.0014 (SNI-2847-2013 Pasal 7.12.2.1)

Mu 20 x 10°

Mn  22222222.22

Rn = =
b dZ T 1000 x 942

= 2.515




100

Sy 20 o0
M= 085xfc 085%x25

1 2m X Rn
Pperu = | 1= 1_T

__ 1 [, [, _2x11294x2515
Pperiv = 77504 240

Pmin =8 pperlu < pperlu
Maka, d| paka' pperlu: 00112
ASperyy = p-b.d = 0.0112 x 1000 X 94 = 1051.4 mm?

= 0.0112

1
AS{ eutangam = ZnDZ =0.25 X X 122 = 113.1 mm?

As
ey & o3 40

n =
Iyacdid A5‘1 tulangan

Dipakai 10612 (As = 1130.4 mm?)
As.fy — 1130.4 x 240

&= 085.fc.b 0.85x 25 x 1000
a
oMn = As. fy (d - E)

= 12.8mm

12.8
PMn = 0.9 X 226.2 X 240 (94 - T) = 21390000 Nmm
¢Mn = 21390000 Nmm > Mu = 20000000 Nmm (OK)

1000 _ 1000
S =

n_1_10_1=111.11mmz100mm

Kontrol Spasi Tulangan:
S>25mm (SNI-2847-2013 Pasal 7.6.2)



S < (3h=360 mm) (SNI-2847-2013 Pasal 7.6.5)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)
100 mm > 25 mm (OK)

100 mm < 360 mm (OK)
100 mm < 450 mm (OK)

Maka, dipakai tulangan utama ¢12 — 100 (arah-x)

Kontrol Retak

s = 380 (z;i’) AVT 300("’%

2 Q2
fs =3 fy =3 % 240 = 160 Mpa

C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C. =20mm

s = 380 (%’
s =100mm < 525 mm
Maka, digunakan s =525 mm

Sw =100 mm < 525 mm .....(OK).

)—2.5><20§300><G—§2)

Penulangan Pelat Bordes
Mg :15.5kNm=15.5x10° Nmm

Tulangan Lapangan

@ =090 (SNI-2847-2013:9.3.2.1)
12

dx = 120—20—7=94mm

_ 0.85x fi X b1 > 600

) fy 600 + fy

Pp

101
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_085x25x085 600
Pp = 240 600 + 240

= 0.054

Pmax = 0.75pp = 0.75 x 0.06324 = 0.04

Pmin = 0.0014 (SNI-2847-2013 Pasal 7.12.2.1)

Mu  15.5 X 106

Mn = — = 17222222.22Nmm

) 0.9
oo Mgl wrz2vzge a2 |
"= bdz T T1000%x 942
fy 240
= = = 11.294
M= 085%fc_ 0.85x25

1 2m X Rn
Preriu = |1~ 1—T

2x11.294 x 1.95

1
pperlu = 11—294 1-— \/1 240 =3 00085

Pmin < pperlu < pperlu
Maka, dl pakal pperlu: 00085
ASperiu = p-b.d = 0.0085 x 1000 X 94 = 802 mm?

1
Asyiongan = ZnDZ =0.25 x T X 122 = 113.1 mm?

M:710~8

n —
Vs Asl tulangan

Dipakai 812 (As = 904.3 mm?)
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| Asfy 9043 x 240
@ =085 fc.h 0.85x 25 x 1000

oMn = 9As.fy (d ~ g)

=10.2mm

10.2
@Mn = 0.9 x 904.3 X 240 (94 £ T) = 17360000 Nmm
éMn = 17360000 Nmm > Mu = 15500000 Nmm (OK)

1000 1000
5= =——=14286 mm = 100 mm
n—1 8-1

Kontrol Spasi Tulangan:

S >25 mm (SNI-2847-2013 Pasdl 7.6.2)
S < (3h=360 mm) (SNI-2847-2013 Pasal 7.6.5)
S <450 mm (SNI-2847-2013 Pasdl 7.6.5)
100 mm > 25 mm (OK)
100 mm < 360 mm (OK)
100 mm < 450 mm (OK)

Maka, dipakai tulangan utama ¢12 — 100 (arah-x)

Kontrol Retak

380 (280) 2.5C, < 300(280)
Si= = L. s

fs 9 fs

2 2

J i =§fy =§><240 = 160 Mpa
C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C. =20mm

= 380 (280> 2.5 %20 <300 x (280)
INE b/ X N 160

s =100 mm < 525 mm
Maka, digunakan s =525 mm
Su =100 mm < 525 mm .....(OK).
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Penulangan Bal ok Bordes

Data Desain :

e Mutu Beton (f'c) =25Mpa-> p:=0.85
o Teba Pelat (t) =120 mm

e Tinggi Balok (n) =300mm

e Lebar balok =200 mm

e Selimut Beton =30 mm

e Tulangan Lentur (¢p) = 16 mm

e (¢) Sengkang =10 mm

o f = 240 Mpa

e M, =15.5kNm

Pembebanan Balok Bordess
Berdasarkan analisis gaya dalam pada tangga didapat reaksi di
titik C sebesar Rc = 18.12 kN/m

Beban Mati

Berat Sendiri Balok =0.25 Xx03x24=18kN/m
Dinding =1.6x25=4.0kN/m

Total =1.8%x4.0=72kN/m

qa=120,+R, =12%72+1812 = 26.76 kN/m

Analisa Gaya Dalam Balok Bordess

Pada proses Andisis struktur balok bordes ini,
menggunakan perhitungan statis tak tentu dengan menggunakan
perletakan jepit-jepit, dimana pembebanan seperti gambar Gambar
5.11.

1
M, = koefisien x qz X |2 = 5 26.76 X 3.6%2 = 34.68 kNm

1 1
Wy =5%qax1=7x2676x36=4817 kN
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Penulangan Lentur Balok Bordess
Direncanakan menggunakan tulangan ¢16
M, = 34.68 kNm

) tul. lentur

d = h — selimut beton — tul. geser — T RS
16
d=300—30—10—7=252
0.85 X f, X By 600

Pp = X

fy 600 + fy

_085x25x085 600 . .

A 240 600 + 240

Prmax = 0.75p, = 0.75 x 0.06324 = 0.04

Domin = % = 0.0058 (SNI-2847-2013 Pasd 10.5.1)
y

Mu  34.68 x 10°

DORY rravzAidy dsrAld 33N
n=" i 38533333.33Nmm
o _ Mn 3853333333
iz 100082822\ @
fy 240
- - = 11.294
M= 085x%fc_ 0.85x%25 4

1 2m X Rn
Ppertu = —| 1 1_T
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_ [, |, _zx11294x2427)_
Preriv = 71592 240 N

Pmin = Pperiu £ Pperiu
Maka, dl paka' pperlu: 00108
ASperiu = p-b.d = 0.0108 X 250 x 252 = 678.4 mm?

1
AS1 tytangdn = ZnDZ = 0.25 X T X 162 = 200.96 mm?

As
painDETIY gl 338 ~ 4

ne =
Uroee ASq tuiangan

Dipakai 4¢16 (As = 803.8 mm?)
As. fy P 803.8 x 240

@ 085.fc.h  0.85x25x 250
a
OMn = QAs. fy (d - 5)

= 36.3mm

36.3
®Mn = 0.9 x 803.8 x 240 (252 - T) = 406000000 Nmm
¢$Mn = 40600000 Nmm > Mu = 34680000 Nmm (OK)

250 NG00 W
T — 1 ol el

Kontrol Spasi Tulangan:

S >25 mm (SNI1-2847-2013 Pasal 7.6.2)
S < (3h=360 mm) (SNI1-2847-2013 Pasal 7.6.5)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)
83.33 mm > 25 mm (OK)

83.33mm<360 mm  (OK)
83.33mm <450 mm  (OK)

Maka, dipakal tulangan utama 4D16
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Kontrol Retak
ST (20 280
s =380 : ) - 25€, < 300( )

S
2 2
=—f, ==%X240 =160 Mpa
C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C. =20mm

s = 380 (%

s =83.33mm < 525 mm
Maka, digunakan s =525 mm
Su =83.33 mm < 525 mm .....(OK).

)—2.5x20§300x(%)

Desain Tulangan Geser Balok Bordess
Direncanakan tulangan geser 2 kaki ¢10 (A,=157.08 mm?)
V, = 48.17 kN

Berdasarkan  (SNI-2847-2013: Ps 11.2.1.1) kemampuan
beton untuk menahan gaya geser ditentukan dengan perumusan
berikut:

V. =017 AJf.b,d
V. = 0.17 X 1.0 x V25 x 250 x 252 = 53550 N = 53.55 kN

Jarak Antar Tulangan Geser
_ A,®fyed  157.08 X 0.75 X 240 X 252

V, —@V.  (48.17 — 0.75 x 53.55) x 103

= 889.8 mm

Berdasarkan SNI-2847-2013 Ps 11.4.5 jarak tulangan geser
maksimum untuk struktur yang tidak direncanakan untuk menahan
beban gempa harus tidak lebih dari :

d 252 =
2 = 2 = mm

» Makadigunakan s= 125 mm
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Berdasarkan SNI-2847-2013 Ps 11.4.6 bila Vu=>0.50V ¢ maka
luas minimum sengkang harus dipenuhi. Sebagai mana ditunjukan
dengan penyelesaian dibawah ini.

0.35b,,S 0.35x 250 x 125
Av min — fyt 77 240
=>» Dipasang sengkang 2 kaki
Ay pasang = 157.08 mm? > Ay i = 45.57 mm?
(Ok, Memenuhi)

= 45.57 mm?

Gaya geser perlawanan sengkang
@A, fyed  0.75 X 45.57 X 240 X 252
Plrss R 125
= 16.54 kN
@V + V) = 16.54 + 0.75 x 53.55 = 56.7 kN
oV, +V.) =V, =48.17 kN
= (Ok, emenuhl)

= 16536.5 N

Dipasang sengkang daerah tumpuan 10—125 mm sepanjang
2h=2%300=600 mm

Dipasang sengkang daerah lapangan $10—125 mm

Desain tulangan geser bal ok bordes ditunjukan pada Gambar 5.13.

5.3 Perencanaan Balok Sekunder

Pada perencanaan balok pracetak, penulangan dikontrol
terhadap tigakondisi yaitu, penulangan sebelum komposit sebelum
overtopping, saat overtopping, dan saat sesudah komposit.

0 R | e

(a) (b) (c)
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Gambar 5.11 (a) Dimensi balok anak sebelum komposit, (b) Dimensi balok anak
saat overtopping, (c) Dimensi balok anak saat komposit.

Data desain balok sekunder B2

e Dimensi Balok = 30/50 mm
e Bentang Balok = 7200 mm
e Mutu Beton (f’¢c) = 25 Mpa
e (¢) Tulangan Utama = 19 mm
e (¢) Tulangan Geser = 10 mm
e Selimut Beton = 30 mm

5.3.1 Perhitungan Pembebanan

Pembebanan Balok Sekunder B2 As- 2°(A - B)

Denah lokas balok sekunder B2 As — 2°(A — B) ditunjukan pada
gambar 5.3

Gambar 5.12 Lokasi Peninjauan Balok Sekunder B2 As 2°-AB

Terdapat dua struktur plat lantai yang membebani bal ok
sekunder B2 seperti yang ditunjukan pada Gambar 5.3. Distribus
beban pada plat lantai bertipe tributary maka untuk mendapatkan
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beban merata digunakan perumusan q.. (1 trapesium). Beban
merataini dipakai pada saat kondisi pelat sudah komposit.

1 87
Qeky = 2 qul‘x V-~

2
3y
400 300
L, =3600— (—+—) = 3250 mm
2 2
400 300
Ly = 5400 — (T + T) = 5050 mm

Pembebanan Sebelum Komposit (Sebel um Overtopping)
Beban Mati

Berat Sendiri BIk = 0.3x0.38x24 = 2.74 kKN/m
Beban Mati Pelat = ¥2x0.07x3.35x 24 = 2.81 kN/m
QoL = 2.74+2.81 =5.55 kN/m
Beban Hidup
Qu = Beban hidup pekerja =2 kN/m

Kombinasi Pembebanan
qu = 14D, = 1.4 x555=7.77kN/m
gy = 12D, +1.6L, = 1.2 X555+ 1.6 x 2 = 9.86 kN/m

Pembebanan Sebelum Komposit (Saat Overtopping)
Pada saat pengecoran ditambahkan beban mati akibat beton
basah yang diovertopping sebesar 20 % dari beban mati balok dan

pelat.
Beban Mati
Berat Sendiri Blk = 0.3x0.38x24 =274 kN/m
Beban Mati Pelat = % x 0.12x 3.35x 24 =4.82 kN/m
QoL = 274+482 = 7.56 kN/m
20% QoL = 0.2 (7.56) =1.51 kN/m
Qbitot = 7.56 + 1.51 =9.07 KN/m
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Beban Hidup
QL = Beban hidup pekerja =2 kN/m

Kombinasi Pembebanan
g, = 1.4D; = 1.4 x (9.07) = 12.7 kN/m
gy =12D;, +1.6L, = 1.2 X (9.07) + 1.6 X 2 = 14.1 kN/m

Pembebanan Sesudah Komposit
Beban Mati
Berat Sendiri = 0.3x05x24 = 3.6 kN/m
1 3.25%2 1 _
Gekw = 2 X 3 X 4.02 X 3.25 [1 = 3><5.052] = 7.65 kN/m+
11.25 KN/m

Beban Hidup
Beban Hidup (Lo) = 1.92 kN/m? (SNI-1727-2012 Tabel 4-1)

Ku=1 (SNI-1727-2012 Tabel 4-2)

Ap = 3.25 % 5.05 = 16.41 m?

K Ar = 1% 1641 = 16.41 m?

Maka, 16.41 m? < 37.16 m? (Beban Hidup tidak boleh
direduksi)

Maka, Beban hidup lantai = 1.92 kN/m?

2
Gekw = 2X 2 X 1.92 X 3.25 [1 ) 328

3%5.052
Kombinasi Pembebanan
q, = 14D, = 1.4 x 11.25 = 15.75 kN /m
g, =12D, +1.6L, = 1.2 X 11.25 + 1.6 X 3.66
=19.36 kN/m

] = 3.66 kN/m

5.3.2 Perhitungan Momen dan Gaya Geser

Perhitungan momen dan gaya lintang sesuai balok anak
sebelum dan sesudah komposit.
Momen dan Geser sebelum komposit (Sebelum Overtopping)
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1 1
M= (gx q X LZ) = (§ X 9.86 X 5.42) = 35.94 kNm

1 1
V=§><q><L=§x9.86x5.4=26.62kN
Momen dan Geser saat overtopping
1 1
M= (§ X q X LZ) = (§ x 14.1 X 5.42) =51.39 kNm

it 1
V=§quL=§>< 14.1 X 5.4 = 38.1 kN
Momen dan Geser sesudah komposit
1 1
M= (g X q X LZ) - (g X 19.36 x 5.42) = 70.57 kNm

1 1
V=E><q><L=§19.36><5.4=52.27kN

5.3.3 Perhitungan Tulangan Lentur

Perhitungan Tulangan Sebelum Komposit (Sebelum Overtopping)
Dimensi balok anak 30/50

Tebal selimut beton = 40 mm

Diameter tulangan utama = 19 mm

Diameter tulangan sengkang = 10 mm

fo’=25Mpa

fy = 240 Mpa

Tulangan Lapangan
M, = 35.94 kNm
tul. lentur

d = h — selimut beton — tul. geser — >

19
d =380 —40— 10—7= 320.5 mm
085X f' X By y 600

Pb fy 600 + fy
_085x25x085 600 .
Po= 240 600 + 240



Pmax = 0.75p, = 0.75 X 0.06324 = 0.04

Prmin = == = 0.0058 (SNI-2847-2013 Pasal 10.5.1)

%
Mu  35.94 x 10°
IR TR IR0 o @S ds @
0) 0.9
P, Mn _ 39933333
"= pdZ T 1000x2522
fy 240
24 £ = 11.294
M= 085% f'c 0.85x% 25

1 2Zm X Rn
Ppertu = — &5 ST

2x11.294x1.4

1
pperlu = m 1-— \/1 240 = 0.0061

Pmin < pperlu < pperlu
Maka, dipakai pperiy = 0.0061
ASperiy = p-b.d = 0.0061 x 300 x 320.5 = 559.5 mm?

1
AS1 tuiangan = ZnDZ =0.25 X X 192 = 283.53 mm?

Asperlu =197 ~ 2

n S EEE—
figngog ASl tulangan

bw 1 2tselimut B 2(Z)sengkang 7 n(btul.utama

7. n—1
300 —2x 40— 2% 10 —2x 19
$= 2-1

=162 mm

113
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Dipakai 219 (As = 566.8 mm?2)

_ Asfy 5668 X 240
@ = 085.fc.b 0.85x 25 x 300

OMn = QAs. fy (d - g)

=21.3mm

21.3
@Mn = 0.9 X 566.8 X 240 (317.5 4 T) = 36390000 Nmm
¢Mn = 36390000 Nmm > Mu = 35940000 Nmm (OK)

Maka, dipakai tulangan lapangan 2¢19

Kontrol Retak

s =380 (Zfﬂ) —25C, < 300(2%

2 2
fs=§fy=§><240=160Mpa

C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C. =20mm

s=380(%

s =565mm < 525 mm
Maka, digunakan s = 525 mm
Su =41 mm < 525 mm .....(OK).

)—2.5><40S300x(%)

Karena serat atas tidak mengalami tarik, tulangan negatif
digunakan tulangan praktis minimum sehingga luasan yang

diperlukan,

As =05xAs
=0,5 x 566.8
= 283.4mm?

Digunakan 2 ¢ 19 mm = 566.8 mm?

Perhitungan Tulangan Saat Overtopping
Dimens ba ok anak 30/50
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Tebal selimut beton = 40 mm
Diameter tulangan utama =19 mm
Diameter tulangan sengkang = 10 mm

fc’ =25 Mpa
fy =240 Mpa
M, = 51.39 kNm
tul. lentur
d = h — selimut beton — tul. geser — I N
19
d =380 —40 — 10—7= 320.5 mm
0.85 X f X By 600
Pp = X
fy 600 + fy
_ 0.85x25x0.85 gl 600 3o f
A 240 600 + 240

Prmax = 0.75p, = 0.75 X 0.06324 = 0.04

Pomin = % = 0.0058 (SNI-2847-2013 Pasal 10.5.1)
y

Mu 51.39 x 10°
Mn = 7 = T = 57100000 Nmm

Mn 57100000

Rn = = =
"= 5.d% T 1000 x 320.52
fy 240
L L = 11.294
M= 085x%fc 085x%25

1 2m X Rn
Pperiu = —{ 1= I_T
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1 2x11.294 % 2
- 1————F——|=0.0081

Prertu = 77994 240

Pmin = pperlu s pperlu
Maka, d'paka' ppe(lu: 00081
ASperiy = p-b.d = 0.0081 x 300 X 320.5 = 777.9 mm?

AS1 tyiangan = =mD? = 0.25 x w x 19% = 283.53 mm?

Ntulangan = =274=3
AS1 tuiangan

bw - 2tselimut - 2Q)sengkang - nwtul.utama

n—1
300—2%x40—-2x%x10—3x 19
5= A =72mm
Dipakai 3919 (As = 850.2 mm?)

_ Asfy _ 7779x240
@085 fc.b  085x25x300

OMn = 04s. £y (d - %)

32mm

32
@Mn = 0.9 x 2883.9 x 240 (320.5 = 7) = 55920000 Nmm
éMn = 55920000 Nmm > Mu = 51390000 Nmm (OK)

Maka, dipakai tulangan lapangan 3¢19

Kontrol Retak

_ 380 (229) — 280
s = 3280 ( fSZ) 2.5C; <300(7)
fo = 51, =5 % 240 = 160 Mpa

C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C. =40 mm
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s =380 (23
160

s =565mm < 525mm

Maka, digunakan s =525 mm
Su = 72mm < 525 mm .....(OK).

)—2.5x4os300x(%)

Karena serat atas tidak mengalami tarik, tulangan negatif
digunakan tulangan praktis minimum sehingga luasan yang

diperlukan,

As =0,5xAs
=05x7779
= 388.95 mm?

Digunakan tulangan lapangan 2 ¢ 19 mm = 566.8 mm?

Perhitungan Tulangan Setelah Komposit
Dimensi balok anak 30/50

Tebal selimut beton =40 mm

Diameter tulangan utama =19 mm
Diameter tulangan sengkang = 10 mm
fc’ =25 Mpa

fy = 240 Mpa

Tulangan Lapangan
M, = 70.57 kNm
tul. lentur

d = h — selimut beton — tul. geser — >
o

d =500 — 40— 10—7= 440.5 mm

085X f X By b 600

fy 600 + fy

0.85 x 25 X 0.85 600
Pp = X
240 600 + 240

Pp

= 0.054
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Pmax = 0.75p, = 0.75 X 0.06324 = 0.04

P = ;—4 = 0.0058 (SNI-2847-2013 Pasal 10.5.1)
y

Mu 74.29 x 10°

Mn 8254444444

s> 2 L
™= }dZ T 300 x 320,52

1.35

fy 240

= = = 11.294
0.85 % f'c  0.85x 25

m

1 2m X Rn
Prern = —{ 1 1—T

1 2x11.294 x 1.35
=N 1/~ = 0.0058

Poertu 7 17,294 240
Pmin = pperlu
Maka, dipakai tulangan lapangan 2419

Kontrol Retak

s = 380 (Zfﬁ) PN 4 300(%)

S,

2 2
fs =3 fy =3 % 240 = 160 Mpa
C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C.=20mm

s =380(222) — 2.5 x 40 < 300 x (3)

s =565mm < 525mm
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Maka, digunakan s =525 mm
Su =162 mm < 525 mm .....(OK).

(a) (b) (c)

Gambar 5.13 Penulangan daerah lapangan: (a) Tulangan balok anak sebelum
komposit, (b) Tulangan balok anak saat overtopping, (c) Tulangan balok anak
saat komposit.

5.3.4 Perhitungan Tulangan Geser

Dipakai tulangan diameter 10 mm

Perhitungan Tulangan Geser Sebelum Komposit
V, = 26.62 kN

Berdasarkan (SNI-2847-2013: Ps 11.2.1.1) kemampuan beton
untuk menahan gaya geser ditentukan dengan perumusan berikut:
V. =0.17 AJ/f!b,d

V. =0.17 x 1.0 x V25 x 300 x 320.5 = 81727 N = 81.73 kN

Jarak Antar Tulangan Geser
Ap@fyd  157.08 X 0.75 x 240 x 320.5
= = =—261.32mm

V,— 0V,  (26.62—0.75 x 81.73) x 103
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Berdasarkan SNI-2847-2013 Ps 11.4.5 jarak tulangan geser
maksimum untuk struktur yang tidak direncanakan untuk menahan
beban gempa harus tidak lebih dari :

d 320.5
— = JIr = 160.25mm

2
» Makadigunakan s =150 mm
V, = 65.95 < 0.5V, = 30.65

Maka, dipasang sengkang daerah tumpuan @10—150 mm
sepanjang 2h=2x500=1000 mm
Dipasang sengkang daerah lapangan $10—150 mm

Perhitungan Tulangan Geser Saat Overtopping

V, = 38.1kN

Berdasarkan (SNI-2847-2013: Ps 11.2.1.1) kemampuan beton
untuk menahan gaya geser ditentukan dengan perumusan berikut:
V. = 0.17 A\/f!b,,d

V, =0.17 x 1.0 x V25 x 300 x 320.5 = 81727 N = 81.73 kN

Jarak Antar Tulangan Geser
d AyDfyd g 157.08 x 0.75 x 240 x 320.5

V,—®V.  (38.1—0.75x 81.73) x 103

= —390.1 mm

Berdasarkan SNI-2847-2013 Ps 11.4.5 jarak tulangan geser
maksimum untuk struktur yang tidak direncanakan untuk menahan
beban gempa harus tidak lebih dari :

d_3205_. .
) = ) = . mm

» Makadigunakan s =150 mm
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Berdasarkan SNI-2847-2013 Ps 11.4.6 bila Vu=0.50V ¢ maka
luas minimum sengkang harus dipenuhi. Sebagai mana ditunjukan
dengan penyelesaian dibawah ini.

V, = 38.1 > 0.5V, = 30.65
0.35b,,S 0.35x 300 x 150
Av min — fyt - 240
=>» Dipasang sengkang 2 kaki
Ay pasang = 157.08 mm? = A, i, = 65.625 mm?
(Ok, Memenuhi)

= 65.625 mm?

Gaya geser perlawanan sengkang
oV = DA, fyed ) 0.75 x 157.08 x 240 x 320.5
) = 2

150

= 6041297 N

= 60.41 kN
OV, +V.) =60.41+0.75 x 81.73 = 121.71 kN
oWV; +V,) =V, =38.1kN
= (Ok, Memenuhi)

Dipasang sengkang daerah tumpuan @10—150 mm sepanjang
2h=2%500=1000 mm
Dipasang sengkang daerah lapangan $10—150 mm

Perhitungan Tulangan Geser Setelah Komposit

V, =52.27 kN

Berdasarkan (SNI-2847-2013: Ps 11.2.1.1) kemampuan beton
untuk menahan gaya geser ditentukan dengan perumusan berikut:
V. =0.17 A{/f/b,,d

V. = 0.17 X 1.0 x V25 x 300 x 440.5 = 495562.5 N
= 495.563 kN

Jarak Antar Tulangan Geser
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Ay@f,ed  157.08 x 0.75 X 240 x 440.5
= = = —-1379 mm
V,— 0V, (52.27 — 0.75 x 495.56) x 103

Berdasarkan SNI-2847-2013 Ps 11.4.5 jarak tulangan geser
maksimum untuk struktur yang tidak direncanakan untuk menahan
beban gempa harus tidak |ebih dari :

PP 920
awavzl havenl &

Maka digunakan s = 200 mm

V, =52.27 < 0.50V. = 185.84
Maka digunakan s = 200 mm

Gaya geser perlawanan sengkang
7 @A, fyed  0.75 X 157.08 X 240 X 440.5
Yo A 150
= 62.274 kN
OV +V,) =62.274+ 0.75 X 495.56 = 433.94
OV, +V,) =V, =52.27 kN
= (Ok, Memenuhi)

= 622744 N

Dipasang sengkang daerah tumpuan @10—200 mm sepanjang
2h=2%x500=1000 mm
Dipasang sengkang daerah lapangan $10—200 mm

5.3.5 Pengangkatan Elemen Balok Anak

Balok anak dibuat secara pracetak dipabrik. Elemen balok
harus dirancang untuk menghindari kerusakan pada waktu proses
pengangkatan. Titik pengangkatan dan kekuatan tulangan angkat
harus menjamin keamanan elemen balok tersebut dari kerusakan.
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-M

Gambar 5.14 Momen Saat Pengangkatan Bal ok

=

Y 4Y
2<1+ﬁ+y—b<1+m>>

Maka,
W =0.38x0.3x%x24=274kN
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(50 — 12)
Yo=Y, =————=19cm
Y=Y, +5=24cm
4% 24
1+ 520%xtg45

19 4 x 24
2<1+\/1+ (1+—540th45)>

XXL=023x%x540=1242cm

M—2'74X5'42(1 4x023+ 4><0'24)—2574k1\/

-8 TS axtgas) T ° g
2.74 x 0. 232 X 5.42

—M = = 2.113 kNm

—062/1\/E 062><1><\/_5—31Mpa

= —bh2 = E % 300 X 380% = 7220000 mm?3
Momen Lapangan
_+M 2574 x10°

— 036 M
=W, = 7220000 _ 036 Mpa
f =036Mpa < f, = 3.1 Mpa (OK)

Momen Tumpuan
A -M 2113 x10°

W, 7220000
f =029 Mpa < f, = 3.1 Mpa (0OK)

= 0.29 Mpa

5.4 Perencanaan Balok Lift

Pada perancangan lift ini meliputi balok — balok yang
berkaitan dengan ruang mesin lift. Untuk lift pada bangunan ini
menggunakan lift penumpang yang diproduksi oleh Hyundai
dengan data— data pada Tabel 5.14.
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Tabel 5.3 Data Lift

Tipe Lift Passenger
Merk SIGMA
Jenis Lift Duplex
Kapasitas Orang 8
Beban 10
(kN)
Lebar Pintu (mm) 900
Hoistway (mm) 4150 x 2150
Car Size (mm) 2000 x 2150
Dimensi Ruang Mesin (mm) 4800 x 2400
Beban Reaks Ruang | Ri (kN) 61.5
Mesin R2 (kN) 43
Data Desain
Mutu beton (fc’) =25 Mpa—[1=0.85
Tinggi balok (h) = 500 mm
Lebar Balok (b) =300 mm
Selimut Beton =40 mm
Diameter Tul. Lentur (@) =19 mm

Diameter Tul. Sengkang () =10mm

Pembebanan Balok L ift
Beban Kejut

Berdasarkan RSNI-1727-2012 Ps 4.10.2 koefisien untuk
memperhitungkan besarnya beban kejut boleh diambil sebesar 25
persen.
P =(1+0.25) X 43 =53.75kN
gq = 0.3x0.5x% 24 =3.6kN/m

Analisis Gaya Dalam Balok L ift

Balok lift yang tertumpu jepit pada kedua tumpuannya
menjadikan balok tersebut tergolong mekanika statis tak tentu,
sehingga penyelesaian analisis gaya dalamnya tidak dapat
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diselesaikan secara sederahana. Oleh karena itu, dalam mencari
gaya dalam balok lift digunakan program bantu analisis sehingga
didapatkan gaya dalam seperti pada Gambar 5.16 untuk momen
dan Gambar 5.17 untuk gaya geser.

\
N\
A /

/ o
\ T T
N 7 r
3, / -

\ /

N
N

{
i N & N 4 7
i N ¥ |

Gambar 5.15 Momen Balok Lift Kombinasi 1.4D

B7.35

T;L_ W

Gambar 5.16 Gaya Geser Balok Lift Kombinasi 1.4D

5.4.1 Desain Tulangan Lentur Balok Lift
Perhitungan Tulangan Setelah Komposit

Dimensi balok Lift 30/50

Tebal selimut beton = 40 mm

Diameter tulangan utama =19 mm

Diameter tulangan sengkang = 10 mm

fc’ =25 Mpa

fy = 240 Mpa

Tulangan Lapangan
M, = 27.27 kNm
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) tul. lentur
d = h — selimut beton — tul. geser — —
i
d =500 — 40 — 10—7= 440.5 mm
0.85 % f X B, 600
Pp = X
fy 600 + fy
0.85 x 25 x 0.85 600 A
= X = u.
02 240 600 + 240

Prax = 0.75p, = 0.75 X 0.06324 = 0.04

Pomin = % = 0.0058 (SNI-2847-2013 Pasal 10.5.1)
y

Mu 27.27 x 10°
Mn = 7 = T = 86000000Nmm

Mn 86000000

"= b.d? T 300 x 440.52
fy 240
- - — 11.294
M= 085% f'c_ 0.85x% 25 4
1 2Zm X Rn
Ppertu = | 1= [1— .

= 0.0022

2x11.294 x 0.521
1- (1-

Preriv = 71504 240

Pmin = pperlu
Maka, dipakai pmin= 0.0058
ASperiy = p-b.d = 0.0120 x 250 X 440.5 = 770.9 mm?
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1
AS1 tylangan = ZnDZ = 0.25 Xt X 19%2 = 283.53 mm?

As

perlu

n =—=272=3
PO A51 tulangan

bw - 2tselimut - 2Q)sengkang - nwtul.utama

n—1
300—m2%x40—-—2x%x10—-—3x%x 19
= =72mm

3-1
Dipakai 3919 (As = 850.2 mm?)

TANLLY ek Slavasl @Al
4= 085.fc.hb 085x25x300 ~-MM

OMn = QAs. fy (d - %)

32
PMn = 0.9 x 850.2 x 240 (440.5 =N T) = 77950000 Nmm
$Mn = 77950000 Nmm > Mu = 27270000 Nmm (OK)

Maka, dipakai tulangan utama 3¢19

Kontrol Retak

s =380 (Zfﬂ) —25C, < 300(@)

S

2 2
fs=§fy=§x240=16OMpa

C. = Jarak terkecil dari permukaan tulangan ke muka tarik

C.=20mm

s =380 (22
160

s=72mm < 525 mm

Maka, digunakan s =525 mm

Su = 72mm <525 mm .....(OK).

)—2.5x20£300x(%)

Tulangan Tumpuan
M, =774 kNm



) tul. lentur
d = h — selimut beton — tul. geser — —
i
d =380 — 40— 10—7= 320.5 mm
0.85 % f X B, 600
Pp = X
fy 600 + fy
0.85 x 25 x 0.85 600 A
= X = u.
02 240 600 + 240

Prax = 0.75p, = 0.75 X 0.06324 = 0.04

Pomin = % = 0.0058 (SNI-2847-2013 Pasal 10.5.1)
y

Mu  77.4 X 10°

M === s N
n 2 09 86000000 Nmm

Mn 86000000

R — P
"= p.d% T 300 x 44052

=1.477

fy 240

- - — 11.294
M= 085% f'c_ 0.85x% 25 2

1 2m X Rn
Ppertu = | 1 1_T

2Xx11.294 x 1.477

-—— |(1- |1 = 0.064
Preriv = 71504 j 240

Pmin < pperlu < pperlu
Maka, dipakai pperu= 0.0064
ASperny = p-b.d = 0.064 X 250 x 440.5 = 843.9 mm?

129
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1
AS1 tylangan = ZnDZ = 0.25 Xt X 19%2 = 283.53 mm?

As

perlu

n =—=298%=3
PO A51 tulangan

Dipakai 3p19 (As = 850.2 mm?)

bw " 2tselimut I 2Q)sengkang | n(btul.utama

> n—1
S_300—2><40—2><10—3><19
g 3—1

=72mm

_ Asfy  8502x240
=085 fc.h 0.85x25x300

@Mn = QAs. fy (d - %)

32mm

32
PMn = 0.9 x 850.2 x 240 (440.5 = 7) = 77950000 Nmm
¢$Mn = 77950000 Nmm > Mu = 77400000 Nmm (OK)

Kontrol Spasi Tulangan:

S >25mm (SNI-2847-2013 Pasdl 7.6.2)
S < (3h=360 mm) (SNI-2847-2013 Pasal 7.6.5)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)

72 mm>25 mm (OK)
72 mm <360 mm (OK)
72 mm <450 mm (OK)

Maka, dipakai tulangan utama 3¢19
Kontrol Retak
280

s =380 (Zfﬂ) ~2.5C; < 300()

S
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2 2
fs=§fy=§x240=16OMpa

C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C. =20mm

s = 380 (%) —2.5% 20 < 300 x (%)

s=72mm < 525 mm
Maka, digunakan s =525 mm
Su =72 mm < 525 mm .....(OK).

5.4.2 Perhitungan Tulangan Geser Balok Lift
Dipakai tulangan diameter 10 mm
Perhitungan Tulangan Geser Setelah Komposit

V, = 87.75 kN

Berdasarkan (SNI-2847-2013: Ps 11.2.1.1) kemampuan beton
untuk menahan gaya geser ditentukan dengan perumusan berikut:

V. =0.17 /! b,d
V. = 0.17 X 1.0 X V25 x 300 x 440.5 = 495562.5 N
= 495.563 kN

Jarak Antar Tulangan Geser
_ Ay@fyd  157.08 x 0.75 X 240 x 440.5

V,— @V, (82.5—0.75 x 495.56) x 103 _

0mm

Berdasarkan SNI-2847-2013 Ps 11.4.5 jarak tulangan geser
maksimum untuk struktur yang tidak direncanakan untuk menahan
beban gempa harustidak Iebih dari :

d 4405 550,24
S AR .25mm

Maka digunakan s = 200 mm

V, = 87.75 < 0.50V, = 185.84
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Maka digunakan s = 200 mm

Gaya geser perlawanan sengkang
V @A, fyed  0.75 X 157.08 X 240 X 440.5
W’ P QW 150
=62.274 kN
OV, +V,) = 62274+ 0.75 x 495.56 = 433.94
oV, +V.) =V, =87.75kN
= (Ok, Memenuhi)

= 622744 N

Dipasang sengkang daerah tumpuan $10—200 mm sepanjang
2h=2%x500=1000 mm
Dipasang sengkang daerah lapangan $10—200 mm



BAB VI
PEMBEBANAN DAN ANALISISBEBAN GEMPA

6.1 Perhitungan Berat Total Bangunan
Perhitungan beban-beban yang bekerja pada struktur
Gedung Hotel Fave Ketintang Surabaya mengacu pada SNI-1727-
2013 (Beban Minimum untuk Struktur Gedung dan Bangunan
Lain).

pada Tabel 6.1 9d 6.6.
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K eseluruhan beban akibat masing-masing komponen yang
membebani struktur Gedung Hotel Fave Surabaya dapat dilihat

Tabel 6.1 Beban Pada Lantai 1

No Jenis Beban L B H n Beban Mati | Beban
(m) (m) (m) (kN/m?) (kN)
1 Pelat Lantai 3.6 1.8 0.12 43 24 802.48
3.6 2.4 0.12 8 24 199.07
2 |Opening
3 |Penggantung 311.7225 0.07 21.82
4 |Plafon 311.7225 0.11 34.29
5 |Keramik (2 cm) 311.7225 0.02 0.24 1.50
6 |KOLOM
K1 60/60 4.6 0.6 0.6 | 9 24 357.70
7 |BALOK
— | 1 7.8 0.4 0.6 3 24 134.78
L | Biag/e0 2 7.2 0.4 0.6 9 24 373.25
AL, | 3 5.4 0.4 0.6 3 24 93.31
4 0.00
IS 1 7.8 0.3 0.5 4 24 112.32
L | BA30/50 2 7.2 0.3 0.5 4 24 103.68
m<3| 3 5.4 0.3 0.5 4 24 77.76
4 3.6 0.3 0.5 3 24 38.88
8 |SHEARWALL 28.2 0.4 3.2 24 866.30
9 [Dinding 48 3.2 2.5 384.00
10 |Dinding Lift & Tangga 14.4 3.2 2.5 115.20
11 |Spesi (1cm) 311.7225 0.01 0.21 0.65
12 [Ducting AC 311.7225 0.15 46.76
13 [Plumbing 311.7225 0.1 31.17,
Total 3794.92
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Tabel 6.2 Beban Pada Lantai 2-12

. L B H n Beban Mati | Beban
No Jenis Beban 3
(m) (m) (m) (kN/m°) (kN)
1 pelat Lantai 3.6 1.8 0.12 44 24 821.15
3.6 2.4 0.12 8 24 199.07
2 |Opening
3 |Penggantung 357.66 0.07 25.04
4 |Plafon 357.66 0.11 39.34]
5 |Keramik ( 2 cm) 357.66 0.02 0.24 1.72
6 |KOLOM
K1 60/60 3.2 06 06 | 9 | 24 248.83
7 |BALOK
L 1 7.8 0.4 0.6 3 24 134.78
L1 Bi4a0/60 2 7.2 0.4 0.6 9 24 373.25
I <o 3 5.4 0.4 0.6 3 24 93.31
4 0.00
L 1 7.8 0.3 0.5 4 24 q612532-
L1 BA30/50 2 7.2 0.3 0.5 4 24 103.68
[ - 3 5.4 0.3 0.5 4 24 77.76
4 3.6 0.3 0.5 3 24 38.88
8 |SHEARWALL 28.2 0.4 3.2 24 866.30
9 [Dinding 48 3.2 2.5 384.00
10 |Dinding Lift & Tangga 14.4 3.2 2.5 115.20
11 [Spesi (1cm) 357.66 0.01 0.21 0.75
12 |Ducting AC 357.66 0.15 53.65
13 |Plumbing 357.66 0.1 35.77
Total 3724.79




Tabel 6.3 Beban Pada Lantai Atap
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. L B H n Beban Mati | Beban
No Jenis Beban 3
(m) (m) (m) (kN/m”) (kN)
1 Pelat Lantai 3.6 1.8 0.12 43 24 802.48
3.6 2.4 0.12 8 24 199.07
2 |Opening - 24 0.00
3 |Penggantung 372.06 0.07 26.04
4 |Plafon 372.06 0.11 40.93
5 [Keramik (2 cm) 0.02 0.24 0.00
6 [KOLOM
K1 60/60 32 0.6 06 | 9 | 24 248.83
7 [BALOK
e | 1 7.8 0.4 0.6 3 24 134.78
L1 Biao/e0 2 7.2 0.4 0.6 9 24 373.25
P 3 5.4 0.4 0.6 3 24 93.31
4 0.00
2] 1 7.8 0.3 0.5 4 24 112.32
L | BA30/50 2 7.2 0.3 0.5 4 24 103.68|
] 3 5.4 0.3 0.5 4 24 77.76
4 3.6 0.3 0.5 3 24 38.88
8 [SHEARWALL 28.2 0.4 3.2 24 866.30
9 |Dinding 14.2 3.2 2.5 113.60
10 [Dinding Lift & Tangga - -
11 |Spesi (1cm) 372.06 0.01 0.21 0.78
12 [Ducting AC 372.06 0.15 55.81
13 [Plumbing 372.06 0.1 37.21
Total 3325.04
Tabel 6.4 Beban Pada Ruang Mesin Lift
) L B H n Beban Mati | Beban
No Jenis Beban 3
(m) (m) (m) (kN/m”) (kN)
1 |Pelat Lantai 12.6 0.1 24 30.24
2 [Penggantung 12.6 0.07 0.88
3 [KOLOM
K 30/30 3.2 03 03 | 6 | 24 41.47
4 |BALOK
Balok Melintang
B 20/30 17.7 0.2 0.3 24 25.49
Balok Memanjang
B 20/30 14.8 0.2 0.3 24 21.31
5 |Dinding - 3.2 2.5
6 [Spesi (1cm) 12.6 0.01 0.21 0.03
Total 119.42
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Berdasarkan SNI-1727-2013 Tabel 4-1 beban hidup hotel
pada plat lantai digunakan sebesar 1.92 kN/m2. Sedangkan untuk
lantai atap digunakan sebesar 0.96 KN/m2.

Berdasarkan SNI-1727-2013 Ps C.4.1 reduksi beban hidup
dalam peninjauan gempa diperbolehkan untuk direduksi sebesar
0.7 sehingga total beban hidup untuk masing-masing lantai
diperlihatkan pada Tabel 6.5.

Tabel 6.5 Beban Hidup Pada Setiap Lantai

Elevasi Lantai Luasan | Beban Hidup | Beban Hidup 70%

(m’) (kN/m?) (kN)

44.6|R.Mesin 12.60 0.96 8
41.6|Atap 372.06 0.96 250
38.4|Lantai 12 357.66 1.92 481
35.2|Lantai 11 357.66 1.92 481
32|Lantai 10 357.66 %92 481
28.8|Lantai 9 357.66 1.92 481
25.6(Lantai 8 357.66 1.92 481
22.4|lantai 7 357.66 1.92 481
19.2|Lantai 6 357.66 1.92 481
16(Lantai 5 357.66 1.92 481
12.8|Lantai 4 357.66 1.92 481
9.6|Lantai 3 357.66 1.92 481
6.4|Lantai 2 357.66 1.92 481
3.2|Mezzanin 311.72 1.92 419
TOTAL 5965

Sehingga didapatkan total beban yang bekerja pada setiap

lantainya, seperti diperlihatkan pada Tabel 6.6.




Tabel 6.6 Beban yang Bekerja pada Tiap Lantai
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. | Beban Hidup
) ) Beban Mati Total
Elevasi Lantai 70%

(kN) (kN) (kN)

44.6|R.Mesin 119 8 128
41.6(Atap 3325 250 3575
38.4{Lantai 12 3725 481 4205
35.2|Lantai 11 3725 481 4205
32|Lantai 10 3725 481 4205
28.8|Lantai 9 3725 481 4205
25.6(Lantai 8 3725 481 4205
22.4|Lantai 7 3725 481 4205
19.2|Lantai 6 3725 481 4205
16|Lantai 5 3725 481 4205
12.8|Lantai 4 3725 481 4205
9.6[Lantai 3 3725 481 4205
6.4[Lantai 2 3725 481 4205
3.2|Mezzanin 3795 419 4214
TOTAL 54177

Berdasarkan Tabel 6.6 didapatkan berat total bangunan

sebesar W= 54117 kN

6.2 Analisis Beban Gempa
Desain beban gempa mengacu peraturan gempa terbaru
yaitu SNI-1726-2012. Berdasarkan konfiguras struktur Gedung
Hotel Fave Surabaya, anadisis gempa akan menggunakan gempa
dinamik. Oleh karena itu diperlukan tahapan awa dalam
menentukan beban gempa dinamik diantaranya sebagai berikut :
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1. Menentukan Kategori Resiko Bangunan

Tabel 6.7 Menentukan Kategori Resiko Bangunan

Kategori

Jenis pemanfaatan WA
risiko

Gedung dan non gedung yang memiliki risiko rendah terhadap jiwa manusia pada saat
terjadl kegagalan, termasuk, tapi tidak dibatasi untuk, antara lain:

Fasilitas pertanian, perkebunan, perternakan, dan perikanan

Fasilitas sementara

Gudang penyimpanan

Rumah jaga dan struktur kecil lainnya

Semua gedung dan struktur lain, kecuali yang termasuk dalam kategori risiko LIII,IV,
termasuk, tapi tidak dibatasi untuk:
Perumahan
Rumah toko dan rumah kantor
- Pasar

o ran 1l
l - Gedung apartemen/ rumah susun l

Bangunan industri
Fasilitas manufaktur
Pabrik

2. Menentukan Faktor Keutamaan Gempa (l¢)

Tabel 6.8 Menentukan Faktor Keutamaan Gempa (le)

Kategori risiko Faktor keutamaan gempa, /,

| | atau Il 1.0 ]

1l 1,25

[\ 1,50

3. Menentukan Parameter Percepatan Tanah (Ss, $1)
Menentukan parameter percepatan respons spectral
MCE pada perioda pendek, redaman 5 persen (Ss) dan
parameter percepatan respons spectral MCE pada perioda
1 detik, redaman 5 persen (S1) Berdasarkan peta gempa
pada SNI 1726-2012 dengan lokasi gedung yang terdapat
padawilayah Balikpapan serta mel akukan interpolasi pada
datatersebut, didapatkan data seperti pada Tabel 6.10.
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Tabel 6.9 Menentuka Parameter Percepatan Tanah (S, S1)

Parameter Percepatan | Peta Gempa SNI | Digunakan
Respon Spektral 1726-2012
Ss (06-0.7 ) g 069
S (0.2-0254¢ 0.2¢g

4. Menentukan Klasifikasi Situs
Berdasakan SNI 1726-2012 Pasa 5.1 penentuan klasifikasi
situs dilakukan dengan menentukan tahanan penetrasi rata-rata(N)
dengan menggunakan perhitungan seperti yang ditunjukan sebagai
berikut.
Tabel 6.10 Data N-SPT

n
N = KED/?TL:)MAN N-SPT di/Ni Zi=1 i gl
RILY
0 0 i=1 N;
25 4 0.625
4.5 17 0.265 Zcill =612
65 1 6.500 i
85 1 8.500 ) T 94.785
i
10.5 1 10.500
125 1 12.500
14.5 2 7.250 . 612
165 2 8.250 N = =6.47
185 3 6.167 94.785
20.5 4 5.125
25 7 3.214
2.5 14 1.750
26.5 17 1.559
285 15 1.900
305 17 1.794
325 14 2.321
34.5 18 1.917
36.5 17 2.147
38.5 18 2.139
405 14 2.893
425 15 2.833
445 16 2.781
46.5 40 1163
485 70 0.693

5. Menentukan Koefisien Lokasi F,dan F,
Berdasarkan SNI 1726-2012 Pasal 6.2 koefisien situs Fa dan Fv
ditentukan berdasarkan Tabel 4 dan 5 pada SNI 1726-2012.
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« Menentukan Fa

Berdasarkan Tabel 4 pada SNI 1726-2012 serta
dengan menggunakan parameter Ssyang terdapat pada Tabel
6kl
dengan klasifikas situstanah lunak (SE) didapatkan Fa
sebesar 1.5 (interpolasi linier).
« Menentukan Fv

Berdasarkan Tabel 5 pada SNI 1726-2012 serta
dengan menggunakan parameter S yang terdapat pada
Tabel 6.11 dengan klasifikasi situs tanah lunak (SE)
didapatkan Fvsebesar 3.2
Menentukan nilai Susdan Su:

Berdasarkan SNI 1726-2012 Pasa 6.2 untuk
menentukan parameter spektrum respons percepatan pada
perioda pendek (Sus) dan perioda 1 detik (Swi) yang
disesuaikan dengan pengaruh klasifikas situs, harus
ditentukan dengan Rumus 3.2
Sus =F,.S=15%x0.6=0.9
Sy1=F,.8; =32x0.2 = 0.64
Menentukan Parameter Percepatan Spektrum Desain (Sps

dan Sp1)
2 2
SDS = gSMS = g X 09 =0.6

Menentukan Kategori Desain Seismik

Berdasarkan Tabel 6 dan Tabel 7 pada SNI 1726-2012
serta menggunakan parameter yang telah ditentukan pada
langkah sebelumnya maka, Gedung Hotel Fave Surabaya
termasuk pada kategori desain seismik D. Pemilihan
kategori desin tersebut diperlihatkan pada Tabel 6.11



Tabel 6.11 Penentuan Kategori Desain
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| ) Kategori risiko
- Iatau Il atau ||? v
l_" O 4T ST AN N AN BT AN
l 0,167<8§,,<0,33 B c
©0,33<5, <050 ) ¢ Oy DOy
| o050<s, D | D
my | Kategori risiko |
‘ - | latau ilaitﬁlﬁ" V/rCwm Y
OG5, < 2 g A g’ A%y
0,067 <5,,<0,133 ' B C ﬁ
Y otz <ti20n W Il Ne W [l N\ & ]
[ o20<s, bW 1/ 1 |/

Menmtukan Sistem Penahan Gempa

Berdasarkan Tabel 9 pada SNI 1726-2012 sistem
struktur Gedung Hotel Fave Ketintang Surabaya akan
menggunakan tipe B.5 yaitu Sistem rangka gedung dimana

dinding geser akan memikul

seluruh gaya latera

sedangkan rangka bangunan memikul beban gravitasi

ditambah momen akibat perpindahan
Pemilihan sistem  penahan
diperlihatkan pula pada Tabel 6.12.
Tabel 6.12 Penentuan Sstem Penahan Gaya Seismik

lateral dinding geser.
gempa tersebut

Reativicn r:.::?r an;or Batasan sistem struktur dan batasan
modifikasi| et P.Tsn.“ tinggl struktur, i (m)°
Sistem penanan-gaya selsmik respons, | aistem, | deflekal, Kategorig saismik
5 Q| af B | cfof e’ | F-
B.Sistem rangka bangunan
1. Rengka baja dengan bresing eksentris 8 2 4 TB TB 48 48 el
2. Rangka baja dengan bresing konsentris khusus & 2 5 T8 TB 48 48 30
it b ekassak e b i =2 . BT T ETad 10 T
4. Dinding gesar beton bertulang khusus 6 2% 8 T8 TB 48 48 30
BT i — Tl TI
6. Dinding geser beton polos detall 2 s 2 T8 Tl m T TI
7. Dinding geser beton polos biasa 14 2% 1% T8 Ti Tl *Fl TI
8. Dinding gessr pracetak menangah 5 2% 44 TE TB 125 | 2% 12F
4. Dinding geser pracstak biasa 4 2% 4 T8 Tl Tl Tl Tl
10.Rangka baja dan belon komposk dengan 8 2 4 TE TE8 | 48 | 48 3
bresing eksentris
11.Rangka baja dan beton komposit dengan 5 2 4% - TB 48 48 30
bresing konseniris khusus
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Berdasarkan Tabel 6.12 diapatkan puladatatambahan
untuk desain struktur yaitu :
R =6 (Koefisien Modifikasi Respon)
Qy = 2.5 (Faktor Kuat Lebih Sistem)
C4 =5 (Faktor Rembesan Defleksi)

10. Merencanakan Respon Spektrum
Kurva Respon Spektrum harus mengikuti ketentuan
SNI 1726-2011 Pasal 6.4 dibawah ini :

__0.2Sp; __ 0.2X0.427

T, - = 0.142 dt
Sps 0.6
Te =221 = 2227 _ 0712 d¢
Sps 0.6

Untuk perioda yang lebih kecil To, spektrum respon

percepatan desain (Sa), harus didesain dengan persamaan:
Untuk, T=0—-T<To, maka:

Sa = Sps (0.4 + 0.6T10> = 0.6 (0.4 + 0.6 —0.1042) = 0.24

Untuk periode |ebih besar atau sama dengan T'o dan
lebih kecil dari atau sama dengan T's, spectrum respon
percepatan desain (S«) sama dengan Sps.
Untuk, T=0.712-To<T<Ts, maka:

Sa=Sps =0.6
Untuk periode lebih besar dari Ts, spectrum respon

percepatan desain (Sa) diambil berdasarkan persamaan :
Untuk, T=0.812-T>T's, maka:

5:@:%:0526
A Cassiiijh. Tas

Perhitungan tersebut juga diperlihatkan pada Tabel
6.13 dengan interval data sebesar 1 detik.
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Tabel 6.13 Tabel Perhitungan Spektrum Desain

T Sa

To 0.1423 0.6
Ts 0.7117 0.6
Ts+0.3 | 1.0117 | 0.422076
Ts+1.3 | 2.0117 | 0.212262
Ts+2.3 | 3.0117 | 0.141782
Ts+3 | 3.7117 | 0.115043
Ts+4 | 4.7117 | 0.090626

Dengan menggunakan interval perioda sebesar 0.1
detik didapatkan grafik respon spektrum desain seperti pada
Gambar 6.1

Kurva Respon Spektrum

© o 0o o o o o
N SR A SR
=

-
|
4
y
I 5
J
|

o

Percepatan Respon Spektra (Sa)

o
=

2 3 4
Periode, T (detik)

Gambar 6.1 Grafik Respon Spektrrum Desain

11. Merencanakan Perkiraan Periode Alami Fundamental
Berdasarkan SNI-1726-2012 Ps. 7.8.2 penentuan
perioda aami fundamental (T«) harus ditentukan dari
persamaan 26 pada SNI-1726-2012. Dengan parameter Ct
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dan x diambil dari Tabel 15 SNI-1726-2012, serta hn
merupakan total tinggi bangunan.
T, = C,h* = 0.0488 x 47.6%7> = 0.884 detik
Perioda struktur yang didapatkan dari hasil analisis
gempa tidak boleh melebihi batasan atas dari perode
fundamental yang ditentukan dengan perumusan berikut.
T = C,T, - C, (Tabel 14 SNI — 1726 — 2012)
Spi 2 04 C, =14
T =1.4x0.884 = 1.237 detik
12. Perhitungan Gaya Dasar Seismik (V)

Data desain:
SDS = 0.6
SDl = 0427

Faktor reduksi gempa, R=6

Faktor keutamaan gempa, l.=1

Menentukan koefisien Respon Seismik (Cg) ditentukan
dengan perumusan berikut:

Sps _ 0.6
=2 =——=01

B

Dan Cs tidak |ebih dari:

e 0.6
== == 0083
T (E) 1.210 (T)
Dan Cstidak kurang dari:

Cs = 0.044Spsl, = 0.001
C,=0.044 x 0.6 x 1> 0.001
C;, = 0.0264 > 0.001
Maka, nilai Csdiambil 0.1

Berdasarkan SNI 03-1726-2012 Ps. 7.8.1 penentuan
gayadasar seismik (V) dihitung berdasarkan persamaan 21
pada SNI-1726-2012. Sebagaimana ditunjukan pula pada
rumus dibawah ini :
V=CsW=0.1x61737=6843.2 kN
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13. Distribusi Vertikal Gaya Gempa
Gayagempalateral yang timbul pada semuatingkat harus
ditentukan berdasarkan persamaan 30 pada SNI-1726-2012.
Sebagai mana ditunjukan pula pada rumus dibawah ini :
Fi= B
Dimana
Wh

Cvx > ?=1Wihlk
Untuk T<0.5s; makanilai k=1
T>25s; makanilai k=2
05s<T<25s; maka nilai k diperoleh dengan cara
interpolasi linier dari keduanilai k di atas.
Dari hasil analisis struktur didapatkan,
T=1.192 detik, makanilai k adalah sebagai berikut :
0 1.192 — 0.5
=1+ (—2.5 05 (2- 1)) = 1.35
Maka, besarnya distribusi beban geser akibat gempa dapat
dilihat pada Tabel 6.14
Tabel 6.14 Gaya gempa (Fx) padatiap lantai

Lantai ke h [ W (kN)| W,.hi Cyy F, (kN)
R.Mesin Lift 46.2 128 7295.01| 0.0048 25.74
Atap 43|  3575|  189056.92| 0.1231 667.10
Lantai 12 39.8| 4205  204971.29 0.1335 723.25
Lantai 11 36.6| 4205 187624.23| 0.1222 662.04
Lantai 10 33.4| 4205 170360.50| 0.1110 601.13
Lantai 9 30.2| 4205 153187.64| 0.0998 540.53
Lantai 8 27| 4205  136114.74] 0.0887 480.29
Lantai 7 23.8|  4205| 119153.03| 0.0776 420.44
Lantai 6 20.6| 4205 102316.65| 0.0666 361.03
Lantai 5 17.4| 4205 85624.07| 0.0558 302.13
Lantai 4 14.2| 4205 69100.40| 0.0450 243.82
Lantai 3 11| 4205 52781.98| 0.0344 186.24
Lantai 2 7.8| 4205 36726.22| 0.0239 129.59
Lantai 1 46 4214 21081.02| 0.0137 74.39

TOTAL 54177.2| 1535393.69| 1.000 5417.72
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Te=1.153
1.253 - 0.5
i (@it

2505 47 1)) 1 G

Tabel 6.15 Gaya gempa (Fy) padatiap lantai

Lantai ke hy [ W, (kN) [ W,.hi Coy F, (kN)
R.Mesin Lift 46.2 128 15792.51] 0.0053 28.47
Atap 43| 3575|  403400.54| 0.1342 727.16
Lantai 12 39.8] 4205  430595.48| 0.1433 776.18
Lantai 11 36.6] 4205 387552.35| 0.1289 698.59
Lantai 10 33.4] 4205 345464.82| 0.1149 622.73
Lantai 9 30.2|  4205| 304400.32| 0.1013 548.70
Lantai 8 27|  4205|  264438.67| 0.0880 476.67
Lantai 7 23.8] 4205 225675.98| 0.0751 406.80
Lantai 6 20.6]  4205|  188230.74| 0.0626 339.30
Lantai 5 17.4]  4205|  152253.23| 0.0507 274.45
Lantai 4 14.2|  4205|  117941.51] 0.0392 212.60
Lantai 3 1] 4205 85570.94| 0.0285 154.25
Lantai 2 7.8] 4205 55556.29| 0.0185 100.14
Lantai 1 46| 424 28670.64| 0.0095 51.68

TOTAL 54177.2| 3005544.02| 1.000 5417.72

Setelah dilakukan pemilihan kriteria desain, didapatkan

data gedung yang telah dimodifikasi, yaitu :

Tipe Bangunan : Gedung Apartemen.

o Klasifikai Situs: Tanah Lunak (SE).

e Kategori Desain Seismik : D

e Faktor Keutamaan Gedung, /e: 1

o Koefisien Maodifikasi Respon, R : 6

e Faktor Kuat Lebih Sistem, 2,: 2,5

e Faktro Rembesan Defleksi, C.: 5

e Jumlah Lantai :13 Lantai Panjang Bangunan : 54 m
e Lebar Bangunan: 13.2m
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e Tinggi Bangunan: 46.2 m
(termasuk rumah lift).
Lantai Dasar : 4.8 m
Lantai 25/d12:3.2m

e Struktur Bangunan :Beton Bertulang

e Sistem Struktur : SRB - SDSK
e Struktur Pondas : Pondas Dalam.

6.3 Analisa Struktur dengan Program EtabsV9.7.1
6.3.1 Permodelan Struktur
1. Pembuatan Grid Line
Untuk membuat grid line pada ETABS, langkah-
langkah yang dilakukan adalah sebagai berikut:
e File>New Model > Default.Edb
e Pada opsi “Building Plan Grid System and Story
Definition”, dipilih structural object: Grid only
e Kemudian edit boxes diisi sesua denah atau data
bangunan yang direncanakan

1L 11/ suleing Planrid System and stry Bata peiien || 0 [/ |
‘ (Giid Dimensions [Plan) | | Stoy Dimensions ZF
| & Uniform Giid Spacing & Simple Story Data I
Nurber Lines in Dirsclion  [10 Number of Staries 3 |
‘ Number Linesin Y Diecin 10| Typical Story Heigh! pz_ ||
( Spacing in ¥ Dirsction ER V1/] Bottam Stom Height [=2 )| A
Spacingin'f Direction [2ER N ] 2 Custogiihy Doba | 8
‘ " Custom Grid Spacing it -3 |
| | KN - | |
‘ £dd Stuctursl Dbjects 2
- f
RN | (S ‘ E & § |
| el | I8
‘ =
SteelDeck  Staggered  FlatSlb  FlatSlbrith  walfleSleb  TwoWsyor  Grid Only |
| Truss Peimeter Bearns Ribbed Slab |
‘ [
OK Cancel ,‘
—— "

‘Gambar 6.2 Grid system dan Story Data
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2. Penentuan Material Struktur
Untuk menentukan material struktur, langkah-
langkah yang dilakukan adalah sebagai berikut:

e Pilih menu Define > Material Properties

e Dalam option “Define Materials” pilih Conc
(concrete) kemudian pilih Modify/Show Materials.

e Pada options “Material Property Data”, pada
Analysis Properti Dataisi Edit Boxes sesuai data
material yang digunakan (perhatikan satuan yang
dipakai).

o Nila Edit Box Modulus Elasticity diperoleh dari
rumus pada SNI-2847-2013 Ps 8.5.1 yaitu 4700,/f;.

P A Material Property. Data

i AR M- “
I Display Color —I
Material Name [BETONELK Geler | I
Typs of Mateial — Type of Desian |
‘  |sohopic  Orthotropic Design Concrete -
Analysis Propety D ata Design Propetty Data (40 318-05/BE 2003)
| [zaoiEns Comp Shength fe 5
! [23BE 05 ViedStess y (240 ’
[24821.1280 i Vi Shess, s [0 |
02 I~ Lightweight Concrete
Coeff of Thermal Expansion EEET Shear Stength Reduc. Faetor [~ |
‘ Shear Modulus 03421368 ]
L Cancel ,J

Gambar 6.3 Grid system dan Story Data

3. Penentuan Dimens Frame (Rangka)
e |nput Data Pelat
Untuk mendefiniskan ukuran pelat pada
ETABS, pilih menu Define, Wall Slab/Deck Sections
> Add New Deck > Add New Slab, kemudian diis
data sesuai dengan data perencanaan.



149

‘ ‘ Section Mame  [FELATIZ0 | ‘
| I~ —
| Malteria BETONFLT -
Thickness——————————————
N | Membrane 01 | ‘
Bending 012 | ‘
Type —
= Shel € Membrane ‘ ‘
| | T Thick Flate
| rLoadDistibution—————————— |
~ e neiway Load Distibuti |
N 77 7 -
SeiMedfers ]  Display Color M
. Cancel

Gambar 6.4 Input Properti Pelat

Kemudian berdasarkan SNI-2847-2013 pasa
10.10.4 (analisis orde dua elastis) harus meninjau
property penampang Yyang ditetapkan yang
memperhitungkan pengaruh beban aksial, keberadaan
daerah retak pada sel uruh panjang komponen struktur,
dan pengaruh jangka waktu pembebanan. Untuk pelat
properti yang digunakan adalah 0,25l4, Balok 0,35I,
dan Kolom 0,71 .

Untuk itu, dipilih set modifier lalu mengganti enam
data seperti diperlihatkan pada Gambar 6.4.

M| - Stifness Modfiers——————————————
|| | Menbrans 11 Modifer 0.23
! Membrane (22 Modifier 0.25 1
’ Membrane {2 Modifier 0.25 | t
| Bending m17 Modifier 025 | :
| EBending m22 Modiier 0.23
i[ '\ Bending 12 bladier Ll 1
Shear 13 Modifier 1
Shear 23 Madifier 1 |
| Mass Modfier y |
| Weight Madiier 1 ]
i _coca |

Gambar 6.5 Input Set Modifier Pelat



150

e Input Data Balok
Untuk memasukan data dimensi bal ok dipilih menu
Define > Frame Section > Add Rectangular.

‘ Section Name |4DfED
Properties Praperty Modifiers Material
’7 ~Sechion Proceries. . ’7 Set Modifiers... ’7 BETUNELK:‘
Dimerrsion:
Depth (3) e
Width [12] oF H
=
E’: i
e TR
Cancr O 8
Reinf ¢
( _gicrioeenn. _J TP |
EIK Caneel

Gambar 6.6 Input Data Balok

Kemudian pada property modifier > set modifier
dimasukan angka seperti pada Gambar 6.5.

1~ Praperty Modifier

Crozs-section [axial) Area 1
Shear Areain 2 direction 1
Shear Area in 3 direction 1
Tarsional Constant 1
Moment of Inertia about 2 axis 0.35
tament of Inertia about 3 axis 0.3
ass 1
“w/eight 1

Cancel
Gambar 6.7 Input Set Modifier Pada Balok
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e Input Data K olom (60/60)
Untuk memasukan data dimensi kolom sama
seperti pada bal ok, yaitu dipilih menu Define >
Frame Section > Add Rectangular.

Rectangular Section
Section Name k2.600/600 |
| Fropetties Froperty Modiiers Matericl
Dimensions
Depth [13] 06 | | ’
0 0
Width [12] 0E FH T
e ‘
Coners HEEEH
Pleir t
L st |
|_ Cancl

" Gambar 68 Input DataKolom
Kemudian pada property modifier > set modifier
dimasukan angka 0,7 seperti pada Gambar 6.6.
Analysis Property Modification Factors

1
| - Propety Modiiers

Crass-saction [axisl] Area J
Shear Area in 2 direction ! |
Shear Area in 3 direction 1
Torsioral Carstant !

| Moment of Inertia about 2 sz L4
Mament of Inertia about 3 axis 0.7
Mass 1
weight {

i Cancel
Géfnbar 6.9 Set_ Modifier Pf;ldg k»olrom
Penggambaran M odel Elemen

Setelah semua data material yang dipaka sudah
didefinisikan, langkah selanjutnya adal ah menggambarkan



152

letak balok, kolom, dan pelat sesuai dengan denah yang

direncanakan.

- Untuk penggambaran balok dan kolom menggunakan
menu Draw> Line Object

- Untuk penggambaran Pelat menggunakan menu

Draw>Area Object
"r\ L nmwfyf Emrwwmagdﬂmmmrmw 3 0SEstatik | o= aEaE x|

Be gt ow
D& JBY ia l & > DﬁEBEﬂMM'?(}ﬁ R % I-.«»?-:-:-.
z i =

- Plan View - STORY12 - Elevation 38.4 & s 3D view he

30Vew a13YE® 2540

‘Gambar 6.10 Output Penggambaran Permodelan Struktur e

5. Permodelan Dinding Geser (Shear Wall)

- Untuk permodelan arealshear wall dipilih menu
Draw>Area Object>Draw Rectangular Area. Pada
Properties of Object dipilih property elemen wall yang
sudah dibuat: Shear Wall

- shear wall digambarkan seperti pada denah yang
direncanakan.

- Selanjutnyadilakukan Mesh Area pada area Shear Wall
agar elemen dapat lebih bedeformasi lateral (tidak
kaku) dan menghindari perubahan tegangan yang
signifikan maupun konsentrasi tegangan. Dalam hal ini
Meshing yang dilakukan adalah membagi area per
segmen menjadi 4 x 4 dengan memilih menu
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Edit>Mesh Areas>Mesh Quad/Triangles into 4 by 4
Areas.

Meshing Optians —— -

: " Cookie Cut at Selected Line Objects [Horiz.]
" Cookie Cut at Selected Points at i Degrees [Hariz.)

(+ hiesh Quads/Triangles into |4 by |4 Areas

|

| " Mesh Duads/Triangles at |
I Intersections with Yisible Grids |'
| N cted Po jectz on Edges | |
,’ I~ Intersection Selecled Line Dhije

kmjﬂl— 2 = — -_ =N . e s ‘
Gambar 6.11 Mesh Areas Shear Wall

5855 SRBS.

|

Ty H
e 3
ﬁg L

Silk At

ﬁ% S

T

i

- Permodelan Area Shear Wall Sebagai Pier
K egunaan permodel ah area shear wall sebagai
pier adalah penggabungan area-area padatiap tipe
shear wall dalam satu lantai menjadi satu kesatuan
sehingga menjadi struktur yang menerima beban
aksid dan lentur (seperti kolom). Untuk
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memodelkan shear wall sebagai pier dilakukan
dengan memilih menu Assign>Shell/Area>Pier
L abel>Add New Pier.

Untuk mengecek apakah bentuk area shear
wall sudah sesuai dengan area yang dimodelkan
pada Pier, maka dicek pada Section Designer
dengan memilih menu Design>Shear Wall
Design> Deifine  Pier  Sections  For
Checking>Add Pier Section> kemudian isi box
seperti pada Gambar 6.13.

Pier Section Data

| Section Name &l

‘ Base Material SHEARWE = ]

‘IJIJi

Define/Edit/Show Section

| Section Designer...

’ ()8 | Cancel |

|

Gambar 6.13 Data Penampang Pier

kemudian pada section designer ditentukan
tulangan longitudinal yang dipaka (corner
reinforcing dan edge reinforcing) untuk
mendapatkan diagram interaksi pada pier.

Karenabentuk geometri penampang pier serta
ukuran dan lokas penulangan tulangan vertikal
menggunakan section designer, maka pier
dimodelkan sebagai General Reinforcement Pier
Section. untuk memodelkan pier sebagai General
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Reinforcement Pier dipilih menu Select>By Pier
ID> P1 > OK, lalu modelkan sebagai General
Reinforcement Pier dengan memilih menu
Design>Shear Wall Design>Assign Pier Section
For Checking>General Reinforcement Pier
Section.

6. Permodelan Perletakan Struktur

Karena permodelan perletakan struktur adalah jepit,
pada ETABS dapat dimodelkan dengan memblok semua
joint pada level base kemudian pilih menu Assign>Joint
Point> Restraint(Supports), lalu pada Pop-up yang muncul
dipilih “Restrain in Global Direction” atau pilih gambar

jepit seperti pada Gambar 6.9.
7 assignRestaints
Restiaints in Glabal Directions |

v Translation | Hotation about 5
[v Translation v [v Fiotation about v ’

W Trenslation 2 [ Holion sboit 2

Fast Restraints |

| o | | ®
Cancel |
Gambar 6.14 Permodelan Perletakan Struktur

7. Permodelan Rigid Offset

Pada ETABS pendekatan pengaruh kekakuan
sambungan dapat dimodelkan sebagai Rigid Zone Offset.
Nilai default Rigid-Zone Factor =0. Jika Rigid Zone
Factor=1 maka dianggap end-offset sebagai element yang
sangat kaku (fully rigid). Secara umum, manual program
menyatakan bahwa Rigid Zone Factor < 0.5.

Untuk memodelkan Zone Factor ini dipilih menu
Assign>Frame Line>End (length), kemudian masukan
nilai Rigid Zone Factor=0.5.
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6.3.2 Pembebanan Struktur
1. Nilai Massa (Mass Source)

Karena semua €l emen yang tergambar dalam ETABS
seperti: Balok, Kolom, serta Shearwall telah memiliki massa
sesuai yang kita masukkan pada menu “Material Properties.
Maka, Pada ETABS agar tidak terjadi input massa yang
sama harus ditentukan sebagai berikut:

Define Mass Source

Mags Diefinition

" From Self and Specified Mass

& iom Losds

" From Self and Specified M ass and Loads
Defire Mass Multiplier for Loads

Load Multiplier
DEAD =

Ve |or Add
Muodify
Delete

v Include Lateral Mass Only
Iv Lump Lateral Mass at Sty Levels

Cancel
Gambar 6.15 Define Mass Source
Pada Mass Definition dipilih From Loads, ini berarti
massa yang terhitung adalah dari beban mati tambahan
(load), dan juga termasuk dari berat sendiri (beban DEAD
sudah termasuk Self Weighti)
Kemudian massa struktur dianggap berasal dari berat

beban mati total (pengali=1) dan beban hidup efektif
sebesar 70% (pengai=0.7).

2. Jenis Beban Gempa yang Dipakai dalam Analisa
Struktur
Pada perhitungan beban gempa digunakan beban
gempa dinamik menggunakan Respon Spektrum Gempa
rencana sesuai SNI-1726-2012. Agar dapat dimodelkan
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berupa kurva yang mulus kordinat T vs Sa harus
dimasukan dalam Excel karena permodelan kurva respon
spektrum rencana hanya bisa dilakukan dengan notepad,
sehingga kordinat kurva respon spectrum dari Excel di-
copy ke notepad |alu disimpan.

Data perhitungan kurva respon spektrum didapatkan
dari perhitungan sesuai pada sub 6.2 Point 10.

- ( ) Requ\seSpenmm‘ Funktion D'aﬁmlmn ) .

Functon Damping Ratio— | |
Function Name [RsP: [oos

W\

e
@ \collegetits\final assignment_cahyadiyattugas
akhir ¢ ahyadityahlanorantiesoon soekim b

Heater Lines to Skip [i

& Perind vs Valuz

Carvert to iser Defined iew Fils

Function Graph

Display Graph (20386 , 0.1405 ]

- F‘Gamﬁar 6.16 K‘urvaiR&spor; SGeT(trhm

Kemudian setelah memasukan Kurva Respon
Spektrum, ditentukan pemodelan pembebanan gempa
dinamik menggunakan Respon Spektrum sebagai berikut:

Damping = 0.05 (SNI-1726-2012 Ps 6.10.1.3)

- Menurut SNI-1726-2012 Ps 11.1.4: Parameter
respon gaya harus dikalikan le/R. sedangkan nilai
C dinyatakan dengan percepatan gravitas
sehingga harusjugadikali dengan nilai percepatan
gravitasi (g=9.81 m/dt?).

- Menurut SNI-1726-2012 Ps 7.9.3, nilai untuk

masing-masing parameter yang ditinjau, yang
dihitung untuk berbagai ragam, harus
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dikombinasikan menggunakan metoda kombinas
kuadrat lengkap (CQC).

- Padaops “Directional Combination” digunakan
metode SRSS atau orthogonal scale factor=0
sehingga hasil beban gempa yang dihasilkan dari
suatu arah sumbu kordinat tidak tergantung hasil
beban gempa dari sumbu kordinat lain.

. Response Spectrum Case Data
P O a7 A N £ LD _|
Spectrum Case Name [R5 |
Structural and Function Damping
|

‘ [ramping 0.05

Modsl Combination

| @ COC € SASS  ( ABS O GMC |
1 2|

| Directional Combination |

* SRSS |

‘ o ARS Orthogonal 5F

" Modified SRSS [Chinese)

uz i

|
Excitation angle 0. |
Eccentricity
Ecc. Riatio [ Diaph ) Jo. |
Ovenide Diaph. Eceen. Owerride: 1

Cancel i
Gambar G.F Pembebanan—Gempa Dinamik Arah-X

- Pada gempa dinamik arah-x (scae factor
U1=100% x 9.81 x I/R dan U2=30% x 9.81 x I/R)

- Padagempadinamik arah-y (scalefactor U1=30%
X 9.81 x I/R dan U2=100% x 9.81 x I/R)

- Beban gempa dinamik bekerja di pusat diafragma
tanpa dikenai eksentrisitas (ecc.ratio=0).

3. Penentuan Beban Kombinasi
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Sesuai dengan SNI-2847-2013, beban kombinasi
tersebut dimasukan dalam ETABS. Untuk memasukan
beban kombinasi:  dipilih  menu  Define>Load
Combination>Add New Combo, lalu ditentukan beban
kombinasi yang dimasukan sebagai berikut:

\ Load Cﬂmbinaﬁon Data ’
e m— cmm— =2y

Load Combination Name 12D16L ‘

Laoad Caombination Tyupe ADD -

Define Combination ‘
Caze Name Scale Factor
|DEAD Static Load = [1.2

18 Add

|LIVE Static Load

Madify
Delete
Cancel ‘

Garmbar 6.18 Penentuan Beban Kombinas

4. Beban Merata Pada Pelat
Untuk menentukan beban-beban yang bekerja pada
peat (beban hidup dan beban mati tambahan), pilih
keseluruhan pelat pada lantai yang memiliki beban yang
sama.
- Untuk memasukan beban mati dipilih menu Assign >
Shell/Area Loads > Uniform > Load Case Name >
Dead, lau uniform load diisi dengan beban mati
merata yang sudah diperhitungkan sebelumnya yaitu
3.97 KN/n?2.
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| I Case {08 |DEAD =] [ kem =] J
i ~UniformLoad——————————— 1 Dptlons IZAE BSbAdz ’ '
H o E‘S?l—“"——' " Addto Existing Loads }

| * Replace Existing Loads

|| Direction | Gravity :‘v |- " Delete Existing Loads J

OF. I Cancel J I '

Gambar 6.19 Input Beban Mati Merata Pelat Lantai

- Untuk memasukan beban hidup dipilih menu Assign
> Shell/Area Loads > Uniform > Load Case Name >
Live, lau uniform load diis dengan beban hidup
merata yang sudah diperhitungkan sebelumnya yaitu
1.92 kKN/m? untuk pelat lantai dan 0.96 kN/m? untuk
pelat atap.

' " niform Surface loads

T S Units——
—|

| | Load Case Name 1L|VE [khem =]

EERNYENSTE WY | W V)
| | Unformlosd — Dptlons . s | ’
[ | Tead W—' € Add to Evisting Loads |

I {* Replace Existing Loads |
I Direction | Graviy :I' i Delete Existing Loads ‘ |
NWagZlinl RSnagZzaml | ESvAd Ml ESPAT

0K I Cancel J ‘

\_ = - 3 =

Gambar 6.20 Input Beban Hidup Merata Pel at Lantai

Permodelan Pelat sebagai Penyalur Beban L ateral/
Gempa (Diafragma) ke Struktur Primer

Untuk memodelkan pelat sebagal  diafragma,
dilakukan  dengan  memilih  menu  Select>By
Wall/Sab/Deck Section, lalu pilih slab yang sudah di buat.
Setelah itu dipilih menu Assign>Shell Area/Rigid
Diaphragm.
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Gambar 6.21 Diafragma Lantai

6.3.3 Analisis Options Pada Etabsv.9.7.1
1. Building Active Degree of Freedom
Karena struktur yang direncanakan adalah struktur 3
dimensi (3D), maka dalam analisis struktur harus
mencakup 6 dergjat kebebasan (Degrees of Freedoms).
Sehingga untuk memodelkannya  dipilih  menu
Analyze>Set  Analysis options, lalu dipilih semua
opsinya, yaitu: UX,UY,UZ,RX,RY ,RZ.

Analysis Options

| Bulding Active Degrees of Freedom
Ful 30 WZPlane  YZPlane  NoZ Fictation |

Wi Ssleg

I U MUr WUZ WA MR WRZ |

| ¥ Dynaric Analysis Set Dynanic Parameters |
| ¥ Includs PDelta Set P-Della Parameters '
| [~ Save Access DE Fil

\
i 0K Cancel ‘
Gambar 6.22 Penentuan Derajat Kebebasan Sruktur
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2. Analisa Dinamik
Karena struktur yang direncanakan ditinjau
menggunakan  analiss  dinamik, maka untuk
menentukannya dipilih menu Analyze>Set Analysis
Options>Dynamic Analysis, lalu parameter dinamik diis
seperti sebagai berikut:

F\j rerfeeeitn v T

| Mumber of Modes l

i Type of Analysis — ———
@ Eigerwestors Rt Vectars

Eigenvalue Parameters - i

| Fiequency Shift [Center] ID
| Cutoff Frequency (Radius) 0.
| Relative Tolerance 1.000E-07

| ¥ Include Residual-Mass Modes

Stamng Rtz Vecmrs
List of Loads Fitz Load Wectors |

Iost

I:] - Cancel I »

Gambar 6 23 Penentuan Parameter untuk Analisis Dinamik

e ——— e — s

- Padakolom Number of Modes, diisi sesuai jumlah
tingkat yaitu 12 untuk memenuhi kontrol
partisipasi massa 90%.

- Pada kolom EigenVaue Parameters dipilih
include Residual-Mass Modes untuk menghitung
beban massa yang hilang jika partisipasi massa
yang dihasilkan kurang dari 100%.
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3. Analisa P-Ddlta

Pengaruh P-Delta adalah suatu gejala yang terjadi
akibat beban gempa lateral tambahan akibat momen
guling yang terjadi oleh beban gravitas yang titik
tangkapnya menyimpang ke samping. Untuk
memasuk  pengaruh  P-Delta  dipilih  menu
Analyze>Set Analysis Options>Include P-Dédlta, lalu
set parameter P-Delta seperti sebagai berikut:

P-Delta Parameters

" Iterative - Based on Load Combination

I awimuirn |berationg
Relative Tolerance - Displacements

Load Case Sials Factor
|

WA I BT

| |
‘ .
‘ Sreeel] ||

Cancel
Gambar 6.24 Parameter untuk Pengaruh P-Delta

4. Run Analysis
Setelah menentukan Analysis Options dalam
ETABS, untuk mendapatkan hasil analisis struktur
dilakukan Run Analysis. Untuk melakukan Running
dipilih menu Analyze>Run Analysis.

6.4 Kontrol Hasil Analisis Struktur

Berdasarkan SNI-1726-2012, hasil analisis struktur harus
dikontrol melalui suatu batasan tertentu. Hal tersebut dilakukan
untuk meninjau kelayakan struktur dalam memikul beban—beban
yang bekerja. Kontrol — kontrol tersebut antaralain :
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e Perioda Struktur

e Kontrol Akhir Base Reaction

e Jumlah Respon Ragam

e Kontrol Sistem Rangka Gedung

o Kontrol Simpangan

e Pembesaran Momen Torsi Tak Terduga
e Kontrol Pengaruh P - Delta

6.4.1 Kontrol Waktu Getar Alami

Berdasarkan SNI-2847-2013 Pasal 7.8.2 periode struktur
fundamental, T, daam arah yang ditinjau harus diperoleh
menggunakan property struktur dan karakteristik deformas
elemen penahan dalam analisis yang teruji, untuk saat ini hal
tersebut baru dapat didekati dengan menggunakan hasil analisis
komputer. Periode yang didapat dari hasil analisis komputer (T'c)
sebagaimana yang ditunjukan pada Tabel 6.16 , tidak boleh
melebihi hasil koefisen untuk batasan atas pada periode yang
dihitung (Cw) dan periode fundamental pendekatan, Ta

Tc<T =TaCu

Dimana:
Ta = Periode Fundamental pendekatan
Cu= Koefisien untuk batas atas

Pada perhitungan sebelumnya (Bab 6.2 point 11)
didapatkan perioda batasan atas sebesar T=1.176 etik.

Tabel 6.16 Kontrol Perioda Struktur

Periode T, Kontrol
(detik) | (detik) Periode
1 1.192 | 1.238092] OK
1.153 | 1.238092] OK
0.746 1.238092 OK
0.331 1.238092| OK
0.271 1.238092| OK
0.202 1.238092| OK
0.162 | 1.238092 OK
0.114 | 1.238092 OK
0.099 | 1.238092 OK
10 0.095 | 1.238092 OK
11 0.089 | 1.238092 OK
12 0.085 | 1.238092 OK

MODE

o(N|o|u|s|wn

©
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Sehingga :
o ArahX
Tex=1.192 dt<T=1.238 dt—=0OKE
o ArahY
Tcy=1.153 dt<T=1.238 dt=0OKE

6.4.2 Kontrol Akhir Base Reaction

Berdasarkan SNI 03-1726-2012 Pasal 7.9.4, nila akhir
Vdainamik harus lebih besar sama dengan 85% Vstatik. Maka
persyaratan tersebut dapat dinyatakan shb:
Vdinamik= 0.85V statik

Maka nilai base reaction respon spectrum hasil analisis
menggunakan program bantu analisis struktur dapat dilihat pada
Tabel 6.17 ,Table 6.18, dan Tabel 6.19.

A
o457 4508

Al

S o

e

50 Ay &

Gambar 6.25 Denah Point Base
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Tabel 6.17 Nilai Base Reaction RSPX (ETABS)

No [ Story Point Load FX

1|BASE 748[RSPX 123.7| 28|BASE 4534|RSPX 8.75
2|BASE 3552(RSPX 122.71| 29|BASE 4535|RSPX 8.34
3|BASE 3553|RSPX 157.94] 30|BASE 4536|RSPX 83
4|BASE 3589|RSPX 121.65 31{BASE 4537|RSPX 8.75
5[BASE 3590RSPX 10.611_32|BASE 4538|RSPX 9.91
elaase 3591|RSPX 11.061_33|BASE 4539[RSPX 9.8
R ) T R s L ) S N T
PIRASE EXIBIREPX 253 3¢[BAsE 4568|RSPX 12.79
9IBASE 3594|RSPX 10.05 3715 AsE 4569|RSPX 21.86
dQIBASE Eb95RoPX .67 3g|BASE 4570[RSPX 15.28
11|BASE 3596|RSPX 121.22| 39[gASE 4571|RSPX 12.79
12|BASE 3597|RSPX 155.04|  40|BASE 4572|RSPX 21.81
13|BASE 3598|RSPX 14.13| 41|BASE 4573|RSPX 15.31
14|BASE 3599|RSPX 14.17| 42|BASE 4658|RSPX 188.28
15|BASE 3600[RSPX 14.12| 43|BASE 4659|RSPX 16.69
16|BASE 3601|RSPX 3.97| 44|BASE 4660(RSPX 24.21
17|BASE 3603|RSPX 3.94] 45|BASE 4661[RSPX 16.39
18|BASE 3610/RSPX 2.06|_46[BASE 4665|RSPX 17.18
19(BASE 3612|RSPX 3.0|_47|BASE 4666|RSPX 16.83
20[BASE 3613|RSPX 175.97)—B|BASE 436[RSFX 168,68
49(BASE 4697|RSPX 16.41

21|BASE 3621|RSPX 179.76]— Tene prmn —~
24|BASE 20/6/RIPX 8.941 - [BAsE 4699|RSPX 16.71
23|BASE 3801|RSPX 193.16] >[pase 1700|RSPX 193.37
24{BASE 3807|RSPX 25.05]" 53|BAsE 4701[RSPX 16.57
25|BASE 4531|RSPX 8.5 54|BASE 4702|RSPX 24.73
26|BASE 4532|RSPX 10.08| 55(BASE 4703|RSPX 16.96
27|BASE 4533|RSPX 9.82 TOTAL 2481.54




Tabel 6.18 Nilai Base Reaction RSPY (ETABS)
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No Story Point Load FY
1|BASE 748|RSPY 156.76| 29(BASE 4535[RSPY 67.6
2|BASE 3552[RSPY 155.21( 30|BASE 4536|RSPY 66.34
3|BASE 3553|RSPY 6.37| 31|BASE 4537|RSPY 72.38
4|BASE 3589|RSPY 156.53| 32|BASE 4538|RSPY 60.76
5|BASE 3590|RSPY 13.26| 33|BASE 4539[RSPY 60.82
6[BASE 3591|RSPY 9.93| 34|BASE 4540[RSPY 72.48
7|BASE 3592|RSPY 13.24| 35|BASE 4541|RSPY 66.4
8|BASE 3593|RSPY 13.1| 36|BASE 4568|RSPY 1.29
9|BASE 3594|RSPY 10.12| 37|BASE 4569|RSPY 1.2
10|BASE 3595[|RSPY 13.41| 38|BASE 4570[RSPY 1.28
11|BASE 3596|RSPY 155.42| 39|BASE 4571|RSPY 1.41
12|BASE 3597|RSPY 6.95|| 40|BASE 4572|RSPY 1.32
13|BASE 3598|RSPY 11.01| 41|BASE 4573|RSPY 1.38
14|BASE 3599|RSPY 10.51| 42|BASE 4658|RSPY 3.3
15|BASE 3600[RSPY 10.48| 43|BASE 4659(RSPY 7
16|BASE 3601|RSPY 223.24| 44[BASE 4660[RSPY 7.23
17|BASE 3603|RSPY 221.23| 45|BASE 4661|RSPY 7.89
18|BASE 3610|RSPY 223.12|| 46|BASE 4665|RSPY 7.02
19|BASE 3612|RSPY 221.28| 47|BASE 4666|RSPY 7.9
20|BASE 3613|RSPY 0.59| 48|BASE 4696|RSPY 3.27
21|BASE 3621|RSPY 0.5 49|BASE 4697|RSPY 7.81
22|BASE 3676/|RSPY 73.89|| 50[BASE 4698|RSPY 7.15
23|BASE 3801|RSPY 3.32| 51|BASE 4699|RSPY 6.93
24|BASE 3807|RSPY 7.24| 52|BASE 4700|RSPY 3.26
25|BASE 4531|RSPY 67.62| 53|BASE 4701|RSPY 7.8
26/BASE 4532|RSPY 62.19| 54|BASE 4702|RSPY 7.14
27|BASE 4533|RSPY 62.1| 55|BASE 4703|RSPY 6.91
28|BASE 4534|RSPY 73.84 TOTAL 2547.73

Tabel 6.19 Nilai Akhir Base Reaction

Fx (kN)

Fy (kN)

RSPX

2481

.54

RSPY

2547.73

Berdasarkan SNI-1726-2012 Pasal 7.9.4, gaya dasar (V)
yang ditentukan dengan menggunakan persamaan 21 pada SNI-
1726-2012 harus dihitung dalam masing-masing dua arah
horizontal orthogona dengan menggunakan perioda fundamental
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struktur dari hasil analisis struktur menggunakan komputer (Tc)
seperti yang diperlihatkan pada Tabel 6.18.

Tabel 6.20 Gaya Dasar (V) Pada masing-masing Arah

T. (detiK) V (kN) 0.85V (kN)
Sumbu X 1192 5417.72 4605
Sumby Y 1153 5417.72 4605

Maka didapatkan kontrol akhir base reaction terhadap
0.85V statik seperti diperlihatkan pada Tabel 6.19.

Tabel 6.21 Konrol Akhir Base Reaction

Fx Fy Kontrol Akhir
Fx Fy
V dinamik 2476.58 Tidak OK
0.85V gatik 4605
V dinamik 2618.32 Tidak OK
0.85V gatik 4605

Sebagaimana yang diperlihatkan pada Tabel 6.19 karena
kontrol akhir tidak memenuhi persayaratan Vdinamik= 0.85V statik.
maka spektra respon desain pada andisis struktur harus dikalikan

faktor skala yang ditentukan dengan Ovswﬂ pada masing-
dinamik

masing arah, sehingga persyaratan Vdinamik=> 0.85V statik terpenuhi.
Besarnya faktor sekala tersebut diperlihatkan pada Tabel 6.20.

Tabel 6.22 Faktor skala Gempa Dinamik

Fx Fy Kontrol Akhir Faktor Skala
Fx Fy Fx Fy
RSPX | 4096.62 Tidak 1.858
OK
RSPY 2696.65 Tidak 1.759
OK
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Setelah diperoleh faktor skala masing-masing arah
pembebanan, selanjutnya dilakukan analisis ulang dengan
mengalikan faktor skala yang diperoleh diatas pada scale factor
respons spectra. Kemudian diperoleh hasil yang diperlihatkan
pada Tabel 6.23

Tabel 6.23 Nilai Base Reaction RSPX setelah dikali faktor skala (1.86)

No [Story Point __ [Load FX 29[BASE 4535[RsPX 15.51
1[BASE 748[RSPX 230.07] 30[BASE 4536|RsPX 15.44
2|BASE 3552|RSPX 228.24| 31{BASE 4537|RSPX 16.28
3|BASE 3553|RSPX 293.77| 32|BASE 4538|RSPX 18.44
4|BASE 3589|RSPX 226.27) 33|BASE 4539|RSPX 18.23
5|BASE 3590{RSPX 19.74| 34[BASE 4540[RSPX 16.15
bfBASE 3591{ RSB 20.58] 35/BASE 4541|RSPX 15.4
7|BASE 3592{RIEX 20011 36[pAsE 4568[RSPX 23.78
3{BASE 3593{RSPX 17731 37]BASE 4569|RSPX 40,67,
SIBASE 3594|RSPX 1871 3gBASE 4570|RSPX 28.41

10[BASE 3595|RSPX 17.991 35]ASE 4571|RSPX 23.78
11|BASE 3596[RSPX 22548 Tor s T oeny P
ﬁ Zﬁ:é :‘;’gg Ezii zii‘” 41[BASE 4573[RSPX 28.48)
.28
el e 7 e aol_2|BAsE 4658[RSPX 350.2
T e TRoPR e 26l_43|BASE 4659|RSPX 31.04
TelAse 601[RsPx S 30|_441BASE 4660|RSPX 45.04
7lBAcE 3603IRSPX 2 33]_45[BASE 4661|RSPX 30.49
TSlRASE 60| RS R ~so|_46|BASE 4665|RSPX 31.95
19|BR5E =S REX Z 26l 47|BASE 4666[RSPX 31.3
20| BASE 3613]RSPX 327.3|__48[BASE 4696|RSPX 350.94
21[BASE 3621[RSPX 334.35| _49|BASE 4697|RSPX 30.53
22|BASE 3676|RSPX 16.63|__50|BASE 4698|RSPX 45.22
23|BASE 3801|RSPX 359.28] S51|BASE 4699|RSPX 31.07
24|BASE 3807|RSPX 46.59| 52|BASE 4700|RSPX 359.66
25|BASE 4531|RSPX 15.9| 53[BASE 4701[RSPX 30.81
26[BASE 4532[RSPX 18.74] 54{BASE 4702[RsPX 45.99
27[BASE 4533[RsPX 18.26] 55[BASE 4703[RsPX 31.55
28[BASE 4534[RsPX 16.27 TOTAL 4615.64
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Tabel 6.24 Nilai Base Reaction RSPY setelah dikali faktor skala (1.81)

No |Story Point Load FY
1|BASE 748|RSPY 283.74| 29(BASE 4535|RSPY 122.35
2|BASE 3552|RSPY 280.93| 30(BASE 4536(RSPY 120.08
3|BASE 3553|RSPY 11.53| 31|BASE 4537|RSPY 131
4|BASE 3589|RSPY 283.31| 32(BASE 4538|RSPY 109.97
5|BASE 3590|RSPY 24.01| 33|BASE 4539|RSPY 110.09
6|BASE 3591|RSPY 17.97| 34|BASE 4540(RSPY 131.2
7|BASE 3592|RSPY 23.97| 35|BASE 4541|RSPY 120.19
8|BASE 3593|RSPY 23.71| 36|BASE 4568|RSPY 2.34
9|BASE 3594|RSPY 18.32| 37|BASE 4569|RSPY 2.17
10|BASE 3595|RSPY 24.27| 38|BASE 4570|RSPY 2.31
11|BASE 3596|RSPY 281.3| 39|BASE 4571|RSPY 2.56
12|BASE 3597|RSPY 12.58| 40(BASE 4572|RSPY 2.39
13|BASE 3598|RSPY 19.92| 41|BASE 4573|RSPY 2.5
14|BASE 3599|RSPY 19.03| 42|BASE 4658|RSPY 5.98
15|BASE 3600|RSPY 18.97| 43|BASE 4659|RSPY 12.67
16|BASE 3601[RSPY 404.07| 44|BASE 4660(RSPY 13.08
17|BASE 3603|RSPY 400.42| A45|BASE 4661|RSPY 14.28
18|BASE 3610|RSPY 403.85 46|BASE 4665|RSPY 12.7
19|BASE 3612|RSPY 400.51| 47|BASE 4666(RSPY 14.3
20|BASE 3613|RSPY 1.07| 48|BASE 4696(RSPY 5.92]
21|BASE 3621|RSPY 0.9] 49(BASE 4697|RSPY 14.13
22|BASE 3676|RSPY 133.75| 50(BASE 4698|RSPY 12.94
23|BASE 3801|RSPY 6.01| 51|BASE 4699|RSPY 12.54
24|BASE 3807|RSPY 13.1| 52(BASE 4700|RSPY 5.89
25|BASE 4531|RSPY 122.39| 53(BASE 4701|RSPY 14.11
26|BASE 4532|RSPY 112.56| 54|BASE 4702|RSPY 12.92
27|BASE 4533|RSPY 112.41| 55[BASE 4703|RSPY 12.51
28|BASE 4534|RSPY 133.66 TOTAL 4611.38

Tabel 6.25 Konrol Akhir Base Reaction

Ex Fy Kontrol Akhir
Fx Fy
V ginami 4615.64
dinamik oK
0.85V gaiik 4605.06
V ginamik 4611.38 oK
0.85V gatik 4605.06

Berdasarkan Tabel 6.22 setelah dilakukan analisis ulang
maka gempa dinamik telah memenuhi persyaratan pada SNI-1726-
2012 Ps. 7.9.4.

6.4.3 Jumlah Respon Ragam
Berdasarkan SNI-1726-2012 Ps. 7.9.1 bahwa anadlisis harus
menyertakan jumlah ragam yang cukup untuk mendapatkan
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partispasi massa ragam terkombinasi paling sedikit 90 % dari
massa aktual dalam masing-maisng arah horizontal orthogonal dari
respon yang ditinjau oleh model.

Penjumlahan respon ragam untuk struktur gedung beraturan
yang memiliki waktu-waktu getar alami yang berdekatan, harus
dilakukan dengan metode (Complete Quadratic Combination) atau
CQC. Waktu getar alami dianggap berdekatan, apabila selisish
nilainya kurang dari 15%. Untuk struktur gedung tidak beraturan
yang memiliki waktu getar alami yang berjauhan, penjumlahan
respon ragam harus dilakukan dengan metoda Akar Jumlah
Kuadrat (Square Root of the Sum of Squares atau SRSS).

Berdasarkan uraian tersebut didapatkan hasil jumlah respon
ragam dengan metoda CQC yang diperlihatkan pada Tabel 6.24

Tabel 6.26 Jumlah Respon Ragam

Mode [SumUX  |SumUY
1| 74.7543 0.0039
2| 74.7584| 69.6253
3| 74.7607| 69.6317
4 88.99| 69.6318
5 88.99| 89.4005
6
7
8
9

88.9907 89.4007
94.5885( 89.4007
94.5885| 95.5284
97.2508| 95.5284
10| 97.2508| 95.5292
11{ 97.2508| 97.9455
12| 98.5836[ 97.9455

Berdasarkan Tabel 6.24 diatas menunjukan bahwa pada
mode shape 6, syarat partisipasi massa telah terpenuhi.
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6.4.4 Kontrol Sistem Rangka Gedung

Berdasarkan SNI-1726-2012 Tabel 9 point B.4 Sistem
Rangka Gedung (SRG) merupakan sistem struktur yang beban
gravitasinya dipikul sepenuhnya oleh rangka, sedangkan beban
lateralnya dipikul oleh dinding geser. Struktur yang menggunakan
sisem ini harus menunjukan bahwa dinding geser mampu
menyerap 90 sampai dengan 100 persen gaya gempa pada arah
yang ditinjau, sehingga rangka gedung hanya memikul gaya
gravitasi ditambah momen akibat perpindahalateral dinding geser.

Kemampuan dari dinding geser dalam menyerap beban
lateral akibat gempa dapat dilihat pada Tabel 6.23

Tabel 6.27 Kontrol Rangka Gedung

Prosentase dalam menahan gempa (kN) Prosentase dalam menahan gempa( %)
No Kombinasi Fx Fy Fx Fy
Portal | Shearwall | Portal | Shearwall | Portal | Shearwall |Portal| Shearwall
1 |1.2D+L+RSPX 113.98 2199.46| 14431 3232.42| 4.93 95.07 4.27 95.73
2 |1.2D+L-RSPX -119.99] -2156.3| -116.02 -3289.32| 5.27 94.73 3.41 96.59
3 [1.2D+L+RSPY 116.57, 3497.71 115.88 3165.69 3.23 96.77 3.53 96.47
4 |1.2D+L-RSPY -155.73 -3578.62| -120.57 -3213.06| 4.17 95.83 3.62 96.38
5 [0.9D+RSPX 129.81 3241.32 141.68 3325.84| 3.85 96.15 4.09 95.91
6 |0.9D-RSPX -95.66| -3251.27 -121.2|  -3122.98| 2.86 97.14 3.74 96.26
7 |0.9D+RSPY 143.17| 3484.13 136.35 3190.5[ 3.95 96.05 4.10 95.90
8 |0.9D-RSPY -126.57| -3604.12 -96.66 -3185.55| 3.39 96.61 2.94 97.06

Berdasarkan Tabe 6.23 terlihat bahwa dinding geser
memikul memikul beban lateral minimum sebesar 94.73 % untuk
arah sumbu X dan 95.73 % untuk arah Y. Sehingga, perbandingan
base shear reaction antara rangka gedung dan dinding geser telah
memenuhi ketentuan.

6.4.5 Kontrol Simpangan (Drift)

Berdasarkan SNI-1726-2012 kontrol drift dan syarat drift
harus ditentukan berdasarkan perumusan 34 pada SNI-1726-2012
Pasal 7.8.6 yaitu sebagai berikut :

C46
6x L Ixe

Dimana
6x = Defleks padalantai ke-x
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Ca = Faktor pembesaran defleksi (4.5)
I = Faktor keutamaan gempa

Sedangkan untuk syarat As=0.020hsx dengan As merupakan
selisih antara defleksi yang ditunjukan pada analisis struktur, (§xe)
dengan defleks akibat pembesaran, (dx).

Hasil dari kontrol simpangan pada analisis struktur Gedung
Hotel Fave Surabaya akibat gempa dinamik pada masing-masing
arah diperlihatkan pada Tabel 6.24 untuk arah X dan Tabel 6.25
untuk arah Y.

Tabel 6.28 Kontrol Simpangan Arah-X

Tingkat h Se 5 A £4 Keterangan
(m) (mm) (mm) (mm) (mm)
Lantai 13 43.2 74.15| 370.75| 21.650] 64 oK
Lantai 12 40 69.82| 349.10| 21.600| 64 oK
Lantai 11 36.8 65.50| 327.50| 26.800| 64 oK
Lantai 10 33.6 60.14 300.70 28.850, 64 OK
Lantai 9 30.4 54.37| 271.85| 29.850| 64 oK
Lantai 8 27.2 48.40| 242.00| 32.950| 64 0K
Lantai 7 24|  41.81] 209.05| 36.050| 64 0K
Lantai 6 20.8 34.60] 173.00 29.850| 64 0K
Lantai 5 17.6 28.63| 143.15| 36.050] 64 0K
Lantai 4 14.4 21.42| 107.10| 34.000] 64 0K
Lantai 3 11.2 14.62 73.10| 29.850| 64 0K
Lantai 2 8 8.65|  43.25| 21.600] 64 0K
Lantai 1 4.8 4.33 21.65| 21.650] 96 0K
Tabel 6.29 Kontrol Simpangan Arah-Y
Tingkat h 5% 5 £ ga Keterangan
(m) (mm) (mm) (mm) (mm)

Lantai 13 432 69.620] 348.100| 21.800| 64 oK
Lantai 12 40|  65.260| 326.300] 28.450| 64 0K
Lantai 11 36.8] 59.570| 297.850| 29.400| 64 0K
Lantai 10 33.6] 53.690| 268.450| 31.300] 64 OK
Lantai 9 30.4| 47.430] 237.150| 33.200| 64 0K
Lantai 8 27.2|  40.790| 203.950| 29.400| 64 0K
Lantai 7 24| 34.910| 174.550| 32.250| 64 OK
Lantai 6 20.8|  28.460| 142.300] 32.250| 64 oK
Lantai 5 17.6| 22.010| 110.050| 28.500| 64 0K
Lantai 4 14.4| 16.310] 81550 27.500| 64 0K
Lantai 3 11.2| 10.810| 54.050] 21.800] 64 oK
Lantai 2 8| 6.450] 32.250 16.150 64 OK
Lantai 1 4.8 3.220 16.100] 16.100] 96 0K
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6.4.6 Pembesaran Momen Tors Tak Teduga

Berdasarkan SNI-1726-2012 Ps. 7.8.4.3 menyebutkan
struktur yang dirancang untuk kategori desain seismik C, D, E atau
F, dimana ketidakberaturan tors tipe la atau 1b terjadi seperti
didefinisikan dalam Tabel 10 SNI-1726-2012 harus mempunyai
pengaruh yang diperhitungkan. Karena struktur Gedung Hotel
Fave Surabaya yang termasuk dalam kategori desain sesimik D
maka diperlukan kontrol terlebih dahulu terhadap ketidakberaturan
tors laatau 1b seperti seperti yang didefinisikan dalam Tabel 10
SNI-1726-2012. llustrasi dari uraian diatas diperlihatkan pada
Gambar 6.2.

AV nevARl Acsigal A 7 ) o
-2 ; e = B3
: =) sz
0 }rl ~ e X
! -
\L‘ JJJJJJ A
"
Orata-rata = O +0 ., _|_ Omaksimum |
2 * 1,20 rata-rata
Gambar 6.26 Pembesaran Torsi Tak Terduga (Ax)
Dimana:
64 atau dmax dan 6B dihitung berdasarkan simpangan akibat beban
spektra.

Berdasarkan ~ SNI-1726-2012 Tabel 10  struktur
dikategorikan ketidakberaturan tors la dan 1b bila ketentuan
dibawah ini terpenuhi :
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dmax<1.26avg— Tanpa Ketidakberaturan Tors
1.20avg<dmax<1.46avg— Ketidakberaturan Tors l1a
Omax>1.46avg— Ketidakberaturan Tors 1b

Berdasarkan uraian tersebut didapatkan hasil point
displacement yang diperlihatkan pada Tabel 6.26 untuk arah X dan
Tabel 6.27 untuk arah Y

Tabel 6.30 Point Displacement Akibat Beban Spektra Arah-X

Point Displacement (mm)
Point Object Y X

748 21.73 MAX-->73.96
3589 21.73 72.45
3590 21.73 72.83
3591 21.73 73.20
3592 21.73 73.58
3601 273 72.64
3604 21.73 73.01
3607 21.73 73.39
3610 21.73 73.77
3676 21.73 73.87
4531 21.73 73.82
4532 21.73 73.91
4533 21.73 72.50

bavg 73.30

Point displacement tersebut didapatkan akibat beban spektra
arah-X sebagaimana diperlihatkan pada Tabel 6.27.
Berdasarkan Tabel 6.27 didapatkan analisis sebagai berikut:
1.28avg=1.2%x73.30=87.96 .. dmax < 1.28avyg
73.96 < 87.96— — TanpaKetidakberaturan Tors
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Tabel 6.31 Point Displacement Akibat Beban Spektra Arah-Y

Point Displacement (mm)
Point Object X Y

748 21.59 MAX--> 70.48
3552 21.59 70.19
3553 21.59 70.36
3621 21.59 70.31
3640 21.59 70.23
3801 21.59 70.43
3807 21.59 70.46
4568 21.59 70.32
4569 21.59 70.33
4570 21.59 70.35
4665 21.59 70.44
4666 21.59 70.47
4700 21.59 70.24

bavg 70.35

Point displacement tersebut didapatkan akibat beban spektra
arah-X sebagai mana diperlihatkan pada Tabel 6.27.
Berdasarkan Tabel 6.27 didapatkan analisis sebagai berikut:
1.28avg=1.2%70.35=84.42 . dmax < 1.26avg
70.48 < 84.42— Tanpa Ketidakberaturan Torsi

6.4.7 Kontrol Pengaruh P-Delta

Berdasarkan SNI-1726-2012 Ps 7.8.7 pengaruh P-delta
harus diperhitungkan dengan menggunakan persamaan 35 pada
SNI-1726-2012. Pengaruh P-delta tidak disayaratkan untuk
diperhitungkan bila koefisien stabilitas () < 0.1
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P,Al,
3 Vxhstd

Dimana:

Px = Beban vertikal total pada dan diatas tingkat-x,
tanpa faktor beban (kN)

A = Simpangan antar lantai tingkat yang terjadi secara
serentak dengan Vx (mm)

Ie = Faktor keutamaan gempa

Vx = Gayageser seismik yang bekerja antar tingkat x dan x-1
(kN)

hsx = Tinggi tingkat dibawah tingkat x, (mm)
Ca = Faktor pembesaran defleksi

Berdasarkan persamaan diatas didapatkan hasil
perhitungan koefisien stabilitas yang diperlihatkan pada Tabel
6.32.

Tabel 6.32 Perhitungan koefisien stabilitas (6)

Lantai P, A le V, hey cd 0

Atap 3575 21.80 1 753.7211| 3200 5 0.006463
Lantai 12 4205 28.45 1 798.9834| 3200 5 0.009359
Lantai 11 4205 29.40 1 713.7411| 3200 5 0.010827
Lantai 10 4205 31.30 1 631.0415| 3200 5 0.013037
Lantai 9 4205 33.20 1 551.0417| 3200 5 0.015836
Lantai 8 4205 29.40 1 473.9263( 3200 5 0.016305
Lantai 7 4205 32.25 1 399.915| 3200 5 0.021196
Lantai 6 4205 32.25 1 329.2763| 3200 5 0.025743
Lantai 5 4205 28.50 1 262.346| 3200 5 0.028554
Lantai 4 4205 27.50 1 199.5608| 3200 5 0.03622
Lantai 3 4205 21.80 1 141.5174| 3200 5 0.04049
Lantai 2 4205 16.15 il 89.09524( 3200 5 0.047645
Mezzanin 4214 16.10 1 43.85639( 4800 5 0.064456

Berdasarkan hasil perhitungan di atas didapatkan bahwa
koefisien stabilitas (0) < 0.1 sehingga pengaruh P-delta tidak
perlu diperhitungkan.
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BAB VII
DESAIN STRUKTUR PRIMER
7.1 Umum

Struktur primer memegang peranan penting dalam kekuatan
suatu gedung. Perancanaan struktur primer Gedung Hotel Fave
Ketintang Surabaya ini menggunakan Sistem Rangka Gedung
(SRG) pada kedua arah sumbunya, dimana keseluruhan beban
gempa akan dipikul oleh Struktur Dinding Geser Khusus (SDSK)
sedangka portal atau rangka hanya memikul beban gravitas
ditambah momen akibat perpindahan lateral dinding geser pada
masing-masing arah. Berdasarkan SNI-2847-2013 komponen
struktur yang tidak direncanakan menahan gaya gempa harus
mengikuti pasal 21.13.

7.2 Desain Balok Primer

Pada perencanaan balok primer pracetak, penulangan
dikontrol terhadap tiga kondis vyaitu, penulangan sebelum
komposit, saat overtopping, dan saat sesudah komposit.

[
o o o o _o o e o o

- x Jot L Y L

(a) (b) (c)

Gambar 7.1 (a) Dimensi balok anak sebelum komposit, (b) Dimensi balok anak
saat overtopping, (c) Dimensi balok anak saat komposit.
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7.2.1 Pembebanan Balok Primer B1 As 3 ; B-C (40/60)
Denah lokasi balok sekunder B1 As 3 ; B-C ditunjukan pada
Gambar 7.2.

PALOK YANG DITINJAU

< HH q *4‘: + 777‘:"'
| 1 ] |

Gambar 7.2 Lokasi Peninjauan Balok Primer BL As3; B-C
1. Pembebanan Sebelum Komposit

Beban Mati

Berat Sendiri Balok = 0.4%0.48x24 = 4.61 kN

Balok Anak =0.3x0.38x24x3.6x 2/7.2  =2.74 kN

Beban Pelat =2 x0.07x1.8x24 = 6.05 kN
Cota = 13.4 kN

2. Pembebanan Saat Overtopping

Beban Mati

Berat Sendiri Balok =0.4x06x24 =5.76 kN

Balok Anak =0.3%x0.5x 24 x 3.6 x 2/7.2 = 3.60 kN

Beban Pelat = 2x0.12x1.8x24 =10.37 kN
Cota = 19.73 kN

3. Pembebanan Setelah Komposit

Pembebanan pada kondisi setelah komposit berlaku
beban ultimate hasil dari analisis struktur dari program bantu
ETABS. Berdasarkan sistem struktur SRG, maka beban yang
diterima rangka adalah gravitasi ditambah momen akibat
perpindahan lateral dinding geser pada masing-masing arah.

Data output momen dari program bantu analisis struktur
dapat dilihat pada Tabel 7.1.



Tabel 7.1 Output Momen Balok Hasil Analisis Program

No | Kombinasi Beban Lokasi Momen (kNm)
o ol {£) 109.684
Tumpuan Kiri
) -168.665
& 109.1
1 1.4DL Wodngan () 09.118
() B
) 106.948
Tumpuan Kanan
) -139.033
¥
Tumpuan Kiri ) 132.996
() -203.253
2 | 1.2DL+1.2LL+0.5Lr Lapangan ((+)) 133.312
Tumpuan Kanan (4 132.253
(-) -170.575
Tumpuan Kiri (+) 131.153
() -228.565
3 | 12DL+LLRSPX Lapangan ((+)) 118.639
Tumpuan Kanan () 122.366
(=) -198.728
Tamkgan Kl 120.309
() -195.062
4 | 1.2DL+LL£RSPY Lapangan ((+)) 118,511
Tumpuan Kanan ) 118,591
() -165.146
Tumpuan Kiri (+) 85.075
() 85.075
5 0.9 DL+ RSPX Lapangan ((+)) 70.393
Tumpuan Kanan () 83.496
() -165.146
Tumpuan Kiri ki) 73.165
() -25.055
6 0.9 DL £ RSPY Lapangan ((+)) 70.309
Tumpuan Kanan (4 58.76
() -136.807

181
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7.2.2 Penulangan Lentur Balok Primer B1As3; B-C
f¢ =25 Mpa

fy =390 Mpa
0.85 X f/ X By 600
Pp = X
fy 600 + fy
_085x25x085 600
Po = 390 600+ 390

Pmax = 0.75pp = 0.75 x 0.028 = 0.021

Berdasarkan SNI-2847-2013 Pasal 10.5.1 rasio tulangan

minimum ditentukan dengan rumus sebagai berikut:

1.4 1.4
Pmin = E =S 0.0036

0'25\/75 0.25v25
Pmin = vanl 6 = 0.0032

Maka, dipakai pmin=0.0036

1. Penulangan Sebelum Komposit
b =400 mm
h =480 mm

d':40+10+§=59.5mm

1
d =480—40—10—519 = 420.5mm

X 13.4 X 7.82) = 86.83 kNm = 86830000 Nmm

x| =

=

= — =96480000 Nmm

M, 86.83 % 10°
? 0.9

M, =

Kontrol tulangan rangkap atau tunggal
Mn = 96480000 Nmm




__600
=800+ 7, " “ T 600+ 390
¢ = 0.75¢, = 0.75 X 254.85 = 191.14 mm
a=pBr.c =085 x 191.14 = 162.47 mm

X 420.5 = 254.85 mm

183

C. = 0.85f..b.a = 0.85 X 25 X 400 x 162.47 = 1380995 N

= 1381 kN
Qe PTEs0sF 0 £
STEROT Seal RO ST TR
a
My, = Agfy (d _E) = 3541 x 390 x (420.5 u
= 468521572 Nmm = 468.52 kNm

162.47)

M,, = 468.52 kN > M,, = 96.48 kNm
Maka dihitung sebagai tulangan tunggal

Mn 96480000

Ri=—= = 1.364
"= pd? 00 x 42052 3@
il Gasenl Gl
M= 085X e 085XZ5 1031
2m X Rn
Poeriw = —( 1 1—T

L QAL NP CEESZE Pt ¢
Ppertu = 75735 390 =&

Pmin < pperlu < pperlu
Maka, dipakai pperiu= 0.0036
ASperiy = p-b.d = 0.0036 X 400 x 420.5 = 615.5 mm?

1
AS1 tutangan = ZnD2 = 0.25 X T X 192 = 283.39 mm?



Asperlu _ 615.5

fuilageliSas, @Phn 50
Dipakai 3919 (As = 850.17 mn?)

=217=3

bw - 2tselimut - 2®sengkang B n(atul.utama

3 n—1
S_4OO—2><40—2><10—3><19

=24,
= 5mm

_ Asfy  850.15x390
4= 085.fc.h 085 x 25 x 400

OMn = QAs.fy (d - %)

=39mm

39
®Mn = 0.9 x 850.17 x 390 (420.5 3 7)

= 119660000 Nmm
¢éMn = 119660000 Nmm > Mu = 86823000 Nmm (OK)

Kontrol Spasi Tulangan:

S >25mm (SNI-2847-2013 Pasdl 7.6.2)
S < (3h=360 mm) (SNI-2847-2013 Pasal 7.6.5)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)

121.5 mm > 25 mm (OK)
121.5 mm < 360 mm (OK)
121.5 mm < 450 mm (OK)

Maka, dipakai tulangan utama 3¢p19

Kontrol Retak
280
S = 380(

N

280
) —2.5C, < 300( 7

N

)
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2 2
fs =3fy =73 %390 = 260 Mpa

C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C., =50mm
s =380(25) - 2.5 % 50 < 300 x (=)
260 260
s = 284.23 mm < 323.08 mm (OK).

Gambar 7.3 Penulangan Balok Primer B1 As 3 ; B-C Sebelum Komposit

2. Penulangan Saat Overtopping
b =400 mm
h =480 mm

d’=4o+10+§=59.5mm

1
d=480—40—10—§19=420.5mm

1
M, = (§ X 19.73 x 7.22) = 127.85 kNm
= 127850000 Nmm
M, 127.85Xx 10°
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Kontrol tulangan rangkap atau tunggal

Mn = 142056000 Nmm
600

% =500+ %~ 600+390
¢ = 0.75¢, = 0.75 x 254.85 = 191.14 mm
a=pr.c=0.85x 191.14 = 16247 mm

C. = 0.85f.b.a = 0.85 x 25 X 400 X 162.47

= 1380995 N = 1381 kN
C 1380995

A= —=

STF 390

a 162.47

My = Asfy (d —E) = 3541 x 390 X (420.5 5] )
= 468521572 Nmm = 468.52 kNm

X 420.5 = 254.85 mm

= 3541 mm?

M, = 468.52 kNm > M,, = 142.056 kNm
Maka dihitung sebagai tulangan tunggal

Mn 142056000

Rn = L = 2.00
"= P.dZ T 200 x 42052
fy 390
- - 135
M= 085 f'c 0.85x25

1 2m X Rn
Ppertu = | 1 <P

_ 1 [, |, _2x1835x200)\
Pperiv = 7535 390 —\

Pmin < pperlu < pperlu
Maka, dlpakal pperiu=0.0036
ASperiy = p-b.d = 0.0054 x 400 x 420.5 = 911.6 mm?
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1
AS1 tuiangan = ZnDZ = 0.25 X T X 192 = 283.39 mm?

Asperri ll 19418

b 'O W T
Dipakai 4019 (As = 1133.5 mm?)

=322=4

bw N 2tselimut i stengkang i nQ)tul.utama

& n—1
S_400—2><40—2><10—4><19

g =75mm

_ As.fy - 1133.5%390
4= 085.fc.b  0.85x 25 x 400

OMn = 9As. fy (d - %)

=52mm

52
PMn = 0.9 x 1133.5 x 390 (420.5 - —)

2
= 159960000 Nmm
¢Mn = 159960000 Nmm > Mu = 127850000 Nmm (OK)

Kontrol Spasi Tulangan:

S>25mm (SNI-2847-2013 Pasdl 7.6.2)
S < (3h=360 mm) (SNI-2847-2013 Pasal 7.6.5)
S <450 mm (SNI1-2847-2013 Pasal 7.6.5)

75mm > 25 mm (OK)
75 mm <360 mm (OK)
75 mm <450 mm (OK)

Maka, dipakai tulangan utama 4¢19
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Kontrol Retak
380 (280> 2.5C, < 300(280)
S = — L =
fs ) fs
—2 —2><390—26OM
fs = ny v = pa

C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C. =50mm
280 280

s = 380 (%) —25x50 <300 x (2—60)
s = 284.23 mm < 323.08 mm (OK).
=)

‘U |

e -

Gambar 7.4 Penulangan Balok Primer B1 As 3 ; B-C Saat Overtopping

3. Penulangan Setelah K omposit

Pada penulangan setelah komposit berlaku momen ultimate
hasil dari analisis struktur.

b =400 mm

h =600 mm

d'=40+1o+325=62.5mm
d=600—40—10—§25=537.5mm

Penulangan Daerah Tumpuan

Mu(-) =203 kNm
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M, 203 x10°

My = ¢ = = 5 = 211.588.889 Nmm

Kontrol tulangan rangkap atau tunggal
Mn = 211588889 Nmm

__ 600 . _
% =800+7, "~ “ T 600+ 240
¢ =0.75¢c, = 0.75 x 383.93 = 287.95 mm
a=f;.c=0.85x 287.95 = 244.76
C. = 0.85f/.b.a = 0.85 X 25 x 400 x 244.76

= 2080460 N = 2090.46 kN

4 G _2080460 .
S_fy_ Tl 51 mm

a
My, = Asfy (d - Z)
— 533451 x 390 x (537.5 )
— 863640099 Nmm = 863.64 kNm

X 537.5 = 383.93 mm

244.76)

My, = 863.64 kN > M,, = 211.59 kNm
Maka dihitung sebagai tulangan tunggal

_ 085X f' X By 600

= X
Pb fy 600 + fy

_085x25x085 600 ..
Po = 240 600 + 240

Pmax = 0.75p, = 0.75 x 0.06324 = 0.04

_ Mn 211588889 _
" b.d? 400 x 537.52

Rn 1.83
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__ Sy 390 gss

M= 085x%fc 085%x25
1 2m X Rn

pperluzn_,L d’>- _T

CEZ R VT x o Lar N7
Pperiv = g 35 390 =

Pmin =< pperlu < pperlu
Maka, dlpakal pperlu: 0005
ASperpy, = p-b.d = 0.005 x 400 X 537.5 = 1075 mm?

1
ASy tyiangan = ZnDZ = 0.25 X © X 192 = 283.53 mm?

ASperlu _ 1075

RodanggolioR, 0 23050
Dipakai 4419 (As = 1134.12 mm?)

=379 =4

bw - 2tselimut - 2(Z)sengkang =1 nq)tul.utama

n—1
S_400—2><40—2><10—4><19

Dot =78mm
__Asfy _113412x3%0 __
=085 fc.h 085x25x400 ~o
a
oMn = pAs. fy (d - E)
52.04
@Mn = 0.9 x 1134.12 x 390 (537.5 X T)

= 203607974 Nmm
¢Mn = 203607974 Nmm > Mu = 190430000 Nmm (OK)



Kontrol Spas Tulangan:

S >25mm (SNI-2847-2013 Pasal 7.6.2)
S < (3h=360 mm) (SNI-2847-2013 Pasdl 7.6.5)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)

78 mm > 25 mm (OK)
78 mm < 360 mm (OK)
78 mm < 450 mm (OK)

Maka, dipakai tulangan utama 4¢19

Kontrol Retak
280 280
s = 380( ) —2.5C, <300(—)
fs fs

8,
fy =3 fy =5 %390 = 260 Mpa

C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C. =50mm
280

s = 380 (ﬁ) —2.5% 50 < 300 x (%)

s = 284.23 mm < 323.08 mm (OK).

Penulangan Daer ah L apangan
Mu (+) = 133 kNm

M, 133 x 10

M, = — = = 170022222 N
n= 09 700222 mm

Kontrol tulangan rangkap atau tunggal
Mn = 170022222 Nmm

_ 600 A 600
=500+ £ T 600+ 240
¢ =0.75¢, = 0.75 X 383.93 = 287.95 mm
a=f;.c = 0.85x 287.95 = 244.76

x 537.5 = 383.93mm

191
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C. = 0.85f.b.a = 0.85 X 25 x 400 x 244.76
= 2080460 N = 2090.46 kN

e C _2080460_533451 )
S_fy_ TV & S51mm

a
My, = Agfy (d - E) = 5334.51 x 390 x (537.5 2
= 863640099 Nmm = 863.64 kNm

244.76)

My, = 863.64 kN > M,, = 170.02 kNm
Maka dihitung sebagai tulangan tunggal

Mn 170022222

Rn'= s — 147
"= .dZ ~ 200 x 537.52
Nl bl 398
M 8 Xfc 0BBXZ5 L1092

1 2Zm X Rn
Pperiw = —{ 1 U7y

[ Grav(e] Qranighs Grdit dapgsl
Pperiv = 7535 390 o4

Pmin < pperlu < pperlu
Maka, dlpakal pperlu: 0002
ASperiy = p-b.d = 0.004 X 400 X 537.5 = 860 mm?

1
AS1 tuiangan = ZnDZ = 0.25 x w X 19% = 283.39 mm?

Asperlu % 1075

Meutangan = Asl tulangan - 283.53
Dipakai 3919 (As = 850.17 mn?)

=295=3
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bw - 2tselimut - 2®sengkang - thul.utama

y n—1
400 —2 x40 —2x 10 —3 x 19
e ¥ 32/q

=121.5mm

__Asfy _ 85015x39 ___
T 085.fc.h 085x25%x400

OMn = 9As. £y (d - %)

S5
@PMn = 0.9 x 850.17 x 390 (537.5 — —)

2
= 155470000 Nmm
¢Mn = 155470000 Nmm > Mu = 133000000 Nmm (OK)

Kontrol Spasi Tulangan:

S >25mm (SNI-2847-2013 Pasdl 7.6.2)
S < (3h=360 mm) (SNI-2847-2013 Pasdl 7.6.5)
S <450 mm (SNI-2847-2013 Pasal 7.6.5)

121.5 mm > 25 mm (OK)
121.5 mm < 360 mm (OK)
121.5 mm < 450 mm (OK)

Maka, dipakai tulangan utama 3¢19

Kontrol Retak
280 280
S 380( ) —2.5C, <300(—)
fs fs

2 2
fS:§fy=§x390=260Mpa

C. = Jarak terkecil dari permukaan tulangan ke muka tarik
C. =50mm
280
s =380

ﬁ)—2.5 X 50 < 300 x (@)

260
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s = 284.23 mm < 323.08 mm (OK).

40U

.o o

100
Gambar 7.5 Penulangan Balok Primer B1 As 3 ; B-C Setelah Komposit

Desain Tulangan Torsi
Contoh perhitungan diambil dari frame balok yang sama
yaitu pada balok primer B1 As 3 ; B-C. dari hasil analisis
program bantu didapatkan momen torsi terbesar yaitu :
Tu=29.6 kNm

Berdasarkan SNI-2847-2013 pasal 11.5.1 untuk
struktur non prategang bila momen torsi lebih besar dari
kemampuan penampang memikul beban tors maka
pendetailan terhadap penulangan torsi harus dilakukan.
Kemampuan penampang dalam statis tak tentu dimana
redistribusi momen ditentukan dengan perumusan pada SNI-
2847-2013 pasal 11.5.2.4 (a) sebagaimana diperlihatkan
pada penyelesaian berikut :

AZ
T, = $0.331,/f, (P—C”>
cp

Acp = by, X b =400 x 600 = 240000 mm?
P, = 2(by, + h) = 2(400 + 600) = 2000 mm
A =1 (untuk beton normal)
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®=0.75

T. = 0.75 x 0.33 X 1@( =5

= 35640000 Nmm = 35.64 kNm

2400002>

- T, =29.6 kNm < T, = 35.64 kNm
Maka, Tulangan torsi tidak diperlukan

7.2.3 Penulangan Geser Balok Primer BLAs3; B-C

Dipakai tulangan Sengkang 2 kaki diameter 10 mm
Perhitungan Tulangan Geser Setelah Komposit
V;, = 140 kN

Berdasarkan (SNI-2847-2013: Ps 11.2.1.1) kemampuan beton
untuk menahan gaya geser ditentukan dengan perumusan
berikut:
V., =017 A{/f./b,d
V. = 0.17 x 1.0 x V25 x 400 x 540.5 = 183770 N

= 183.77 kN

Jarak Antar Tulangan Geser
_ Ay@fyd  157.08 X 0.75 X 390 X 540.5

V, — @V, (140 — 0.75 x 183.77) x 103

= 11430 mm

Berdasarkan SNI-2847-2013 Ps 11.4.5 jarak tulangan geser
maksimum untuk struktur yang tidak direncanakan untuk
menahan beban gempa harus tidak |ebih dari :

d 5405

3 @K 270.25 mm

2
Maka digunakan s = 250 mm
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V, = 140 kN > 0.5¢V, = 68.91 kN
Maka,

b,, s 400 x 250
Ay min = 0.062 fc’fL = 0.062 X V25 x e
yt

= 129.17 mm?
A, =157.08 > Ay min = 129.17 ... (0K)

Gaya geser perlawanan sengkang
oV DAy fyed  0.75 x 157.08 x 240 X 540.5
250 sSQLE 250
=61.23 kN
OV, +V.) = 61.23 + 0.75 x 183.77 = 199 kN
OV, +V.) = 199 kN >V, = 140 kN
= (Ok, Memenuhi)

= 61229 N

Dipasang sengkang daerah tumpuan @10—250 mm sepanjang
2h=2%500=1000 mm
Dipasang sengkang daerah lapangan $10—250 mm

7.2.4 Penyaluran Tulangan Momen Negatif Balok Primer B1

As3; B-C

Berdasarkan SNI-2847-2013 Pasal 12.12 paling
sedikit sepertiga tulangan tarik total yang dipasang untuk
momen negatif pada tumpuan harus mempunyal panjang
penanaman melewati titik belok tidak kurang dari d, 12db,
atau Ln/12, yang mana yang lebih besar.
d = 540.5 mm
12d, =12 x 19 = 228 mm
L,/16 = 680/16 = 42.5 mm
Maka, dipakai panjang penanaman sepanjang d = 540.5
mm
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7.2.5 Pengangkatan Elemen Balok Primer B1As3; B-C
Berat Balok Pracetak = 0.4x0.48x7.8x24=33.18 kN
Qu=1.2x1.2x33.18 = 47.78 kN
Dengan menggunakan 2 tulangan angkat, maka
Qu/2 = 23.89 kN
Gaya angkat setiap tulangan

=% _ 2899 _ 3379 kN

U ™ sin45  sin4as

Menghitung tulangan angkat
Berdasarkan PBBI pasal 2.2.2 tegangan ijin Tarik
dasar bgjatulangan adalah fy/1.5.

390
Oijin = E = 260 Mpa

Py
Oijin X1

33.79 x 103
otul.an‘gkat 2 W == 643 mm

Maka, digunakan tulangan angkat diameter 10 mm

thul.angkat =

Kontrol Tulangan Angkat
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X =

W 4Y. )
2<1+\/1+Yb(1+—Lth9
Maka,

W = 0.4 X 0.48 x 24 = 4.61 kN

(60 — 12)
Yo=Y, =——F——=24cm
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Y .=Y,+5=29cm
4 x29

14 omno o2 o
P 720 X tg45 o

29 4% 29
2<1+\/1+29<1+780xtg45))

X xL=0.235%x720=169.2cm

# 461 x 7.2% (1 i 4% 0.29 )
8 7.8 X tg45
=6.61 kNm
461><032><7.82
-M = = 6.59 kNm

=1 62/1\/E 0.62 x 1 x V25 = 3.1 Mpa

= gbh2 E X 400 x 480% = 15360000 mm?>

Momen Lapangan
_+M 6.6 X 10°

= 0.430 M
~ W, ~ 15360000 pe
f = 0430 Mpa < f. = 3.1 Mpa (OK)

Momen Tumpuan

_—M _659x10° 04260

~ W, T 12500000 .
f =0.428 Mpa < f, = 3.1 Mpa (0K)

7.3 Desain Kolom

Pada struktur bangunan Gedung Hotel Fave Surabaya
hanya terdapat satu macam jenis kolom dengan ukuran
60/60 cm. sebagai contoh perhitungan, akan didesain kolom
interior 60/60 cm yang terletak pada As B-3 seperti yang
diperlihatkan pada Gambar 7.7.
Data— Data Desain :
Tinggi kolom =48m
Dimens kolom =600 x 600 mm
Mutu Beton, (f<¢) =35MPa
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Mutu Baja, (fy) =390 MPa
Mutu Baja Sengkang =240 MPa
@ tul. Memanjang =D 25mm
@ tul. Sengkang =D 12mm

Gambar 7.7 Lokasi kolom yang akan dianalisis AS B-3

Tabel 7.2 Rekapitulisasi gaya dalam kolom AS B-3

No | Kombinasi Beban Aksial Momen (kNm) Geser (kN)
(kN) Sb-X Sb-Y Sb-X Sb-Y

1 1.4DL 6019.68| -23.259 0.373 0.27 -15.66
2 1.2DL+1.2LL+0.5Lr 6885.38| -27.836 0.353 0.28 -18.63
3 1.2 DL +LL + RSPX 5982.83| 55.169 1.113 6.11 9.58
4 1.2 DL +LL +RSPX 6450.94| -126.021 | -22.772 -5.58 -42.93
5 1.2 DL+ LL + RSPY 6133.41 48.098 5.3 19.22 -9.01
6 1.2 DL+ LL + RSPY 6300.35| -54.403 | -74.624 -18.7 -24.34
7 0.9 DL + RSPX 3625.05| 37.314 1.377 6.02 16.19
8 0.9 DL £ RSPX 4082.48| -116.099 | -22.872 -5.67 -36.32
9 0.9 DL = RSPY 3775.63| 30.242 5.565 19.13 -2.4
10 0.9 DL £ RSPY 3931.89| -44.481 | -74.725 -18.78 -17.73
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Rekap gaya dalam kolom yang terdapat pada Tabel 7.3 akan
menjadi data beban yang dimasukan pada program bantu analisis
kolom.

Kolom As B-3 direncanakan menggunakan tulangan baja
sebesar 16-D25 seperti terlihat pada Gambar 7.8.

16D25 3

Gambar 7.8 Penampang Kolom ASB-3

Hasil yang telah dilakukan dari program analisis kolom
diperlihatkan pada P-M diagram seperti terlihat pada Gambar 7.9.

=pColin - Colurdf{ Btabs 4.cal, 8

EEERILEEEL [ EFEISETE T -
oo

F (i
Pros__ S0y fFead

Sebagaimana yang tel ah diperlihatkan pada Gambar 7.9,
dengan rasio tulangan sebesar 2.27% yaitu 16-D25 penampang



202

telah mampu memikul kombinasi beban pada kedua sumbunya.
Hal tesebut diperlihatkan dengan kordinat yang berasal dari
kombinasi beban yang dipikul oleh kolom As B-3 sebagaimana
diperlihatkan pada Tabel 7.3.

Berdasarkan SNI-2847-2013 Pasal 10.9.1 batasan rasio
tulangan komponen struktur tekan tidak diijinkan kurang dari
1% dan tidak diijinkan melebihi 8 %, oleh karena itu
penampang yang memiliki rasio tulangan sebesar 2.27% telah
memenuhi ketentuan.

Desain Penulangan Geser Kolom AS B-3
Data Perencanaan :

Tinggi kolom = 3200 mm

Dimensi kolom = 600 x 600 mm

Mutu Beton, (f¢) = 35 MPa

Mutu Baja, (fy) =390 MPa

Mutu Baja Sengkang (fyv)= 240 MPa

@ tul. Memanjang = D 25 mm

@ tul. Sengkang = D 12 mm

M enentukan beban geser rencana kolom

Gaya geser pada kolom pada sistem rangka gedung
ditunjukan sebagai berikut :
Vu=50.71 kN
Desain penulangan geser kolom AsB-3
¢ Direncakan menggunakan tulangan sengkang 2 kaki @12
(Asv=226.2 mmz)
Berdasarkan SNI -2847-2013 Pasal 11.2.1.2 penentuan kekuatan
geser beton yang terbebani aksial tekan ditentukan dengan
perumusan berikut :
Ay =600 % 600 = 360000 mm?

25
d=600—40—12—7=535.2m’m
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Ry
V. =017(1+ MNfibyd

144,
6141510

= 0. e X X t

017<1_F14><360000>1V35 600 x 535

=716908 N = 716.91 kN

V.=V,

0.75x 716908 = 537.68 kN = 50.71 kN

= (Oke, Memenunhi).

Maka, sengkang cukup dipasang praktis dengan jarak sebesar :

d €535 ) _
s = I MAVe 267.75 mm - dipakai s = 250 mm

Maka, digunakan sengkang sejarak 250 mm disepanjang bentang
kolom.

Panjang L ewatan K olom

Sesuai dengan SNI-2847-2013 Pasal 12.2.3 sambungan
lewatan tulangan @25 mm dari kolom tengah ditentukan dengan
persamaan berikut :

B fy Ve Ws
la = TG, T ko |
LIAF! <%)
b

Parameter diatas didefinisikan dengan baik pada pasal 12.2.4 pada
SNI-2847-2013, dimana:

fy =390 MPa

Y: =1 (dtuas lainnya)

Ye =1 (tulangan tanpa pelapis)

Ys 1 (tulangan lebih besar dari D-22)

A =1 (Beton Normal) f¢'=35 MPa db=25 mm

C adalah nila terkecil dari parameter dibawah ini:
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25
c=40+12+7=64.5mm
500 —2(40+12)— 25 x4

dl= T=d =96 mm
Maka, ¢, = cpin = 64.5 mm Sehingga,
64.54+0

= 2.58 = 2.5 mm (nilai maksimum 2.5)
Maka, diambil 2.5
390 1x1x1

= 25 =564 mm = 565 mm
¢ \11x1v35 (64-§5+ 0)

Sesuai SNI-2847-2013 Pasal 12.15, sambungan |lewatan
harus diletakan ditengah panjang kolom dan harus dihitung
sebaga sambungan tarik. Karena seluruh tulangan pada
panjang lewatan disambung, maka sambungan lewatan
termasuk kelas B. Sehingga panjang lewatan kolom setelah
dikalikan faktor sebesar 1.3 untuk sambungan kelas B adalah :
1.31d=1.3X565=734.5 mm = 750 mm
Detail penulangan kolom As B-3 diperlihatkan pada Gambar
7.10.
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Gambar 7.10 Penulangan Kolom As B-3

7.4 Desain Dinding Geser
Struktur Gedung Hotel Fave Surabay akan yang didesain
dengan kategori seismik D dengan konfigurasi struktur didesain
dengan sistem rangka gedung dimana dinding geser harus mampu
memikul seluruh beban lateral dan rangka hanya memikul beban
gravitasi ditambah gaya akibat deformasi latera dinding geser.
Dinding geser yang terdapat pada strukur ini merupakan
struktur dinding geser khusus dengan denah dinding
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diperlihatkan pada Gambar 7.11. Secara keseluruhan terdapat
dua tipe dinding geser, oleh karena itu akan dianlisis tipe
dinding geser tersebut berdasarkan gaya dalam yang paling
menentukan diantara masing-masing dinding geser tersebut.

%”///////‘5? . T
= N RN RN
[l ‘
—
|
po s py
] I

Gambar 7.11 Lokasi Dinding Geser SW3

7.4.1 Desain Dinding Geser SW3
Data— Data Desain :

Tinggi Dinding, (hw) = 41600 mm

Tebal Dinding, (h) =400 mm

Panjang Dinding, (Iw) = 2400 mm

Mutu Beton, (f¢) =35 MPa

Mutu Baja, (fy) = 390 MPa

Mutu Baja Sengkang = 240 MPa

@ tulangan Vertikal =D 25 mm (Ulir)

@ tulangan Horisontal =2D 19 mm (Ulir) A=1(beton
normal)

Analisis Desain Dinding Geser Khusus
Gaya dalam yang bekerja pada dinding diperlihatkan
pada Tabel 7.4. Gaya ddam tersebut didapatkan dari program
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bantu analisis struktur. Anaisis desain dinding geser mengacu
pada SNI-1726-2012 Pasal 21.9.

Tabel 7.3 Rekapitulisasi Gaya Dalam Dinding Geser SW3
Aksial Momen (kNm) Geser (kN)
(kN) Sh-X Sh-Y Sb-X Sb-Y

No Kombinasi Beban

1 1.2 DL+ LL + RSPX 4927.22| 7028.658| 6918.517 613.19 382.94
2 1.2 DL + LL + RSPX 7215.67| -7743.01| -7441.27| -641.57| -356.77
3 1.2 DL+ LL + RSPY 5258.04| 14458.17| 4582.123 220.07 991.4
4 1.2DL +LL+RSPY 6884.85| -15172.5| -5104.87| -248.44 -965.22
5 0.9 DL + RSPX 3172.88| 7148.016| 7007.557 618.29 377.97
6 0.9 DL + RSPX 5461.34| -7623.65| -7352.23| -636.47| -361.73
7 0.9 DL + RSPY 3503.71| 14577.53| 4671.164 225.17 986.43
8 0.9 DL + RSPY 5130.51] -15053.2] -5015.83| -243.34| -970.19

Penampang dinding geser siku diperlihatkan pada
Gambar 7.12.

Gambar 7.12 Penampang Dinding Geser SWF
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Desain Penulangan Dinding Geser SW3
Berdasarkan Tabel 7.4 didapatkan gaya dalam terbesar

yaitu :
Vu=991.4 kN=991400 N
Pu=7215.67 kN=7215670 N
Mu=15172.5 kNm=15172.5 X106 Nmm

Berdasarkan SNI-2847-2013 Pasal 21.9.2.2 dua tirai
tulangan harus digunakan bila:
V, = 01704/ f!
Ay, =1, X h = 6750 x 400 = 27 X 10°> mm?
V, = 0.17 X 2700000V35 = 2715481 N
V, =991.4 kN < 01714,/ f, = 2715.48 kN
Maka, penampang didisain dengan satu tirai tulangan.

M enentukan kuat geser beton (V¢) sesuai SNI-2847-2013
Pasal 11.9.6, dimana V¢ diambil yang lebih kecil diantara
persamaan berikut :
d=08x1, —08><6750:5400mm

= 0.27A/f/hd + -

= 0.27 X 1V/35 X 400 x 5400 + 7E155/Q52500
Sl 4 x 6750

= 4893392 N = 4893.39 kN .. s ... @PTRCL)

Ly (012 fc’+0-21P—”h)
V. = 0.050/F + T | hd
u W

v, 2

7215670
67 0\(8,1.¢ 14358\, 2/ AT
- (0.05 x 1v35 + ( 6750 x 400)) 400 X 5400

151725 x 106 _ 6750
991400 2

= (0.296 + 0.6372)400 x 5400 = 2015712 N ......... 2)
Maka, V=2015.71 kN
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®V. 0.55x 2015712

= 554321 kN <V, = 554.32 kN

2

Maka, Berdasarkan SNI-2847-2013 Pasal 11.9.8 desan
tulangan geser horisontal dinding harus sesuai dengan SNI-
2847-2013 Pasal 11.9.9.

Berdasarkan SNI-2847-2013 Pasal 11.9.9.3 spas
tulangan geser horizontal tidak boleh melebihi dari poin berikut
ini:

lﬂ - 6750

L] S = T = 1350 mm
e 3h=3%X400=1200mm
e 450mm

Direncanakan menggunakan tulangan horizontal (transversal)
1D19 dengan jarak 200 mm
1
Ay = anﬁt xn=1x_mx 192 = 283.53 mm?
. Ayefyd  283.53 x 390 x 5400

3 s 200
= 2985.57 kN

= 2985571 N

Kontrol Rasio Tulangan Geser Transversal dan
L ongitudinal

h 43.2

w
Mo T =642
l, 6750

Berdasarkan SNI-2847-2013 Pasal 21.9.4.3 maka rasio
tulangan vertikal atau longitudinal, (p1) tidak perlu kurang dari
rasio tulangan horizontal atau transversal, (pt).

e Rasio Tulangan Geser Transversal (pt).
Berdasarkan SNI-2847-2013 rasio tulangan geser
transversal tidak boleh kurang dari 0.0025.
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Ayt 283.53
hxs  400X200

p; = = 0.0036

Maka, rasio tulangan geser transversal sebesar D19
dengan jarak 200 mm telah memenuhi ketentuan

¢ Rasio Tulangan Geser longitudinal (pu).

Berdasarkan SNI-2847-2013 rasio tulangan vertikal tidak
boleh kurang dari 0.0025.
Direncanakan menggunakan tulangan horizontal
(transversal) dengan sebesar D25 dengan jarak 100 mm
1 1
A, S angl X=X 252 = 490.87 mm?
Ay 49087
~ hXxs 400x 100

Py = 0.0123 = 0.0025

Maka, rasio tulangan geser longitudina sebesar D25
dengan jarak 100 mm telah memenuhi ketentuan.

K emampuan Nominal Geser Penampang

V, =V +V,) =2968.44 + 3649 = 6617.44 kN

Berdasarkan SNI-2847-2013 Pasal 21.9.4.1 Vn tidak
boleh melebihi kemampuan nominal geser penampang yang
ditentukan dengan perumsan berikut :

Karenafll—w > 2, makaa, = 0.17

Vo =A4A¢ (OCC A\/ﬁ + plfy)
=330 x 10*(0.17 x 1v35 + 0.0036 x 390)

= 7952121 N = 7952.12 kN
Maka, V, = 7952.12 kN
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Kontrol Kemampuan Nominal Geser Penampang
oV, =V,
0.55 x 7952.12 > 1282.5
4373.67 = 1282.5
Oke, penampang mampu memikul beban geser yang ada.

Desain Elemen Batas
Berdasarkan SNI-2847-2013 Pasal 21.9.6.2 daerah tekan
harus diperkuat dengan elemen pembatas khusus bila :

w
€ = 6003, /)
dimana, ¢ dalam persamaan tersebut berkaitan dengan sumbu
netral terbesar yang dihitung untuk gaya aksial terfaktor dan
kekuatan momen nominal yang konsisten dengan perpindahan
desain (6u). Rasio 6u/hw pada persamaan tersebut tidak boleh
diambil kurang dari 0.007.

Nilai 6 adalah nilai simpangan terbesar pada salah satu arah.
Dengan menggunakan program analisis struktur didapatkan nilai
simpangan terbesar tersebut seperti yang ditunjukan pada Gambar
7.13.
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Gambar 7.13 Smpangan arah Y terbesar pada dinding

Berdasarkan Gambar 7.13 didapatkan simpangan éu
arah X terbesar, yaitu 61.36 mm.

Su _ 6136 _ 10014 < 0.007
hy 43200

Maka, }f—u diambil sebesar 0.007

Nilai ¢ didapatkan dengan program bantu dengan gaya dalam
pada Tabel 7.4 diambil berdasarkan gaya aksial dan lentur
terbesar sesuai dengan arah yang dinjau. Hal tersebut
diperlihatkan pada Gambar 7.14
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200 % ABS0

Pt

Gambar 7.14 Pemodelan dinding SWF

6750
¢ > g1
600(0.007)

=1607mm = ¢ =365mm

i — S
M v
P Pt
-
and Moments with Corresponding Capacities:
Bu M My nx fMny  fMn/Mu NA depth Dt depth  eps t  Phi
¥o kN KNm kNm XNm XNm .3 mm
1 2927.22 702868 €918.52 8719.98 8563.33  1.2a81 207 2663 0.03718 0.900
z 721567 -7743.01  -7441.27 -20720.21 -19912.77  2.&76 534 4318 0.02212 0.500
3 5253_08 14458 20 4582.12  25263.46 8006.5¢  1.7a7 3091 002151 0.300
2 €884.85  -15172.50  -5104.87 -21075.32  -7080.81  1.389 3952 0.03284 0.900
B 5461_3¢  -7623.65  -7352.23 -18840.86 -18170.09  Z.471 3 4766 0.02562 0.900
€ 3503.71 1457750 467116  22253.83 7130 94 1.527 358 3062 0.02439 0.900
7 5130_51 -15053.20  -5015 83 -13067.60  -6353 .46  1.267 331 3953 0.03661 0.500
8 3172.88 7148.02 7007.58 7699.68 7548.38  1.077 198 2671 0.03931 0.500

dengan program bantu

Sehingga, dinding struktur tidak harus diberi elemen batas.

7.4.1 Desain Dinding Geser SW2

D ‘ B " "
|
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1
|
ﬂ\NSSESER
%
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& g

Gambar 7.15 Lokasi dinding geser SW2



214

Data— Data Desain :
Tinggi Dinding, (hw)
Teba Dinding, (h)
Panjang Dinding, (Iw)
Mutu Beton, (f¢)
Mutu Baja, (fy)
Mutu Baja Sengkang
@ tulangan Vertikal

@ tulangan Horisontal
normal)

Analisis Desain Dinding Geser K husus

= 41600 mm

=400 mm

= 2400 mm
=35 MPa

=390 MPa
= 240 MPa
=D 25 mm (Ulir)
=2D 19 mm (Ulir) A=1(beton

Gaya dalam yang bekerja pada dinding diperlihatkan
pada Tabel 7.4. Gaya dalam tersebut didapatkan dari program
bantu anaisis struktur. Analisis desain dinding geser mengacu
pada SNI-1726-2012 Pasal 21.9.

Tabel 7.4 Rekapitulisasi Gaya Dalam Dinding Geser SW3

No Kombinasi Beban Aksial Momen (kNm) Geser (kN)
(kN) Sb-X Sb-Y Sb-X Sb-Y
1 1.4DL 4085.28| 114.059 19.57 11.96 17.34
2 1.2DL+1.2LL+0.5Lr 4075.04| 117.793 21.687 13.38 18.51
3 1.2 DL+ LL £ RSPX 1645.54| 3676.167 32.637 15.2 597.93
4 1.2DL+LL+RSPX 6074.52| -3455.6 7.053 9.21| -563.65
5 1.2DL+LL +RSPY 2891.46 1151.661 61.337 21.86 186.87
6 1.2 DL+LL +RSPY 4828.6| -931.096 -21.647 2.55[ -152.59
7 0.9 DL £ RSPX 411.77| 3639.208 25.373 10.69 591.94
8 0.9 DL £ RSPX 4840.74| -3492.56 -0.211 47| -569.64
9 0.9 DL £ RSPY 1657.68| 1114.702 54.073 17.35 180.88
10 0.9 DL £ RSPY 3594.82( -968.055( -28.911 -1.96| -158.58

Penampang dinding geser siku
Gambar 7.12.

diperlihatkan pada
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Gambar 7.16 Penampang Dinding Geser SWF

Desain Penulangan Dinding Geser SW3

Berdasarkan Tabel 7.4 didapatkan gaya dalam terbesar
yaitu :
Vu=563.65 kN=991400 N
Pu=6074.52 kN=7215670 N
Mu=3455.6 kNm=3455.6 X106 Nmm

Berdasarkan SNI-2847-2013 Pasal 21.9.2.2 dua tira

tulangan harus digunakan bila:
V, = 0.17A A/ f/
Agy =1, X h = 2850 x 400 = 11.4 x 10° mm?
V, = 0.17 x 114000035 = 1820969 N

V;, = 563.65 kN < 0.171A.,+/ f; = 1820 kN

Maka, penampang didisain dengan satu tirai tulangan.
Menentukan kuat geser beton (V<) sesuai SNI-2847-2013

Pasal 11.9.6, dimana V¢ diambil yang lebih kecil diantara

persamaan berikut :

d=08x1, —08><2850=2280mm

= 0.274/f/hd + L
6074520 x 2280

=0.27 X 1x/£x 400 x 2280 + 125555
= 2671679 N = 2671.8 kN ... ce. v s eee e one (1)
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n P
Ly (042 + o.zlw—uh)
My il b5
Vi, QA

- 2850 (0.1 x 135 + 02 %)
— | 0.05 x 1v35 + Bcs < 971 400 x 2280

563 2

hd

V.= 0.05A/F +

= (0.297)400 x 2280 = 270864 N ......... (2)
Maka, V.= 270.86 kN
@V, 0.55 x 270864
) =—————="74488 kN <V, = 7449 kN
Maka, Berdasarkan SNI-2847-2013 Pasa 11.9.8 desan
tulangan geser horisontal dinding harus sesuai dengan SNI-
2847-2013 Pasal 11.9.9.

Berdasarkan SNI-2847-2013 Pasal 11.99.3 spas
tulangan geser horizontal tidak boleh melebihi dari poin berikut

ini:

o l?w=285ﬂ=570mm
e 3h=3x%x400=1200mm
450 mm

Direncanakan menggunakan tulangan horizontal (transversal)
1D19 dengan jarak 200 mm
1
Ay = anﬁt xn=1Xx 77X 192 = 283.53 mm?
oAl Ayefyd  283.53 x 390 X 5400

1 s 200
= 2985.57 kN

= 2985571 N
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Kontrol Rasio Tulangan Geser Transversal dan
L ongitudinal
h 43.2

w
e = 15162
l, 2.850 z

Berdasarkan SNI-2847-2013 Pasal 21.9.4.3 maka rasio
tulangan vertikal atau longitudinal, (p1) tidak perlu kurang dari
rasio tulangan horizontal atau transversal, (pt).

o Rasio Tulangan Geser Transversal (pt).
Berdasarkan SNI-2847-2013 rasio tulangan geser
transversal tidak boleh kurang dari 0.0025.

Ay 28353
Pt = 7xs — 200x200

= 0.0035

Maka, rasio tulangan geser transversal sebesar D19
dengan jarak 200 mm telah memenuhi ketentuan

e Rasio Tulangan Geser longitudina (pu).
Berdasarkan SNI-2847-2013 rasio tulangan vertikal tidak
boleh kurang dari 0.0025.
Direncanakan menggunakan tulangan horizontal
(transversal) dengan sebesar D25 dengan jarak 100 mm

L 1 2 2
Ay =anvl xn=znx25 = 490.87 mm
Ay 490.87

24 - = 0.0123 > 0.0025
hxs 400x 100 Sy

P

Maka, rasio tulangan geser longitudina sebesar D25
dengan jarak 100 mm telah memenuhi ketentuan.
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Kemampuan Nominal Geser Penampang

V, =, +V,) =2968.44 + 3649 = 6617.44 kN

Berdasarkan SNI-2847-2013 Pasal 21.9.4.1 Va tidak
boleh melebihi kemampuan nominal geser penampang yang
ditentukan dengan perumsan berikut :

Karena?—W > 2, makaa, = 0.17

w

Vh =4 (OCC A\/ﬁ W plfy)
=330 x 10*(0.17 x 1v35 + 0.0036 x 390)

= 7952121 N = 7952.12 kN
Maka, 1, = 7952.12 kN

Kontrol Kemampuan Nominal Geser Penampang
oV, =V,
0.55 X 7952.12 > 1282.5
4373.67 = 1282.5
Oke, penampang mampu memikul beban geser yang ada.

Desain Elemen Batas

Berdasarkan SNI-2847-2013 Pasal 21.9.6.2 daerah tekan

harus diperkuat dengan elemen pembatas khusus bila:
Ly
O

600(8,/hy)
dimana, ¢ dalam persamaan tersebut berkaitan dengan sumbu
netral terbesar yang dihitung untuk gaya aksia terfaktor dan
kekuatan momen nominal yang konsisten dengan perpindahan
desain (6u). Rasio du/hw pada persamaan tersebut tidak boleh
diambil kurang dari 0.007.

Nilal éuadalah nilai simpangan terbesar pada salah satu arah.
Dengan menggunakan program analisis struktur didapatkan nilai
simpangan terbesar tersebut seperti yang ditunjukan pada Gambar
7.13.
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% ¥ z \ £
s 76581021  70.242567  -5.760531
0.002325 0.000558  -0.000079 '

.
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s
i gl
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Gambar 7.17 Smpangan arah Y terbesar pada dinding

i
:
i

Berdasarkan Gambar 7.13 didapatkan simpangan du
arah X terbesar, yaitu 61.36 mm.

Su _ 7658 _ (10018 < 0.007
hy 43200

Maka, :—u diambil sebesar 0.007

Nilal c didapatkan dengan program bantu dengan gaya dalam
pada Tabel 7.4 diambil berdasarkan gaya aksial dan lentur
terbesar sesuai dengan arah yang dinjau. Hal tersebut
diperlinatkan pada Gambar 7.14
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T
MR

REINFORLEMENT g e T S ]
[y y——— PSEIN Mo e G S
Factored Loads and Moments with Corresponding Capacities:
ou M Muy £Mnx fMoy  £Mn/Mu NA depth Dt depth  eps_t Phi
Fa. KN KNm Kim KNm kNm m mm

1 1383.23 7.55 3783.62 13.63 §465.47 ol 722 0.00378
H 5315.15 -16.88 -3555.57 -48.86  -10420.20 z_330 0.00543
3 2680.03 3s5.33 1165.72 246.53 812283 6.368 0.01148
1 460728 -84.10 -383.07 -372.23  -8173.62 8.441 428 1146 D0.00503
B 195 38 5.239 3717_91 1288 518352 1.388 EES 1668 0.01109
3 4746.30 -15.34 -3592.68 -40.72 . -9537.72 2.855 630 1348 0.00626 0.300
¥ 1507.24 36.72 1130.01 225.43 §935.20 6.141 502 2715 0.01324 0.300
B 3334.4¢ -42.77 -1004.78 -316.77  -7441.77 7.408 EEL] 1151 0.00581 0.300

4%% End of output ***

Gambar 7.18 Pemodelan dinding SW2 dengan program bantu

2850

piel  myPANE S
€ =500(0.007)
Sehingga, dinding struktur harus diberi elemen batas.

=67857mm < c=716mm
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BAB VIII
DESAIN PONDASI

8.1 Desain Pondasi

Menurut Pedoman Perancangan Ketahanan Gempa untuk
Rumah dan Gedung 1987 pasal 2.2.8, umtuk pondasi setempat dari
suatu gedung harus saling berhubungan dalam 2 arah ( umumnya
saling tegak lurus) oleh unsur penghubung yang direncanakan
terhadap gaya aksia tarik dan tekan sebesar 10% dari beban
vertikal maksimum.

Daam perancangan sloof ini diambil contoh perhitungan
pada sloof kolom interior :
Data Perencanaan

o Gayaaksia kolom = 6885.38 kN
e P,=10% x 721.13 kN =6885 kN - 688538N
e Dimensi sloof = 450700 mm
o Panjang doof =QL:2 m
e Mutu beton (f) =25 MPa
o Diameter Tul. Utama (@) = 19 mm
o MutuBga(f,) = 390 MPa
o Eladtisitas(E;) =200000 MPa
e Selimut beton =50 mm

Tegangan ijin tarik beton :
fijin = 0.7 X {/f{ = 0.7 X V25 = 3.5 MPa
Tegangan tarik yang terjadi :

2 688538

Jr = obh = 08 x 450 X 700

= 2.86 MPa < frijin - OK

Berdasarkan SNI-2847-2013 Pasal 21.12.3.2 Balok sloof
yang didesain sebagai pengikat horizontal antar poer harus
diporoposikan sedemikian hingga dimensi penampang terkecil
harus sama dengan atau lebih besar jarak antar kolom yang
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disambung dibagi dengan 20, tetapi tidak perlu lebih besar dari 450

Direncanakan dimensi sloof terkecil adalah 450 mm, makadimensi
tersebut telah memenuhi kriteria pendesainan.

Penulangan doof didasarkan pada kondis pembebanan
dimana beban yang diterima adalah beban aksial dan lentur
sehingga perilaku penampang hampir mirip dengan perilaku
kolom, oleh karena itu tulangan yang akan digunakan adalah
tulangan konfensional yaitu tulangan baja.

Beban yang diterima Sl oof
e Berat Sendiri = 0.45x% 0.7 x24 =756 kN/m
e Beratdinding = 25 x 3.2 =80 kN/m
qq = 87.56 kN/m

Konstruksi doof merupakan balok menerus sehingga pada
perhitungan momen digunakan momen koefisien. Besarnya
koefisien momen tersebut ditentukan pada SNI-2847-2013 Pasal
8.3.3, sebagaimana diperlihatkan dengan analisis berikut ini:
qy =14q; =1.4%x756 =10.58 kN/m

1 1
M, = To X du X 1?2 = 0% 10.58 x 7.2%2 = 54.85 kNm

Untuk memudahkan desain penulangan lentur sloof
digunakan program bantu analisis dengan memasukan data beban
sebagai berikut :

M, = 54.85 kNm

P, = 721.13 kN

Direncanakan menggunakan tulangan 10D22

(Af = 3801.33 mm?)

Lalu dicek dengan diagram interaksil hasil program bantu seperti
pada Gambar 8.1.
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- Gaml:;ar “8.l-mDimagram Interaksi Soof

Dari diagram interaksi pada Gambar 8.1 didapatkan rasio tulangan
sebesar 1.23% (10D22) serta terlihat pula bahwa sloof mampu
memikul kombinasi momen dan aksial yang terjadi.

Jarak minimum yang disyaratkan antar dua tulangan
longitudinal adalah 25 mm. Besarnya jarak antara tulangan
longitudinal terpasang pada bal ok sloof tersebut adalah :

s b,, — 2 X Sellmurti : i@sengkang -n 5L
450—-2%x50—-2%x10—-6x19
N 6—1
Penulangan Geser Sloof
4 =%><qu><7.2 =—;—x10.58><7.2 =38.1kN

Berdasarkan SNI-2847-2013 Pasa 11.2.1.2 penentuan
kekuatan geser beton yang terbebani aksia tekan ditentukan
dengan perumusan berikut :

Ay = 450 x 700 = 315000 mm?

=432 =125

22
d=700—50—10—7=629mm



224

V.=017(1+ il M f!b,d
c — . 14Ag f;:W

10580
=0.17 (1 + m) 1v25 X 450 x 629

= 241744.83 N = 242 kN
@V, = 0.75 x 242 = 181.5KN = V,, = 38.88 kN
(Oke, Memenuhi)
Berdasarkan SNI-2847-2013 Pasal 21.12.3 jarak antara tulangan
transversal pada doof tidak boleh kurang dari berikut ini:
e d/2=629/2=3145mm = 315mm
e 300mm
Jadi dipasang sengkang 2910 — 300 mm di sepanjang sloof.

8.2 Desain Tiang Pancang

Pondas merupakan bangunan struktur bawah yang
berfungsi sebagai perantaradalam meneruskan beban bagian atas
dan gaya-gaya yang bekerja pada pondasi tersebut ke tanah
pendukung di bawahnya.

Perencanaan bangunan bawah atau pondasi suatu struktur
bangunan harus mempertimbangkan beberapa hal diantaranya
jenis, kondis dan struktur tanah. Hal ini terkait dengan
kemampuan atau daya dukung tanah dalam memikul beban yang
terjadi di atasnya. Perencanaan yang baik menghasilkan pondas
yang tidak hanya aman, namun juga efisien, ekonomis dan
memungkinkan pel aksanaannya.

8.3 Desain Tiang Pancang Kolom AsB-3

Desain tiang pancang kolom yang akan dianalisis
adalah pada kolom As B-3 sebagaimana ditunjukan pada
Gambar 8.2
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Gambar 8.2 Letak pondasi kolomyang dianalisis

Data Perencanaan

Data-data dalam perencanaan pondasi adalah :

e Kedalamantiangpancang =24m

e Diameter tiang pancang, d =50 cm

e Kadlilingtiang pancang(4s) =m X d X 40 =62.83m

Luastiang pancang (4,) = 1/4 X7 x d?

=2 X1 X 502 = 1963 5cm?
Direncanakan poer dengan dimens :

L=28m
B=28m
t=1m

Digunakan tiang pancang produksi WIKA kelasA1l. Dengan
tekanan ijin sebesar 185.3 Ton.

8.3.1 Beban Pada Tiang Pancang
Dari hasil analisis struktur didapatkan gaya-gaya dalam yang
bekerja pada pondasi seperti yang diperlihatkan pada Tabel 8.1.
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Tabel 8.1 Reaksi Kolom As B-3

L Gaya Dalam
Kombinasi
Fx (kN) [Fy (kN) |P (kN) Mx (kNm)  |My (kNm)
Beban Tetap
1D+1L 0.14 | -13.83 | 5447.99 38.25 -0.46
Beban Sementara
1D+1L+1RSPX -3.25 | -27.92 | 5560.89 -78.19 -13.00

Pada desain tiang pancang ini akan digunakan kombinasi
terbesar dari beban sementara dan beban tetap. Berdasarkan hal
tersebut maka digunakan kombinasi beban sementara sebagai
acuan gaya dalam untuk desain pondasi. Oleh karena itu, didapat
momen pada dasar poer, yaitu :

My, =My + E, Xt =7819+ 2792 %1 =106.11 kNm

Myo =M, +F Xt =13+325%x1 =16.25 kNm

Beban vertikal yang berkerjaakibat pengaruh beban sementara dan
beban sendiri poer sebagai berikut :

e Beban Sendiri Poer

2.8%x28x%x1X 24% = 18816 kN
e Beban Aksia Kolom
Beban Sementara, P =5561 kN

XP =5749 kN
Daya dukung ijin satu tiang pancang dianalisis berdasarkan
nilai N-SPT dari hasil SPT dengan menggunakan perumusan
WIKA. Dari data SPT dengan kedalaman 40 m sebagaimana
diperlihatkan pada Tabel 8.2.
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Tabel 8.2 Data N-SPT
KEDALAMAN
(m)

0
2.5
4.5
6.5
8.5
10.5
12.5
14.5
16.5
18.5
20.5
22.5

N-SPT

NS |wW|N(N[R R e e G s o

24.5 14
26.5 17
28.5 15
30.5 17
32.5 14
34.5 18
36.5 17
38.5 18
40.5 14

Berdasarkan Tabel 8.2 didapatkan nilai N-SPT didasar tiang,
(Np) pada kedalaman 40 m dan nilai rata-rata N sepanjang tiang
(Nav) sebagaimana diperlihatkan pada andisis dibawah ini :
N, =18

144+17+15+17+ 144+ 18
o= 3 = 15.83

Ny, diambil berdasarkan nilai 3 < N < 50

AN
Quit = 40A,N, + %

62.83 X 15.83
=40x0.196x18+f= 340 Ton
Qult
Q4 = SF > SF=2
340
= 10 =170Ton

Kekuatan bahan berdasarkan data tiang pancang milik
PT.WIKA BETON untuk diameter 50 cm (kelas A1) diperolen P =
185.3 Ton.
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Berdasarkan hasil analisis kekuatan bahan dan kekuatan
tanah diambil P terkecil, yaitu =170 Ton.

8.3.2 Tiang Pancang K elompok
Jumlah tiang pancang ditentukan dengan perumusan berikut:

P
n= g— — E diasumsikan sebesar 0.7
PE,
( V7R ) 2%y
W70 x O Y

Maka direncanakan dengan 5 pancang dengan |etak tiang pancang
pada poer diperlihatkan pada Gambar 8.3.

Syarat jarak antar tiang pancang () :
25D <S5, <5D—-S,=36D=36x%x05=18m
25D <S5, <5D > S, = 36D=36%x05=18m

Gambar 8.3 Posisi tiang pancang



229

Kontrol Beban Aksial Satu Tiang Pancang

Berdasarkan Gambar 8.3 didapatkan jarak masing-masing tiang
pancang terhadap titik berat poer, seperti yang diperlihatkan pada
Tabel 8.3

Tabel 8.3 Jarak Tiang Pancang Kolom

Tiapd Sumbu

X x2 Y y2
P1 0.9 0.81 0.9 0.81
P2 0.9 0.81 0.9 0.81
P3 0.9 0.81 0.9 0.81
P4 0.9 0.81 0.9 0.81
P5 0 0 0 0
> 3.24 3.24

Gaya yang dipikul oleh masing-masing tiang pancang ditentukan
dengan perumusan berikut :

ZP Mxoymax Myoxmax
Pp=—% 2 2
n Xy XX
B 5711 106.11x 0.9 16.25% 0.9
max =g+ 3.24 p UL
= 1176 kN = 117.6 Ton
5711 106.11% 0.9 16.25% 0.9

Finax = 5 3.24 3.24
= 1108 Ton = 110.8 Ton
Maka, tekanan maksimum satu tiang pancang adalah 115.88 Ton.

Menentukan Efisiensi Aktual
Efisens aktual ditentukan dengan menggunakan
perumusan dari Converce-Labarre sebagal berikut :
Jumlah baris, (m) =2
Jumlah kolom, (n)=2
Di[n—1)m+(m—1)n

Ex=1—tan" 1=
k a3 90. mn




230

0.5\ [(3—13+ (B -1)3
1 _ -1(_— =
=1-tan (1.9) 90 x 3 x 3 0.73
Kontrol Kapasitas

Pmax 4 pEk
117.6 Ton < 170 X 0.73
117.6 Ton < 124 Ton — (Oke, Memenuhi)

8.3.3 Kontrol Tebal Poer Kolom

Perencanaan teba poer harus memenuhi suatu ketentuan bahwa
kekuatan geser nominal harus lebih besar dari geser ponds yang
terjadi.

Data Perencanaan Poer :

Dimensi Kolom= 600 x 600 mm

[ ]

e Dimensi Poer =2800x 2800 x 1000 mm

e Selimut Beton =70mm

e @ Tulangan =25mm

e Mutu Beton, (f,) =25MPa

e Dimens tiang pancang = 500 mm

L) =1 (Beton Normal)

° g = 70 (Kolom Interior)

e Rasiosis panjang terhadap daerah reaksi, (B)
600

p = 500~ 1.0

25
d =1000-70 -5 = 917.5mm

Penampang kritis adalah pada daerah tiang pancang ujung oleh
karena itu, Keliling penampang kritis (b,) ditentukan dengan
perumusan dibawah :
Jarak dari tepi tiang yang dianalisis hingga ke tepi poer terdekat
adalah 250 mm
b, = 2n(Diameter tiang + 250)

= 2m(500 + 250) = 1500 mm
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Berdasarkan SNI-2847-2013, Pasal 11.11.2.1 untuk
pondasi tapak non-prategang, (V) ditentukan berdasarkan
nilai yang terkecil dari poin berikut :

a V,=017(1+ %),1 fib,d

2
V.= 0.17(1 +ﬁ)\/25 x 1500 x 917.5
= 3236800 = 3236.8 kN

b. V. = 0.083 (% + 2) A/ b,d

40 X 917.5
=0. (W R 2)\/2_5 X 1500 X 917.5

= 1622989 N = 1623 kN

c. V. =0.334/f/b,d
= 0.33V25 x 1500 x 917.5
= 2356200 N = 2356.2 kN

Dari ketiga nilai V. diatas diambil nilai terkecil, maka kapasitas
penampang dalam memikul geser adalah 1623 kN = 162.3 Ton
V. = P,Tiang

162.3Ton = 117.6 Ton — Oke, Memenuhi

Maka, hyper = 1000 mm telah memenuhi ketentuan.

8.3.4 Desain Penulangan Poer Kolom

Berdasarkan SNI 2847-2013 Pasal 7.12 Desain penulangan
poer ditentukan berdasarkan rasio tulangan susut atau minimum
karena poer diasumsikan hanya berfungsi sebagai penyalur beban

sga

Data Perencanaan :
e Dimens Poer, B X L = 2800 x 2800 mm
e Tebal Poer, = 1000 mm

e Mutu Beton, (f.) = 25 MPa
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e Mutu Beton, (f;) = 240 MPa
e Diameter Tul. Utama (@) = 25 mm
e Tebal Seimut Beton = 70 mm

e Tinggi efektif balok poer
dx = 1000 — 70 — 22—5 —917.5mm

Penulangan Poer
Berat Poer, g, = 1.1 X 1 X 24 = 26.4 kN/m = 2.64 Ton/m
Py = 2Pyqy = 2 X 175.3 = 350.6 Ton

1 2
Mu:(Ptxe)_(EXQue)

= (117.6 X 0.6) — (% X 2.64 X 1.12)
— 68.96 Tm = 689.6 kNm

N
I,

GO

NP

Gambar 8.4 Mekanika beban poer Kolom
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085X f/ X By 600

Po 600 + fy
0.85%25x0.85 600
Pr = 390 600+390 0.028

Pmax = 0.75p, = 0.75 X 0.028 = 0.021

Prmim = 0.0020
ppe Mu | 6896 109" "§ .
"= 0.85bd2  0.85 x 2800 X 917.52
AP AR 4|
SR TEC DBE R
1 2m x Rn

e ST AR T T L V)]

L\ _2X1835x035)\
PRl 778 3% 390 R

Pmin L pperlu

Maka, dipakai p,,in = 0.0020

ASperp, = p-b.d = 0.0020 x 1000 x 917.5
= 1835 mm?

1
AS) tuiangan = ZnDZ = 0.25 X X 252 = 490.63 mm?

ASperny 1835

f e CAST Sy gl
Dipakai 4¢25 (As=1962.5 mm?)

=374=4
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1000 1000
= =——=1333.333mm = 300 mm
n—-—1 4-1
Maka, digunakan tulangan @25 — 300

8.4 Desain Tiang Pancang Kolom AsA-3

Desain tiang pancang kolom yang akan dianalisis
adalah pada kolom As A-3 sebagaimana ditunjukan pada
Gambar 8.25

W L *

i ‘ ONDASI KOLO

Gambar 8.5 Letak pondasi kolomyang dianalisis

Data Perencanaan

Data-data dalam perencanaan pondasi adalah :

e Kedadamantiangpancang =40m

e Diameter tiang pancang, d =50 cm

o Kelilingtiang pancang(4;) =m X d X 40 =62.83m
o Luastiangpancang (4,) = 1/4Xxm x d*

= i X 1 X 502 = 1963.5¢m?

Direncanakan poer dengan dimensi :
L=25m

B=25m

t=1m
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Digunakan tiang pancang produksi WIKA kelasA1l. Dengan
tekanan ijin sebesar 185.3 Ton.

8.4.1 Beban Pada Tiang Pancang
Dari hasil analisis struktur didapatkan gaya-gaya dalam yang
bekerja pada pondasi seperti yang diperlihatkan pada Tabel 8.14.

Tabel 8.4 Reaksi Kolom As A-3

N Gaya Dalam
Kombinasi
Fx (kN) [Fy (kN) [P (kN) Mx (kNm) |My (kNm)
Beban Tetap
1D+1L -10.45 | 0.15 3331.95 28.87 -0.47
Beban Sementara
1D+1L+1RSPX -22.5 -3.1 3569 -69.76 -12.72

Pada desain tiang pancang ini akan digunakan kombinasi
terbesar dari beban sementara dan beban tetap. Berdasarkan hal
tersebut maka digunakan kombinasi beban sementara sebagai
acuan gaya dalam untuk desain pondasi. Oleh karena itu, didapat
momen pada dasar poer, yaitu :

Myo = My + F, X t =69.76 + 22.5 X 1 = 92.26 kNm

My, =My + F, xt=1272+31x1 =158 kNm

Beban vertikal yang berkerjaakibat pengaruh beban sementara dan
beban sendiri poer sebagai berikut :

e Beban Sendiri Poer

2.5x2.5x1><24% = 150 kN
e Beban Aksial Kolom
Beban Sementara, P =3569 kN

JP =3719 kN
Daya dukung ijin satu tiang pancang dianalisis berdasarkan
nilai N-SPT dari hasil SPT dengan menggunakan perumusan
WIKA. Dari data SPT dengan kedalaman 40 m sebagaimana
diperlihatkan pada Tabel 8.2.
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Tabel 8.5 Data N-SPT

KEDALAMAN

(m)
0

25
4.5
6.5
8.5
10.5
12.5
14.5
16.5
18.5
205
225
24.5 14
265 17
28.5 15
305 17
325 14
34.5 18
36.5 17
385 18
40.5 14

N-SPT

RN CSAESEESE o B o o el B (=)

Berdasarkan Tabel 8.25 didapatkan nilai N-SPT didasar
tiang, (Np) pada kedalaman 40 m dan nilai rata-rata N sepanjang
tiang (Nav) sebagaimana diperlihatkan pada anaisis dibawahini :

N, =18
14+17+15+17+ 14 + 18
Ny = c = 15.83
N, diambil berdasarkan nilai 3 < N < 50
AN,
Quit = 404N, + —=
62.83 x 15.83
=40x0.196 x 18 +f = 340 Ton
Qult
Qq=-"cp — SF =2
340
= T = 170 Ton

Kekuatan bahan berdasarkan data tiang pancang milik
PT.WIKA BETON untuk diameter 50 cm (kelas A1) diperolen P =
185.3 Ton.
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Berdasarkan hasil analisis kekuatan bahan dan kekuatan
tanah diambil P terkecil, yaitu =170 Ton.

8.4.2 Tiang Pancang Kelompok
Jumlah tiang pancang ditentukan dengan perumusan berikut:

Y P

n = =—— - E; diasumsikan sebesar 0.7
PE
)/ K10 ) Jy W)
T170x07 0 T

Maka direncanakan dengan 4 pancang dengan letak tiang pancang
pada poer diperlihatkan pada Gambar 8.36.

Syarat jarak antar tiang pancang (S) :
25D <S5, <5D—->S§,=36D=3%x05=15m
2.5D <5, <5D S, =36D=3%x05=15m

Gambar 8.6 Posisi tiang pancang

Kontrol Beban Aksial Satu Tiang Pancang

Berdasarkan Gambar 8.3 didapatkan jarak masing-masing tiang
pancang terhadap titik berat poer, seperti yang diperlihatkan pada
Tabel 8.3
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Tabel 8.6 Jarak Tiang Pancang Kolom

Tiang Sumbu

X x2 y y2
P1 0.75 | 0.5625 0.75 0.5625
P2 0.75 | 0.5625 0.75 0.5625
P3 0.75 | 0.5625 0.75 0.5625
P4 0.75 | 0.5625 0.75 0.5625
P5 0 0 0 0
S 2.25 2.25

Gaya yang dipikul oleh masing-masing tiang pancang ditentukan
dengan perumusan berikut :
a Z_P My Ymax Myoxmax
Il vl Y x?
3719 9226 x 0.75 15.82 % 0.75
Friax T R 2250 )T 225

= 965.8 kN = 96.58 Ton
3719 92.26x 0.75 15.82x0.75

Fnax = 4 2.25 2.25
= 893.73 Ton = 89.37 Ton
Maka, tekanan maksimum satu tiang pancang adalah 96.58 Ton.

Menentukan Efisiensi Aktual
Efisensi  aktual ditentukan dengan  menggunakan
perumusan dari Converce-Labarre sebagai berikut :
Jumlah baris, (m) =2
Jumlah kolom, (n)=2
D[(n=1)m+ (m—1)n

P;

Ce () r g S 90.m.n
05\[(2=1)2+ (2-1)2
i _ —1 =
sy 3 (19)[ 90 X 2 X 2 p

KontroI_Kapasitas
R~ PES
96.58 Ton <170 x 0.79
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96.58 Ton < 135 Ton — (Oke, Memenuhi)

8.4.3 Kontrol Tebal Poer Kolom

Perencanaan tebal poer harus memenuhi suatu ketentuan bahwa
kekuatan geser nominal harus lebih besar dari geser ponds yang
terjadi.

Data Perencanaan Poer :

e Dimensi Kolom= 600 x 600 mm

e Dimensi Poer = 2500 x 2500 x 1000 mm

e Selimut Beton =70 mm

e @ Tulangan =25mm

e Mutu Beton, (f,) =25 MPa

e Dimensi tiang pancang = 500 mm

o 1 =1 (Beton Normal)

o =70 (Kolom Interior)
e Rasiosis panjang terhadap daerah reaksi, (B)
%o

25
d =1000-70 T RS 917.5 mm

Penampang kritis adalah pada daerah tiang pancang ujung oleh
karena itu, Keliling penampang kritis (b,) ditentukan dengan
perumusan dibawah :
Jarak dari tepi tiang yang dianalisis hingga ke tepi poer terdekat
adalah 250 mm
b, = 2n(Diameter tiang + 250)

= 2m(500 + 250) = 1500 mm

Berdasarkan SNI-2847-2013, Pasal 11.11.2.1 untuk

pondas tapak non-prategang, (V) ditentukan berdasarkan
nilai yang terkecil dari poin berikut :

d V,=017(1+ %)/1 fib,d

2
V, = 0.17(1 +1—0)\/2_5 X 1500 x 917.5
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= 3236800 = 3236.8 kN

e V, = 0.083 (%2 +2) A/ bod
40 X 917.5
= 0. (WJ’ z)x/ﬁ x 1500 X 917.5

= 1622989 N = 1623 kN

f. V. =0.334/f/b,d
= 0.33v/25 x 1500 X 917.5
= 2356200 N = 2356.2 kN

Dari ketiga nilai V. diatas diambil nilai terkecil, maka kapasitas
penampang dalam memikul geser adalah 1623 kN = 162.3 Ton
V. = P,Tiang

162.3 Ton = 96.58 Ton — Oke, Memenuhi

Maka, hyper = 1000 mm telah memenuhi ketentuan.

8.4.4 Desain Penulangan Poer Kolom

Berdasarkan SNI 2847-2013 Pasal 7.12 Desain penulangan
poer ditentukan berdasarkan rasio tulangan susut atau minimum
karena poer diasumsikan hanya berfungsi sebagai penyalur beban

sgja

Data Perencanaan .

e Dimens Poer, B X L = 2500 x 2500 mm

e Teba Poer, = 1000 mm

e Mutu Beton, (f,) = 25 MPa

e Mutu Beton, ( fy) = 240 MPa

e Diameter Tul. Utama (@) = 25 mm
Tebal Selimut Beton = 70 mm

[ ]
e Tinggi efektif balok poer
dx = 1000 — 70 — 22—5 =917.5mm



8.4.5 Penulangan Poer
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Berat Poer, g, = 0.95 X 1 X 24 =22.8kN/m = 2.28 Ton/m

P, = 2P, = 2 X 96.58 = 193.16 Ton
1
M, = (Ptxe)_(ixquez)
= (193.16 x 0.45) — (% X 2.28 X 0.952)
= 85.89 Tm = 858.9 kNm

]
I

AT

&)
\
®

L)\

Gambar 8.7 Mekanika beban poer Kolom

0.85 X f. X B, 600
= X

Pb

fy 600 + fy
0.85%25x%0.85 600
Po = 390 600+390 0.028

Pmax = 0.75p, = 0.75 X 0.028 = 0.021

Pmin = 0.0020
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oo Mu__ 8589 106 .
"= 085pd2  0.85x 2500 91752
T AT CLT £

= B2 WBEAZSE

1 2m X Rn
Poerits T F R ) Vigs W

avanl AraiiL Srxkil Eavap] G

Pperiw = 75735 390 7

Pmin = pperlu

Maka, dipakai p,,;, = 0.0020

ASperiy = p-b.d = 0.0020 x 1000 x 917.5
= 1835 mm?

1
AS) tutangan = ZnD2 = 0.25 X ™ X 252 = 490.63 mm?

As 1835
perlu
- & =374~ 4
Wi Giaver). BIAYAR] T

Dipakai 4¢25 (As=1962.5 mm?)

1000 1000
= = ——=1333.333mm = 300 mm
n—1 4-1
Maka, digunakan tulangan @25 — 300

8.5 Desain Pondasi Dinding Geser (SW3)

Desain tiang pancang dinding geser yang akan dianalisis
adalah tipe SWE dan SWF sebagaimana ditunjukan pada Gambar
8.8
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Gambar 8.8 Letak pondasi dinding geser yang dianalisis

Data Perencanaan
Data-data dalam perencanaan pondasi adalah :
e Kedalamantiangpancang =40m
e Diameter tiang pancang =60cm
e Kadlilingtiang pancang(4s) =m X d X 40 =754 m
e Luastiang pancang (4,) 1/4 x 7 x d?
=2 X7 X 602 = 2827.43 cm?
Direncanakan poer dengan dimensi seperti yang ditunjukan pada
gambar 8.9
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Gambar 8.9 Desain poer SWF

8.5.1 Beban Pada Tiang Pancang

Dari hasil analisis struktur didapatkan gaya-gaya dalam
yang bekerja pada pondasi seperti yang diperlihatkan pada Tabel
8.7.
Tabel 8.7 Reaksi dinding geser SWF

P (kN) Fx (kN) Fy (kN) Mx (kNm)|My (kNm)
Beban Tetap -5046.03 85.00 -37.42| -516.89 -89.52
Beban Sementara | -5699.04 -475.74 -158.67| -8396.03| -2941.16

Pada desain tiang pancang ini akan digunakan kombinasi
terbesar dari beban sementara dan beban tetap. Berdasarkan hal
tersebut, maka digunakan kombinasi beban sementara sebagai
acuan gaya dalam untuk desain pondasi.

Gaya dalam pondasi yang bekerja pada dasar poer adalah
sebagai berikut :
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kN
Berat sendiri poer = (7.2 + 21.6) X 1 X 24% = 691.2 kN

Py = 5699 + 691.2 = 6390 kN
My, = My + Fyt = 8396 + 476 x 1 = 8872 kNm
My, = My, + E,t = 2941+ 159 x 1 = 3100 kNm

8.5.2 Mencari Titik Berat Poer

Gambar 8.10 Mencari titik berat poer SWF
Dengan menggunakan perumusan statis momen maka, dapat
ditentukan titik berat poer. Berdasarkan gambar Gambar 8.7 maka
titik berat poer dapat ditentukan sebagai berikut :

C(ADx + (A)x,  (6%3.6)3+ (3% 24)15

A .8 ~ (6x3.6)+ (3%x24)
= 2.625m

Xo
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Ay + (4)y,  (6%3.6)42+ (3% 2.4)1.2

e (6% 3.6)+ (3x24)
=345m
Maka, titik berat poer berada pada koordinat (2.625 m ; 3.45 m)

Yo

8.5.3 Daya Dukung ljin Satu Tiang

Tiang pancang dinding geser memiliki jenis tanah,
kedalaman pemancangan yang sama oleh karenaitu daya dukung
ijin satu tiang pancang menjadi samayaitu sebagai berikut :

N, =18
N,, = 15.83
AN
Quir = 40A,N,, + %
75.4 X 15.83
=40 % 0.283 x 18 + e 442.5 Ton
o Qult )
Qa =~ > SF=2

442.5

Kekuatan bahan berdasarkan data tiang pancang milik
PT.WIKA BETON untuk diameter 60 cm (kelas A1) diperoleh P =
252.7 Ton.

Berdasarkan hasil analisis kekuatan bahan dan kekuatan
tanah diambil P terkecil, yaitu =221.25 Ton.

8.5.4 Tiang Pancang Kelompok
Jumlah tiang pancang ditentukan dengan perumusan berikut:

P
n= g— — Ej, diasumsikan sebesar 0.7
PE,
gl 6390 ' AR
Ve 3B X7057 ) IR\

M aka direncanakan dengan 10 pancang dengan | etak tiang pancang
pada poer diperlihatkan pada Gambar 8.3.
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Syarat jarak antar tiang pancang () :
25D <S,<5D->S,=3D=4x%x06=24m
2i5D.< Sp=I5D— = 3D =25 x 0.6 =@5m

©

Gambar 8.11 Posisi tiang pancang

Kontrol Beban Aksial Satu Tiang Pancang

Berdasarkan Gambar 8.3 didapatkan jarak masing-masing
tiang pancang terhadap titik berat poer, seperti yang diperlihatkan
pada Tabel 8.38
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Tabel 8.8 Jarak Tiang Pancang Kolom
Tiang Pancang Sumbu
X X2 y y2

P1 1.875 3.515625 1.95 3.8025
P2 0.37 0.1369 1,95, 3.8025
P3 1.275 1.625625 1.95 3.8025
P4 1.875 3.515625 1.95 3.8025
P5 2.025 4.100625 0.45 0.2025
P6 0.37 0.1369 0.45 0.2025
P7 1.275 1.625625 0.45 0.2025
P8 2.775 7.700625 0.45 0.2025
P9 1.875 3.515625 2.85 8.1225
P10 0.37 0.1369 2.85 8.1225
> 26.010075 32.265

Gaya yang dipikul oleh masing-masing tiang pancang ditentukan
dengan perumusan berikut :
ZP Mxoymax Myoxmax
Pi = i
n Xy? Xx?
f W 6390 ! 8872 % 2.78 b 3100 x 2.85
max(Po) = =5 26 32.26
= 1753 kN = 175.3 Ton
6390 8872 x2.78 3100 x 2.85

P (P) = o
min (Pa) 10 26 32.26

= —475.35 kN = 47.5Ton
Maka, tekanan maksimum satu tiang pancang adalah 175.3 Ton.

Menentukan Efisiensi Aktual
Efisensi aktua ditentukan dengan menggunakan
perumusan dari Converce-Labarre sebagai berikut :
Jumlah baris, (m) =4
Jumlah kolom, (n)=2
W D[n-=1)m+(m—1)n
SO 5[ 90.m.n

e, (%) [(2 -4+ 4 -1)2

2.4 90 X2 X4 ]=0'80
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Kontrol Kapasitas

Pax < PEy
175.3 Ton < 221.25 x 0.80
175.3 Ton < 178 Ton — (Oke, Memenuhi)

8.5.5 Kontrol Tebal Poer Dinding Geser

Perencanaan tebal poer harus memenuhi suatu ketentuan bahwa
kekuatan geser nominal harus lebih besar dari geser ponds yang
terjadi.

Data Perencanaan Poer :

Dimensi Pier =400 x 6550 mm

Dimensi Poer = (3000 x 2400 + 3600 x 6000) x 1000 mm
Selimut Beton =70 mm

@ Tulangan =25mm

Mutu Beton, (f) =25MPa

Dimensi tiang pancang = 600 mm

A =1 (Beton Normal)

as =20 (Kolom Tepi)

Rasio sisi panjang terhadap daerah reaksi, (B)
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Gambar 8.12 Penampang Kritis Poer Shearwall

& 288 Y
231026
25
d =1000-70 R 917.5 mm
Penampang kritis adalah pada daerah tiang pancang ujung oleh
karena itu, Keliling penampang kritis (b,) ditentukan dengan
perumusan dibawah :
b, = 17170 — Berdasarkan Gambar 8.4

2.05

Berdasarkan SNI-2847-2013, Pasal 11.11.2.1 untuk
pondasi tapak non-prategang, (V) ditentukan berdasarkan
nilai yang terkecil dari poin berikut :
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g V,=017(1+ %)/1 fib,d

2
V.= 0.17<1 +m)\/25 x 17170 x 917.5

= 26454311 = 26454.31 kN

h. V, = 0.083 (%% + 2) A/ bod
20 X 917.5
=0. (Tm + z)x/ﬁ X 17170 X 917.5

= 20062376 N = 20062.38 kN

i. V. =0.331/f/b,d
=0.33V25 x 17170 X 917.5
= 25993233 N = 25993.23 kN

Dari ketiga nilai V. diatas diambil nilai terkecil, maka kapasitas
penampang dalam memikul geser adalah 20062 kN =
2006.2Ton

V. = P, Tiang

2006.2 Ton = 175.3 Ton — Oke, Memenuhi
Maka, hyoer = 1000 mm telah memenuhi ketentuan.

8.5.6 Desain Penulangan Poer Dinding Geser SW3

Desain penulangan lentur poer dianalisis sebagai balok
kantilever dengan perletakan jepit pada kolom. Beban yang bekerja
adalah beban terpusat dari tiang pancang sebesar P dan berat
sendiri poer sebesar q sebagaimana yang diperlihatkan pada
Gambar 8.4. Desain penulangan poer kolom akan menggunakan
tulangan baja dengan data desain sebagai berikut :

Data Perencanaan .

e Tebal Poer, = 1000 mm
e Mutu Beton, (f.) = 25 MPa
e Mutu Beton, (f; ) = 39 MPa
e Diameter Tul. Utama (@) = 25 mm
e Teba Selimut Beton = 70 mm
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e Tinggi efektif balok poer
dx = 1000 — 70 — "’2—5 —917.5 mm

8.5.7 Desain Penulangan Poer
Berat Poer, g, = 1.3 X 1 x 24 = 31.2 kN/m = 3.12 Ton/m
P, = 2P, 4 = 2 X 175.3 = 350.6 Ton
1
My = (P x €)= (5% que?)
= (350.6 X 0.55) — (% x 3.12 X 1.32)

= 190.19 Tm = 1901.9 kNm

=i r
LG L @)L
|
@ (80 e W
.
CRgl® | &
D e |

Gambar 8.13 Mekanika beban poer SW3

085X f/ X py 600

X
Pb Fy 600 + fy
0.85%25x0.85 600
Po = 390 600+390 0.028

Prmax = 0.75p, = 0.75 x 0.028 = 0.021
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Prin = 0.0020
X « Mu 1901.9 x 10° 1.3
"= 0.85bd2  085x3000x917.52
fy 390
- 3 — 1835
M =085 f'c_ 0.85x25
1 2m X Rn
Ppertu = —| 1= 1= =
_ 1 [, _zx1835x09)_
Ppertv = g 35 390 »

Pmin S pperlu < pperlu

Maka, dipakai pperiu=0.0023

ASperiy = p-b.d = 0.0023 x 1000 x 917.5
= 2110.25 mm?

1
AS1 tutangan = ZnDZ = 0.25 X T X 25% = 490.87 mm?
ASperiu 1 §2110:257 |

=43=5
ASq tulangan 490.63
Dipakai 5¢25 (As = 2545.35 mm?)

ntulangan 77

¢_looo 1000
Nl e

Maka, digunakan tulangan @25 — 250
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8.6 Desain Pondasi Dinding Geser (SW2)

Desain tiang pancang dinding geser yang akan dianalisis
adalah tipe SWE dan SWF sebagaimana ditunjukan pada Gambar
8.14

Gambar 8.14 Letak pondasi dinding geser yang dianalisis

Data Perencanaan
Data-data dalam perencanaan pondasi adalah :
o Kedalamantiang pancang =40m

o Diameter tiang pancang =60cm
e Kdlilingtiang pancang(4s) =m X d X 40 = 62.83m
o Luastiangpancang (4,) = 1/4Xxm x d?

=X x 502 = 1963.5 cm?
Direncanakan poer dengan dimensi seperti yang ditunjukan pada
gambar 8.15
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Va

Gambar 8.15 Desain poer SW2

8.6.1 Beban Pada Tiang Pancang

Dari hasil andlisis struktur didapatkan gaya-gaya dalam
yang bekerja pada pondasi seperti yang diperlihatkan pada Tabel
8.9.
Tabel 8.9Reaks dinding geser SW2

P (kN) Fx (kN) Fy (kN) Mx (kNm)[My (kNm)
Beban Tetap -3173.74 -16.83 12.73 119.12 -43.89
Beban Sementara | -4505.25 10.13 -302.13| -1859.28 12.24

Pada desain tiang pancang ini akan digunakan kombinasi
terbesar dari beban sementara dan beban tetap. Berdasarkan hal
tersebut, maka digunakan kombinasi beban sementara sebagai
acuan gaya dalam untuk desain pondasi.

Gaya dalam pondasi yang bekerja pada dasar poer adalah
sebagai berikut :

kN
Berat sendiri poer = (2.25x 3.85) X 1 X 24% = 2079 kN
Py = 4505 + 208 = 4713 kN
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My, = M, + E,t = 1859 + 302 x 1 = 2161.4 kNm
My, = M, + Ft = 12.24 +10.13 x 1 = 22.4 kNm

8.6.2 Daya Dukungljin Satu Tiang

Tiang pancang dinding geser memiliki jenis tanah,
kedalaman pemancangan yang sama oleh karenaitu daya dukung
ijin satu tiang pancang menjadi samayaitu sebagai berikut :

N, =18
N, = 15.83
AN
Quir = 404,N, + —=
75.4 X 15.83
=40%0.283 x 18 + NIAR NN 4425 Ton
Qult
Sl F =2

Qa SF S

442.5
= 775 = 221.25Ton

Kekuatan bahan berdasarkan data tiang pancang milik
PT.WIKA BETON untuk diameter 60 cm (kelasA1) diperoleh P =
252.7 Ton.

Berdasarkan hasil analisis kekuatan bahan dan kekuatan
tanah diambil P terkecil, yaitu =221.25 Ton.

8.6.3 Tiang Pancang Kelompok
Jumlah tiang pancang ditentukan dengan perumusan berikut:

P
nE g— — E, diasumsikan sebesar 0.7
PE,
u 6390 4125
B 224.25080.70, @M

M aka direncanakan dengan 10 pancang dengan letak tiang pancang
pada poer diperlihatkan pada Gambar 8.316.

Syarat jarak antar tiang pancang () :



257

2.5D < S, <5D - S,

3D =25x0.5=125m
25D <S,<5D S, =3

D=285x%x05=1425m

Gambar 8.16 Posisi tiang pancang

Kontrol Beban Aksial Satu Tiang Pancang

Berdasarkan Gambar 8.3 didapatkan jarak masing-masing
tiang pancang terhadap titik berat poer, seperti yang diperlihatkan
pada Tabel 8.3
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Tabel 8.10 Jarak Tiang Pancang Kolom

Tiang Sumbu

X x2 y y2
P1 0.625 0.390625 1.425 2.030625
P2 0.625 0.390625 1.425 2.030625
P3 0.625 0.390625 1.425 2.030625
P4 0.625 0.390625 1.425 2.030625
P5 0.625 0.390625 0 0
P6 0.625 0.390625 0 0
> 2.34375 8.1225

Gaya yang dipikul oleh masing-masing tiang pancang ditentukan
dengan perumusan berikut :
B Z_P n Mo Vmax Myoxmax
on T Yy? 2 x?
P D 4713 3 4713 x 1.425 4 2161 x 0.625
mazx(Po) = 6 8.123 2.344
=1171 kN = 117.1 Ton
2 Py = 4713 4713 x1.425 2161 x 0.625
min(Pa) = —= =~ "7 %3m;
= 400.38 kN = 40.04 Ton
Maka, tekanan maksimum satu tiang pancang adalah 117.1 Ton.

Menentukan Efisiensi Aktual
Efisensi aktua ditentukan dengan menggunakan
perumusan dari Converce-Labarre sebagai berikut :
Jumlah baris, (m) =4
Jumlah kolom, (n) =2

Dlin—1)m+(m—1)n
Ex=1-tan 1=
k s U 90.m.n
0.6\[(2=1D3+ (3 =1)2
el tan—e o -
T (2.4) 90x2x3 gl
Kontrol Kapasitas

Pmax = PER
117.1Ton < 221.25 X 0.75
117.1Ton < 127.5 Ton — (Oke, Memenuhi)
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8.6.4 Kontrol Tebal Poer Dinding Geser

Perencanaan tebal poer harus memenuhi suatu ketentuan bahwa
kekuatan geser nominal harus lebih besar dari geser ponds yang
terjadi.

Data Perencanaan Poer :

Dimens Pier =400 x 2850 mm

Dimensi Poer = (3850 x 2250) x 1000 mm
Selimut Beton =70 mm

@ Tulangan =25mm

Mutu Beton, (f) =25MPa

Dimensi tiang pancang = 600 mm

A =1 (Beton Normal)
A =20 (Kolom Tepi)

Rasio sisi panjang terhadap daerah reaksi, (B)

L

N

Gambar 8.17 Penampang Kritis Poer Shearwall

2.85

=——=7.125
i 0.4

25
d =1000—-70 T AS 917.5 mm
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Penampang kritis adalah pada daerah tiang pancang ujung oleh
karena itu, Kdiling penampang kritis (b,) ditentukan dengan
perumusan dibawah :

b, = 10570 — Berdasarkan Gambar 8.17

Berdasarkan SNI-2847-2013, Pasal 11.11.2.1 untuk
pondasi tapak non-prategang, (V) ditentukan berdasarkan
nilai yang terkecil dari poin berikut :

. %=017(1 +§),1 fib,d

2
V= 0.17(1 +m)\/2_5 X 10570 X 917.5

= 10557181 N = 10557.18 kN

k. V= 0.083 (2% + 2) A{/fb,d
= 0.083 (20 a3i i + z)x/ﬁ x 10570 X 917.5
/L 10570 /

= 15036311 N = 15036.31 kN

l. V. =0.331/f/b,d
= 0.33v25 x 10570 X 917.5
= 16001658 N = 16001.66 kN

Dari ketiga nilai V. diatas diambil nilai terkecil, maka kapasitas
penampang dalam memikul geser adalah 10557.18 kN =
1055.6 Ton

V. = P,Tiang

1055.6 Ton = 117.1 Ton — Oke, Memenuhi

Maka, hpper = 1000 mm telah memenuhi ketentuan.

8.6.5 Desain Penulangan Poer Dinding Geser SW2

Desain penulangan lentur poer dianalisis sebagai balok
kantilever dengan perletakan jepit pada kolom. Beban yang bekerja
adalah beban terpusat dari tiang pancang sebesar P dan berat
sendiri poer sebesar q sebagaimana yang diperlihatkan pada
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Gambar 8.18. Desain penulangan poer kolom akan menggunakan
tulangan baja dengan data desain sebagai berikut :

Data Perencanaan .

e Tebal Poer, = 1000 mm
e Mutu Beton, (f.) = 25 MPa
e Mutu Beton, (fy ) = 390 MPa
e Diameter Tul. Utama (@) = 25 mm
e Tebal Selimut Beton = 70 mm

e Tinggi efektif balok poer
dx = 1000 — 70 — 22—5 = 9175 mm

8.6.6 Desain Penulangan Poer
Berat Poer, q,, = 1.125 X1 X 24 =27 kN/m = 2.7 Ton/m
P, = 3Pyar = 3 x 117.1 = 351.3 Ton

1
M, = (P, X e) — (E X quez>

— (351.3 X 0.625) — G X 2.7 X 1.1252)
= 217.85 Tm = 2178.5 kNm
|

Gambar 8.18 Mekanika beban poer SW2

085% f/ x B, 600
Pp = X
fy 600 + fy
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__0.85%x25%0.85 600

b = =0.028
390 600+390

Pmax = 0.75p, = 0.75 X 0.028 = 0.021

i = 0.0020
X Mu 2178.5 x 10° A
™= 0.85bd% ~ 0.85x3000x 91752
fy 390
- 4 — 1835
M= 085x f'c 0.85x%25
1 2m X Rn
Ppertu = | 1= 1= X7

_ 1 [, |,_2x1835x096)
Pperiv = 7835 390 N

Pmin < pperlu =< Pmax
ASpery = p.-b.d = 0.00795 x 3000 x 917.5

= 6924.5 mm?*
1
AS1 tulangan = ZnD2 = 0.25 X T X 25% = 490.87 mm?
ASperiu 69245

n = = =14.11 = 15
g A (a5 L LA T 253

Dipakai 15¢25 (As = 7359.4 mm?)

3000 3000

n_1—15_1=214mmz200mm

Maka, digunakan tulangan @25 — 200
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BAB IX
DESAIN SAMBUNGAN

9.1 Desain Sambungan Balok Induk - Balok Anak
9.1.1 Desain Brakit Pada Balok Induk

Vu =87.73 kN
Data Perencanaan
bw =120 mm
h =300 mm
d =300 — 20 — (0.5%10) = 275 mm
f’c =25 Mpa
a =100 mm
> 2 0.27<1...0K
7= 775 = 0 <1...0K.
87.73
V, = g /C 142.22 kN = 142220 N

0.2f/b,yd = 0.2 X 25 x 150 X 275 = 165000 N
>Vn....0K
5.5b,,d = 5.5 x 120 x 275 = 181500 N > Vn ... 0K

Luas Tulangan Geser Friksi
Hubungan brakit dengan balok anak, beton normal maka
nilai koefisien gesek pu=1.4

v, 142220

=—=———=26048mm?
T fou 390 X 1.4 e

A

Luas Tulangan Lentur

Perletakan yang akan digunakan dalam brakit pendek ini
adalah sendi-rol yang mengijinkan adanya deformasi arah
lateral ataupun horisontal, maka gaya horisontal akibat susut
jangka panjang dan deformasi rangka balok tidak boleh
terjadi.
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Ny = 0.2V, = 0.2 X 142220 = 28444 N
My =V,a+ Nyc(h—d)
= (142220 x 70) + 28444(100 — 75)

= 10666500 Nmm
b af T Snil
fy 390
= = = 18.35
M=085xfc_ 0.85x25
Mu 10666500
Rn 2.53

~b.d?2_ 0.75x 1000 x 752 _

1 2m X Rn
Pperie = {1 - 1—T

il ] ] 2 % 18.35 X 2.53
1835 390

= 0.007 > ppin = 0.0036, maka dipakai ppery

Mu

Y
17 0.850f,d
10666500

~ 0.85x 0.65 X 390 X 275

= 180 mm?

= 0.007 X 120 X 275 = 231 mm?
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Maka, dipakai Af=231 mm?

Tulangan Pokok As:

A, = Nuc _
™ 9f,  0.65%390

2844t o 112.2 mm?

Agmin = 0.04 (?) b.d = 0.04 (:—950) 400 X 75

g
= 76.92 mm?

As = (A + 4,) = (231 +112.2)

45 =(

2A

3

= 343.2 mm?

ot Ay) = (B2 4 112.2)

= 285.85 mm?

Maka dipakai tulangan 3D12 (As=339.29 mm?)

A = 0.5(A; — Ay) = 0.5(339.29 — 112.2)

= 227.1 mm?

Dipasang sengkang 3D10 = 235.62 mm?
Dipasang sepanjang G) d= G) 275 =183 mm

Luas Pelat Landasan

v, = 0(0.85)f,. Al
Vy

142220

L™ 90857, ~ 0.65x0.85x25

= 10296.47 mm?

Dipakai Pelat Landasan 100x150 = 15000 mm? (tebal 15

mm)

9.1.2 Desain Sambungan Balok Induk-Balok Anak
Sistem sambungan antara balok induk dengan balok anak pada

perencanaan

ini

memanfaatkan panjang penyaluran dengan
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tulangan balok, terutama pada tulangan bagian bawah yang
nantinya akan dijangkarkan atau dikaitka ke atas.

Panjang penyaluran diasumsikan menerima tekan dan juga
tarik sehingga dalam perencanaan dihitung dalam dua kondisi,
yaitu kondisi tekan dan kondisi tarik.

db =19 mm
As perlu = 1934.6 mm?
As terpasang =2267.1 mm?

Panjang Penyaluran Tulangan Tekan

PIAYS As perlu
dc — ‘“db A
s terpasang

l; =200mm

lap = 0.04d,f,

> 0.04 X 19 X 390 = 296.4 mm
dpfy 19 X390

L, = == = 370.5mm
RN N

l >37051934'6—316 16 325
@)V b YTk N e ()

Maka dipasang panjang penyaluran tekan l; = 325 mm .

Panjang Penyaluran Tulangan Tarik

ja fy Vi Wy
" T K (Cb ¥ Ktr)
b

(Cb+Ktr) e
dy ¥ I

dp =19 mm
Ktr =0
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Co  =jarak terkecil dari (2) jarak dari pusat batang tulangan atau
kawat ke permukaan beton terdekat, dan (b) setengah spasi
pusat ke pusat batang tulangan atau kawat yang disalurkan.

Cp=40+ 10 +19/2 =59.5 mm

Cp=1% x74.6=37.34 mm
Maka, dipakai Cp=37.34 mm
37.34+0

(ot s

19
197 <25

Maka, dipakai (Cb+K") =1.97
( 390 1.3x1x0.8
d —1

1.1v/25  (1.97)

lg = 300mm

) 37.43 mm

Maka, dipakai panjang penyaluran tulangan tarik {;, sepanjang 300
mm.

Panjang Penvyaluran Kait Standar dalam kondisi Tarik
SNI-2847-2013 Pasal 12.5

ld28db =8><19=152mm

la = (0.24%,£,/2JF}) 19

= ((0.24 X 1x390)/(1 x \/2_5)) 19 = 355.68 mm

Maka, dipakai [; = 360 mm dengan bengkokan minimum panjang
penyaluran yang masuk kedalam balok dengan panjang kait
standar 90° sebesar 12d, = 12(19) = 228 mm.
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Perencanaan Sambungan Dapped End Beam (PCI 6th Edition)
Vu =52.27 kN (Balok Anak )

f’c =25 Mpa

fy =390 Mpa

a = direncanakan sebesar 100 mm

d =294 mm

Ny = 0.2V, = 0.2 x 52.27 = 10454 N

1. Lentur di ujung sambungan

= —@%[ () + ()

[52270 (10()) + 10454 (30())]
294 294
= 187.88 mm?
2. Geser Langsung
_1000Abhyu _ 1000(1)(30/2.54)(29.4/2.54)(1.4)
He ="y~ (52270/4532)1000
=16.59 > 3.4
— Maka dipakai 3.4 (tabel 4.3.6.1 PCI 6th Edition)

= 0.75 x 390

i 2V, ) NI 1 2 x 52270 [ 10454
ST 30fue  Of, 3x0.75%390x% 3.4  0.75x 390
= 156.05 mm? < 187.88 mm?

Maka, As = 187.88 mm? (2¢12: As = 226.19 mm?)

o el 1083
" of, T 065%x390

Ap = 05(A, — A,) = 0.5(226.19 — 41.24) = 184.95 mm?
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Kontrol Kuat Geser

0.75(1000)(1)2(%)(%) _

oV, = (1000A%bd) = 2 aF

102 kips = 462.35 kN > Vu = 52.27 kN OK!
Maka, dipakai (212: As =226.19 mm?).

2
9.2 Desain Sambungan Balok — Pelat

Sambungan antara balok dengan pelat mengandalkan adanya
tulangan tumpuan yang dipasang memanjang melintas tegak lurus
di atas balok (menghubungkan stud-stud pelat). Kemudian pelat
pracetak yang sudah dihubungkan stud-studnya tersebut diberi
overtopping dengan cor setempat.

9.3 Desain Sambungan Balok Induk — Kolom
9.3.1 Desain Brakit pada Kolom
Pada desain sambungan antara balok induk dan kolom

dipergunakan sambungan dengan menggunakan konsol
pendek. Balok induk diletakan pada konsol yang berada pada
kolom yang kemudian dirangkai menjadi satu kesatuan.
Bentuk konsol pendek yang dipakai dapat dilihat pada gambar
8.3 berikut ini:



270

Slab tumpuan
Ny v, | — Asc (tulangan utama)

“*_Batang tulangan angkur

\ [

|_An (sengkang tertutup
Batang tulangan perangkai atau pengikat)
untuk mengangkur sengkang

atau pengikat \J\

Gambar 9.1 Sistem Penulangan konsol Pendek

1. Desain Korbel pada kolom As B-3 Lantai 2
Dari output analisis dengan software ETABS
didapatkan :

Vy=186.37 N

Data Perencanaan :
Dimensi Balok 30/50
Dimensi Brakit :

bw =300 mm
h =100 mm
d =400-20-25=335mm
i =35 Mpa
a =250 mm
gl 250—0625<1 OK
d ) 400 - . aen o w .
186.37
V, = 06 =310.62 kN = 310620 N

0.2f/b,,d = 0.2 X 35 X 400 x 335 = 938000 N
>Vn....0K
5.5b,d = 5.5 x 400 x 335 = 737000 N > Vn ...0K
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Luas Tulangan Geser Friksi
Hubungan brakit dengan kolom monolit, beton normal
maka nilai koefisien gesek p=1.4

V, 310620

= = T 568.90 mm?
U Fu T 390 % 14 -

A

Luas Tulangan Lentur
Perletakan yang akan digunakan dalam brakit
pendek ini adalah sendi-rol yang mengijinkan adanya
deformasi arah lateral ataupun horisontal, maka gaya
horisontal akibat susut jangka panjang dan deformasi
rangka balok tidak boleh terjadi.
Ny = 0.2V, = 0.2 X 310620 = 62124 N
M, =V,a+ Ny.(h—d)
= (310620 x 250) + 62124(400 — 335)

— 81693060 Nmm
1.4 1.4
pmin = g == % = 00036
fy 390
- - —13.11
M= 085x%fc_ 0.85x35
o Mu 81693060
s 3@ 075 91000 % 3352
1 2m X Rn
Ppertu = 1- 11— Y

1 3 9 2x13.11x0.97
390
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= 0.0025 < ppin = 0.0036, maka dipakai pyin

A Mu
17 0.850f,d
h 81693060
"~ 0.85 x 0.65 x 390 x 335
= 1131.73 mm?
AfZ = pbwd

= 0.0036 x 400 x 335 = 482.4 mm?

Maka, dipakai Af=1131.73 mm?
Tulangan Pokok As:

_ Nyc 62124
ot 26

— 2
T3, & osha | 245.06 mm

Agmin = 0.04 (;—) b.d = 0.04 (%) 400 x 335

y

= 481 mm?
As = (Af + A,) = (1131.37 + 245.06)
= 1376.43 mm?
4= (L4 4,) = (222 + 245.06)
= 624.33 mm?

Maka dipakai tulangan 3D25 (As=1472.61 mm?)

Ap, = 05(A; — A4,) = 0.5(1472.61 — 245.06)
= 591.28 mm?
Dipasang sengkang 3D16 = 603.18 mm?

Dipasang sepanjang (g) dr— (%) 335 =223 mm
Dipasang 3D16 dengan spasi 220/3 = 55 mm

Luas Pelat Landasan




v, = 0(0.85)f. Al
Vu 310620

L™ 9(085)f, ~ 0.65x0.85x35

= 16063.1 mm?
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Dipakai Pelat Landasan 250x300 = 75000 mm? (tebal

15 mm)

9.3.2 Desain Sambungan Balok-Kolom

Sistem sambungan antara balok dengan kolom pada
perencanaan memanfaatkan panjang penyaluran dengan tulangan
balok, terutama tulangan pada bagian bawah yang nantinya

dijangkarkan atau dikaitkan ke atas.

Panjang penyaluran diasumsikan menerima tekan dan juga
menerima tarik sehingga perencanaan dihitung dalam dua kondisi,

yaitu pada kondisi tarik dan kondisis tekan.

db =19 mm
As perlu =1112 mm?
As terpasang =1133.5 mm?

Panjang Penyaluran Tulangan Tekan

e | Ag perlu
dc — dbA
s terpasang

lge = 200 mm
lac = (0.043f,)d,
> 0.043 x 390 x 19 = 318.63 mm
0.24f, 0.24 % 390
lac 2 i R T="%
NI V25

Uiz _ 4603 350
NFEY diRcES gl @ o

X 19 = 355.68 mm

lup = 355.68

Maka dipasang panjang penyaluran tekan [; = 400 mm.

Panjang Penvyaluran Tulangan Tarik




274

£, ¥, 390 x 1.3 x 1
=224, = (—) 19 = 917.43 mm
210/ 2.1 x 1v25

fy WY

]
S ERN <Cb ;r Ktr)
b

() <5

dp

db  =19mm

Kir =0

Cp  =jarak terkecil dari (a) jarak dari pusat batang tulangan atau
kawat ke permukaan beton terdekat, dan (b) setengah spasi
pusat ke pusat batang tulangan atau kawat yang disalurkan.

Cp=40+ 10 +19/2 =59.5 mm

Cp=1% x74.6=37.34 mm

Maka, dipakai Cp = 37.34 mm
37.34+0

22T O

19
197 <25

Maka, dipakai ( ”+K”) =1.97
( 390 1.3x1x0.8
d [

1.1v/25 (1.97)

ly; =300mm

) 37.43 mm

Maka, dipakai panjang penyaluran tulangan tarik [;, sepanjang
917.43 mm.
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Panjang Penyaluran Kait Standar dalam kondisi Tarik
SNI-2847-2013 Pasal 12.5

lg = 150 mm

l; 28d, =8x%x19 =152mm

lq = (0.24%,.f,/1/f) 19

= ((0.24 x 1 x 390)/(1 x V25)) 19 = 355.68 mm

Maka, dipakai [; = 360 mm dengan bengkokan minimum panjang
penyaluran yang masuk kedalam kolom dengan panjang Kait
standar 90° sebesar 12d, = 12(19) = 228 mm.
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BAB X
PENUTUP
10.1 Kesimpulan
Penggunaan elemen beton pracetak memiliki banyak
keuntungan  dibandingkan  beton  konvensional  (insitu).
Diantaranya adalah kualitas beton terjamin, waktu pelaksanaan
lebih cepat dan pada kondisi tertentu biaya konstruksi bangunan
menjadi lebih hemat.
Berdasarkan perhitungan modifkasi struktur gedung Hotel
Fave Ketintang Surabaya yang telah dilakukan, didapatkan hasil
sebagai berikut :
1. Dimensi elemen struktur :
a. Tebal plat lantai & plat atap = 12 cm
b. Dimensi balok anak = 30/50 cm
c. Dimensi balok struktur = 40/60 cm
d. Dimensi kolom = 60/60 cm
e. Dimensi shearwall = 40 cm
2. Perencanaan struktur gedung menggunakan elemen pracetak
dibuat menyerupai monolit dengan cara memakai sambungan
basah (wet connection).
3. Perencanaan struktur gedung dengan Sistem
Rangka Gedung telah memenuhi persyaratan SNI -1726-2012
yaitu partisipasi pemikulan pengaruh gempa oleh struktur balok
& kolom hanya diperkenankan sebesar kurang dari 10 % dengan
mempertimbangkan adanya kompatibilitas struktur.
4. Dari data tanah di daerah Ketintang Surabaya
dapat dilihat bahwa kondisi tanah tidak terlalu baik sehingga
diperlukan pile dalam jumlah banyak. Dari perhitungan pondasi,
dipakai 4 macam pile cap yaitu :
a. Pile cap kolom interior
Bentuk persegi, terdiri dari 5 pile diameter 50 cm dengan
kedalaman 40 m
b. Pile cap kolom exterior
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Bentuk persegi panjang, terdiri dari 4 pile diameter 50 cm
dengan kedalaman 40 m

c. Pile cap Shearwall Siku
Terdiri dari 10 pile diameter 60 cm
d. Pile cap Shearwall Persegi Panjang
Terdiri dari 6 pile diameter 50 cm
10.2 Saran

Saran yang dapat diberikan berdasarkan hasil analisa

dalam Tugas Akhir ini meliputi :

1. Perencanaan dengan menggunakan struktur beton pracetak

sebaiknya memperhatikan detail dan jenis sambungan
serta metode pelaksanaan pada lapangan.

Perencanaan struktur dengan metode beton pracetak perlu
mempertimbangkan sistem struktur yang dipakai agar
didapatkan kemudahan dalam merencanakan sistem
sambungan yang sesuai.

Perencanaan struktur dengan pracetak perlu memikirkan
kemudahan dalam aplikasi di lapangan sehingga
pelaksanaan di lapangan dapat berjalan dengan baik dan
sesuai dengan apa yang diharapkan.
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